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Your printer and the recommended supplies have been designed and tested to meet strict safety 
requirements. Attention to the following information ensures the continued safe operation of your 
Xerox printer. 
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Notices and Safety 

Read the following instructions carefully before operating your printer. Refer to these instructions to 
ensure the continued safe operation of your printer. 

Your Xerox® printer and supplies are designed and tested to meet strict safety requirements. These 
include safety agency evaluation and certification, and compliance with electromagnetic regulations 
and established environmental standards. 

The safety and environment testing and performance of this product have been verified using Xerox® 
materials only. 

Note: Unauthorized alterations, which can include the addition of new functions or connection of 
external devices, can affect the product certification. For more information, contact your Xerox 
representative. 
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Electrical Safety 

This section includes: 
• General Guidelines ........................................................................................................................................................... 13 
• Power Cord ......................................................................................................................................................................... 13 
• Emergency Turn Off ........................................................................................................................................................ 14 
• Telephone Line Cord ....................................................................................................................................................... 14 
 
 

General Guidelines 
 

 WARNINGS:  

• Do not push objects into slots or openings on the printer. Touching a voltage point or 
shorting out a part could result in fire or electric shock. 

• Do not remove the covers or guards that are fastened with screws unless you are installing 
optional equipment and are instructed to do so. Power off the printer when performing 
these installations. Disconnect the power cord when removing covers and guards for 
installing optional equipment. Except for user-installable options, there are no parts that 
you can maintain or service behind these covers. 

 

The following are hazards to your safety: 
• The power cord is damaged or frayed. 
• Liquid is spilled into the printer. 
• The printer is exposed to water. 
• The printer emits smoke, or the surface is unusually hot. 
• The printer emits unusual noise or odors. 
• The printer causes a circuit breaker, fuse, or other safety device to activate. 

If any of these conditions occur, do the following: 
1. Power off the printer immediately. 
2. Disconnect the power cord from the electrical outlet. 
3. Call an authorized service representative. 
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Power Cord 

Use the power cord supplied with your printer. 
• Plug the power cord directly into a properly grounded electrical outlet. Ensure that each end of the 

cord is connected securely. If you do not know if an outlet is grounded, ask an electrician to check 
the outlet. 

 

 WARNING: To avoid risk of fire or electrical shock, do not use extension cords, power strips, or 
power plugs for more than 90 days. When a permanent outlet receptacle cannot be installed, 
use only one factory-assembled extension cord of the appropriate gauge for each printer or 
multifunction printer. Always adhere to national and local building, fire, and electrical codes 
regarding length of cord, conductor size, grounding, and protection. 

 

• Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have a 
ground connection terminal. 

• Verify that the printer is plugged into an outlet that is providing the correct voltage and power. 
Review the electrical specification of the printer with an electrician if necessary. 

• Do not place the printer in an area where people can step on the power cord. 
• Do not place objects on the power cord. 
• If the power cord becomes frayed or worn, replace it. 
• To avoid electrical shock and damage to the cord, grasp the plug when unplugging the power cord. 

The power cord is attached to the printer as a plug-in device on the back of the printer. If it is necessary 
to disconnect all electrical power from the printer, disconnect the power cord from the electrical outlet. 
 

Emergency Turn Off 

If any of the following conditions occur, power off the printer immediately and disconnect the power 
cord from the electrical outlet. Contact an authorized Xerox service representative to correct the 
problem if: 
• The equipment emits unusual odors or makes unusual noises. 
• The power cable is damaged or frayed. 
• A wall panel circuit breaker, fuse, or other safety device has been tripped. 
• Liquid is spilled into the printer. 
• The printer is exposed to water. 
• Any part of the printer is damaged. 
 

Telephone Line Cord 
 

 WARNING: To reduce the risk of fire, use only No. 26 American Wire Gauge (AWG) or larger 
telecommunication line cord. 
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Operational Safety 

Your printer and supplies were designed and tested to meet strict safety requirements. These include 
safety agency examination, approval, and compliance with established environmental standards. 

Your attention to the following safety guidelines helps to ensure the continued, safe operation of your 
printer. 
 

Operational Guidelines 
• Do not remove any trays while the printer is printing. 
• Do not open the doors when the printer is printing. 
• Do not move the printer while is printing. 
• Keep hands, hair, neckties, and so on away from the exit and feed rollers. 
• Covers, which require tools for removal, protect the hazard areas within the printer. Do not remove 

the protective covers. 
• Do not override any electrical or mechanical interlock devices. 
• Do not attempt to remove paper that is jammed deeply inside the product. Switch off the product 

promptly and contact your local Xerox representative. 
 

 WARNING: The metallic surfaces in the fuser area are hot. Always use caution when 
removing paper jams from this area and avoid touching any metallic surfaces. 

 
 

Ozone Release 

This printer produces ozone during normal operation. The amount of ozone produced is dependent on 
copy volume. Ozone is heavier than air and is not produced in amounts large enough to harm anyone. 
Install the printer in a well-ventilated room. 

For more information in the United States and Canada, go to www.xerox.com/environment. In other 
markets, please contact your local Xerox representative or go to www.xerox.com/environment_europe. 
 

Printer Location 
• Place the printer on a level, solid, non-vibrating surface with adequate strength to hold its weight. 

To find the weight for your printer configuration, refer to Physical Specifications on page 218. 
• Do not block or cover the slots or openings on the printer. These openings are provided for 

ventilation and to prevent overheating of the printer. 
• Place the printer in an area where there is adequate space for operation and servicing. 
• Place the printer in a dust-free area. 
• Do not store or operate the printer in an extremely hot, cold, or humid environment. 
• Do not place the printer near a heat source. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=VersaLink+VLB405&PgName=environmentna&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=VersaLink+VLB405&PgName=environmenteu&Language=English
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• Do not place the printer in direct sunlight to avoid exposure to light-sensitive components. 
• Do not place the printer where it is directly exposed to the cold air flow from an air conditioning 

system. 
• Do not place the printer in locations susceptible to vibrations. 
• For optimum performance, use the printer at the elevations specified in Elevation on page 221. 
 

Printer Supplies 
• Use the supplies designed for your printer. The use of unsuitable materials can cause poor 

performance and a possible safety hazard. 
• Follow all warnings and instructions marked on, or supplied with, the product, options, and supplies. 
• Store all consumables in accordance with the instructions given on the package or container. 
• Keep all consumables away from the reach of children. 
• Never throw toner, toner cartridges, drum cartridges, or waste cartridges into an open flame. 
• When handling cartridges, for example toner and such, avoid skin or eye contact. Eye contact can 

cause irritation and inflammation. Do not attempt to disassemble the cartridge, which can increase 
the risk of skin or eye contact. 

 

 CAUTION: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service 
Agreement, and Total Satisfaction Guarantee do not cover damage, malfunction, or 
degradation of performance caused by use of non-Xerox supplies, or the use of Xerox supplies 
not specified for this printer. The Total Satisfaction Guarantee is available in the United States 
and Canada. Coverage could vary outside these areas. Please contact your Xerox 
representative for details. 
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Maintenance Safety 

Do not attempt any maintenance procedure that is not specifically described in the documentation 
supplied with your printer. 
• Clean the device with a dry lint-free cloth only. 
• Do not burn any consumables or routine maintenance items. For information on Xerox® supplies 

recycling programs, go to www.xerox.com/gwa . 
 

 WARNING: Do not use aerosol cleaners. Aerosol cleaners can be explosive or flammable when 
used on electromechanical equipment. 

When installing the device in a hallway or similar restricted area, additional space requirements can 
apply. Ensure that you comply with all workspace safety regulations, building codes, and fire codes for 
your area. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=VersaLink+VLB405&PgName=recyclesupplies&Language=English
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Printer Symbols 

Symbol Description 

 

Warning: 
Indicates a serious hazard that can result in death or serious injury if not avoided. 

 

Hot Warning: 
Hot surface on or in the printer. Use caution to avoid personal injury. 

 

Warning: Moving parts. To avoid personal injury, use caution. 

 

Caution: 
Indicates a mandatory action to take in order to avoid damage to the property. 

 

Caution: 
To avoid damage to the property, be careful not to spill toner when handling the waste 
cartridge. 

 

Do not touch the part or area of the printer. 

 

Do not expose the drum cartridges to direct sunlight. 

 

Do not burn the toner cartridges. 

 

Do not burn the waste cartridge. 

 

Do not burn the drum cartridges. 
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Do not use paper attached with staples or any form of binding clip. 

 

Do not use folded, creased, curled, or wrinkled paper. 

 

Do not use inkjet paper. 

 

Do not use transparencies or overhead projector sheets. 

 

Do not reload paper previously printed on or used. 

 

Do not copy money, revenue stamps, or postage stamps. 

 

For details about all the printer symbols that appear on your printer, refer to the Printer Symbols guide at 
www.xerox.com/office/VLB405docs . 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLB405&PgName=Man&Language=English
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Environmental, Health, and Safety Contact 
Information 

For more information on Environment, Health, and Safety in relation to this Xerox product and supplies, 
contact the following customer help lines: 
United States and Canada: 1-800-ASK-XEROX (1-800-275-9376) 
Europe: +44 1707 353 434 

For product safety information in the United States and Canada, go to www.xerox.com/environment. 

For product safety information in Europe, go to www.xerox.com/environment_europe. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=VersaLink+VLB405&PgName=environmentna&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=VersaLink+VLB405&PgName=environmenteu&Language=English
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Parts of the Printer 

This section includes: 
• Front View ........................................................................................................................................................................... 22 
• Duplex Automatic Document Feeder ....................................................................................................................... 23 
• Control Panel ..................................................................................................................................................................... 24 
• Internal Parts ..................................................................................................................................................................... 26 
• Rear View ............................................................................................................................................................................ 26 
 
 

Front View 
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1. Tray 1 
2. Bypass Tray 
3. Front Door 
4. USB Memory Port 
5. Control Panel 

6. Card Reader Bay 
7. Duplex Automatic Document Feeder 
8. Output Tray 
9. Output Tray Paper Stop 
10. Optional 550 Sheet Feeder, maximum of 3 

(Trays 2–4) 
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Duplex Automatic Document Feeder 

1 2 3 4

5

 
 

1. Document Feeder Cover 
2. Paper Guides 
3. Duplex Automatic Document Feeder 

4. Document Output Tray 
5. Document Output Tray Extension 

 
 

Document Feeder Guidelines 

The Duplex Automatic Document Feeder accommodates the following original-sized documents: 
• Width: 140–216 mm (5.5–8.5 in.) 
• Length: 140–356 mm (5.5–14 in.) 
• Weight: 60–125 g/m² 

Follow these guidelines when loading original documents into the duplex automatic document feeder: 
• Load original documents face up so that the top of the document enters the feeder first. 
• Place only loose sheets of undamaged paper in the duplex automatic document feeder. 
• Adjust the paper guides so that they fit against the original documents. 
• Insert paper in the duplex automatic document feeder only when ink on the paper is dry. 
• Do not load original documents above the MAX fill line. 
 

Document Glass Guidelines 

The document glass accommodates original size documents up to 216 x 356 mm (8.5 x 14 in.). Use the 
document glass rather than the duplex automatic document feeder to copy or scan the following types 
of original documents: 
• Paper with paper clips or staples attached 
• Paper with wrinkles, curls, folds, tears, or notches 
• Coated or carbonless paper or items other than paper, such as cloth or metal 
• Envelopes 
• Books 
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Control Panel 

The control panel consists of a touch screen and buttons you press to control the functions available on 
the printer. The control panel: 
• Displays the current operating status of the printer. 
• Provides access to print, copy, and scan features. 
• Provides access to reference materials. 
• Provides access to Tools and Setup menus. 
• Prompts you to load paper, replace supplies, and clear jams. 
• Displays errors and warnings. 
• Provides the Power/Wake button used for powering on or off the printer. This button also supports 

the power-saver modes, and blinks to indicate the power status of the printer. 
 

 

 

  

Item Name Description 

1 

NFC Area Near Field Communication (NFC), is a technology that enables devices 
to communicate when they are within 10 cm (4 in.) of each other. Use 
the NFC area to obtain a network interface or to establish a TCP/IP 
connection between your device and the printer. 

2 Touch Screen 
Display 

The screen displays information and provides access to printer functions. 

3 
Home Button This button provides access to the Home menu for access to printer 

features, such as copy, scan, and fax. 
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Item Name Description 

4 

Power/Wake This button serves several power-related functions. 

When the printer is powered off, this button powers on the printer. 
• When the printer is powered on, pressing this button displays a menu 

on the control panel. From this menu, you can choose to enter Sleep 
mode, restart, or power off the printer. 

• When the printer is powered on, but in a low-power mode or Sleep 
mode, pressing this button wakes the printer. 

• When the printer is powered on, holding this button for 10-seconds 
turns off the printer. 

This button also blinks to indicate the power status of the printer. 
• When the light blinks slowly, the printer is in low-power mode or 

Sleep mode. 
• When the light blinks rapidly, the printer is powering down, or exiting 

a low-power mode. 

5 

Status LED This light blinks blue or amber to indicate printer status. 
Blue 
• Blinks blue once to acknowledge a successful Authentication request. 
• Blinks blue once slowly for a copy or print job initiated at the control 

panel. 
• Blinks blue twice slowly for fax or print job received from the network. 
• Blinks blue rapidly while the printer is powering up, or to signal 

detection of a Wi-Fi Direct connection request. 
Amber 
• Blinks amber to indicate an error condition or warning that requires 

your attention. For example, an out of toner condition, a paper jam, 
or out of paper for the current job. 

• It also blinks amber to indicate a system error, which typically is 
associated with an error code. 

6 
Notification Banner Notifications and messages are displayed in a pop-up banner below the 

apps area. To view the full notification, touch the down arrow. After you 
have reviewed the information, touch X to close. 

7 
Pause Button When a job is being scanned or processed, a Pause icon appears in the 

notification banner area. To pause the current job, touch the Pause icon. 
The job pauses with the option to resume or delete the job. 
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Internal Parts 

 
 

1. Output Tray Paper Stop 
2. Front Door 
3. Drum Cartridge 
4. Toner Cartridge 

5. Duplex Automatic Document Feeder 
6. Document Cover 
7. Document Glass 
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Rear View 

 
1. Phone Line Connector/Fax Line Connector 
2. Ethernet Port 
3. Wireless Network Adapter Port Cover 
4. USB Port 
5. Foreign Device Interface Connector 
6. Back Cover 

7. Duplex Unit 
8. Transfer Roll 
9. Fuser 
10. Control Board 
11. Left Side Cover 
12. Power Connector 
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Power Options 

The printer has a single multifunction button on the control panel. The Power/Wake button restarts, 
powers up, or powers down the printer. This button also enters and exits low-power mode, and flashes 
when the printer is in power-saver mode. 
 

Powering On the Printer or Exiting Low-Power or Sleep Mode 

To power on the printer, or to exit Low-Power mode or Sleep mode, press the Power/Wake button. 

 
Notes: 

• The Power/Wake button is the only power button on the printer. 
• The printer exits Low-Power mode or Sleep mode automatically when it receives data from a 

connected device. 
• When in Low-Power mode, or Sleep mode, the touch screen is powered off and unresponsive. 

To wake the printer manually, press the Power/Wake button. 
 

 CAUTION: Do not plug or unplug the power cord while the printer is powered on. 
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Restarting, Placing in Sleep Mode, or Powering Off the Printer 

To restart the printer, place the printer in Sleep Mode, or power off the printer: 
1. At the printer control panel, press the Power/Wake button. 

1

2

 
2. Select an option. 

− To restart the printer, touch Restart. 
− To place the printer in Sleep Mode, touch Sleep. 

In Sleep Mode, the touch screen goes dark and the Power/Wake button flashes. 
− To power off the printer, touch Power Off. 
− If the printer does not respond to a single press of the Power/Wake button, press and hold the 

button for 5 seconds. A wait message appears as the printer powers down. 
After 10 seconds, the touch screen goes dark and the Power/Wake button flashes until the 
printer completes the power-down process. 

 

 CAUTION: Do not unplug the power cord while the printer powers down. 
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Accessing the Printer 

Logging In 

Logging in is the process by which you identify yourself to the printer for authentication. If 
authentication is set, to access printer features, you log in with your user credentials. 
 

Logging In at the Control Panel 
1. At the printer control panel, press the Home button. 
2. Touch Log In. 
3. Type the User Name using the keypad, then touch Enter. 
4. If prompted, enter the password, then press Enter. 
5. Touch OK. 

Note: To access each service that is password-protected, repeat steps 3 and 4. 
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Introduction to Apps 

Xerox Apps are a gateway to the features and functions of your device. There are standard Apps that are 
already installed on the device and that appear on the Home screen. There are also Apps that are 
installed as standard but are hidden when your device is used for the first time. 

When you log in, the apps that are configured for your personal account appear on the control panel. 

You can download more Apps for your device from the Xerox® App Gallery. For details, refer to Xerox 
Apps Gallery Overview on page 60. 
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Information Pages 

Your printer has a set of information pages that you can print. These pages include configuration and 
font information, demonstration pages, and more. 

The following Information Pages are available: 
 

Name Description 

 

Configuration Report The Configuration Report provides printer information including 
installed options, network settings, port setup, tray information, 
and more. 

 

Billing Summary Report The Billing Summary Report provides information about the 
device and a detailed listing of the billing meters and sheet 
counts. 

 

Supplies Usage Report The Supplies Usage Report provides coverage information and 
part numbers for reordering supplies. 

 

PostScript Font List The PostScript Font List provides a printout of all PostScript fonts 
that are available on the printer. 

 

PCL Font List The PCL Font List provides a printout of all PCL fonts that are 
available on the printer. 

 

Demonstration Print Demonstration Print provides a demonstration of the current 
print quality. 

 

Startup Page The Startup Page provides basic printer configuration and 
network information. 

 

Job History Report The printer retains information on previous print jobs, including 
the date, time, job type, document name, output color, paper 
size, number of pages, and results. The status of a maximum of 
20 jobs prints on the Job History Report. 

 
 

Printing Information Pages 
1. At the printer control panel, press the Home button. 
2. Touch Device > About > Information Pages. 
3. To print an information page, touch the desired page. 
4. To return to the Home screen, press the Home button. 
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Configuration Report 

The Configuration Report provides product information including, installed options, network settings, 
port setup, tray information, and more. 
 

Printing the Configuration Report 
1. At the printer control panel, press the Home button. 
2. Touch Device > About > Information Pages. 
3. Touch Configuration Report. 
4. To return to the Home screen, press the Home button. 
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The Embedded Web Server 

The Embedded Web Server is the administration and configuration software that is installed in the 
printer. It allows you to configure and administer the printer from a Web browser. 

The Embedded Web Server requires: 
• A TCP/IP connection between the printer and the network in Windows, Macintosh, UNIX, or Linux 

environments. 
• TCP/IP and HTTP enabled in the printer. 
• A network-connected computer with a Web browser that supports JavaScript. 
 

Accessing the Embedded Web Server 

At your computer, open a Web browser. In the address field, type the IP address of the printer, then press 
Enter or Return. 
 

Finding the IP Address of Your Printer 

To install the print driver for a network-connected printer, you need the IP address of your printer. You 
also need the IP address to access the settings of your printer through the Embedded Web Server. You 
can view the IP address of your printer on the control panel or on the Configuration Report. 

Note: Wait until the printer has been on for 2 minutes to view the TCP/IP address. If the TCP/IP address 
is 0.0.0.0, or begins with 169, it indicates a network connectivity issue.  

To view the IP address of the printer on the control panel: 
1. At the printer control panel, press the Home button. 
2. Touch Device > About. 
3. Record the IP address from the display. 
4. To return to the Home screen, press the Home button. 

To obtain the printer IP address from the Configuration Report: 
1. At the printer control panel, press the Home button. 
2. Touch Device > About > Information Pages. 
3. Touch Configuration Report. The IP address appears in the Connectivity section of the 

Configuration Report for IPv4 or IPv6. 
To return to the Home screen, press the Home button. 
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Installation and Setup 

For reference:  
Installation Guide packaged with your printer. 
Online Support Assistant at www.xerox.com/office/VLB405support  
 

Installation and Setup Overview 

Before you print, ensure that your computer and the printer are plugged in, powered on, and connected. 
Configure the initial settings of the printer, then install the print driver software and utilities on your 
computer. 

You can connect to your printer directly from your computer using USB, or connect to a network using an 
Ethernet cable or wireless connection. Hardware and cabling requirements vary for the different 
connection methods. Routers, network hubs and switches, modems, Ethernet cables, and USB cables are 
not included with your printer and are purchased separately. Xerox recommends an Ethernet connection 
because it is typically faster than a USB connection, and it provides access to the Embedded Web Server. 

For more information, refer to the System Administrator Guide at www.xerox.com/office/VLB405docs . 
 

Selecting a Location for the Printer 
1. Select a dust-free area with temperatures from 10–32°C (50–90°F), and relative humidity 10–85%. 

Note: Sudden temperature fluctuations can affect print quality. Rapid heating of a cold room can 
cause condensation inside the printer, directly interfering with image transfer. 

2. Place the printer on a level, solid, non-vibrating surface with adequate strength to hold the weight 
of the printer. The printer must be horizontal with all four feet in solid contact with the surface. To 
find the weight for your printer configuration, refer to Weights and Dimension on page 218, on 
page 218. Select a location with adequate clearance to access supplies and to provide proper 
ventilation. To find the clearance requirements for your printer, refer to Clearance Requirements on 
page 220. 

3. After positioning the printer, you are ready to connect it to the power source and computer 
or network. 

 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLB405&PgName=tech&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLB405&PgName=Man&Language=English


Getting Started 

 

36 Xerox® VersaLink® B405 Multifunction Printer 
 User Guide 
 

Connecting the Printer 

This section includes: 
• Selecting a Connection Method ................................................................................................................................. 36 
• Connecting to a Computer Using USB..................................................................................................................... 37 
• Connecting to a Wired Network ................................................................................................................................. 37 
• Connecting to a Wireless Network ............................................................................................................................ 37 
• Connecting to a Telephone Line ................................................................................................................................ 43 
• Initial Printer Setup ......................................................................................................................................................... 43 
• Configuring AirPrint ........................................................................................................................................................ 43 
• Configuring Google Cloud Print .................................................................................................................................. 44 
• Installing the Software .................................................................................................................................................. 46 
 
 

Selecting a Connection Method 

You can connect the printer to your computer using a USB cable, Ethernet cable, or wireless connection. 
The method that you select depends on how your computer is connected to the network. A USB 
connection is a direct connection and is the easiest to set up. An Ethernet connection is used to connect 
to a network. If you are using a network connection, it is important to understand how your computer is 
connected to the network. 

Note: Hardware and cabling requirements vary for the different connection methods. Routers, network 
hubs, network switches, modems, Ethernet cables, and USB cables are not included with your printer and 
must be purchased separately. 
• USB: If you connect the printer to one computer and do not have a network, use a USB connection. 

A USB connection offers fast data speeds, but typically not as fast as a network connection. 

Note: To access the Embedded Web Server, a network connection is required. 

• Network: If your computer is connected to an office network or home network, use an Ethernet 
cable to connect the printer to the network. You cannot connect the printer directly to the computer. 
A connection through a router or network switch is required. An Ethernet network can be used for 
one or more computers and supports many printers and systems simultaneously. An Ethernet 
connection is typically faster than USB and allows you direct access to the settings of the printer 
using the Embedded Web Server. 

• Wireless Network: If your environment includes a wireless router or wireless access point, you can 
connect the printer to the network with a wireless connection. A wireless network connection 
provides the same access and services as a wired connection provides. A wireless network 
connection is typically faster than USB and allows direct access to the settings of the printer using 
the Embedded Web Server. 

• Telephone: To send and receive faxes, the multifunction printer must be connected to a dedicated 
telephone line. 

 



Getting Started 

 

 Xerox® VersaLink® B405 Multifunction Printer 37 
 User Guide 
 

Connecting to a Computer Using USB 
• Windows 7, Windows 8.1, Windows Server 2008, Windows 10, Windows Server 2008 R2, and 

Windows Server 2012. 
• Macintosh OS X version 10.9 and later. 
• UNIX and Linux: Your printer supports connection to various UNIX platforms through the 

network interface. 

To connect the printer to the computer using a USB cable: 
1. Connect the B end of a standard A/B USB 2.0 or USB 3.0 cable to the USB Port on the back of 

the printer. 
2. Connect the A end of the USB cable to the USB port on the computer. 
3. If the Windows Found New Hardware Wizard appears, cancel it. 
4. Install the print driver. 

For more information, refer to Installing the Software on page 46. 
 

Connecting to a Wired Network 
1. Ensure that the printer is powered off. 
2. Attach a Category 5 or better Ethernet cable from the printer to the network or router socket. Use 

an Ethernet switch or router, and two or more Ethernet cables. Connect the computer to the switch 
or router with one cable, then connect the printer to the switch or router with the second cable. 
Connect to any port on the switch or router except the uplink port. 

3. Attach the power cord, then plug in the printer and turn it on. 
4. Set the network IP printer address, or set up the printer for automatic printer IP detection. For more 

information, refer to the System Administrator Guide at www.xerox.com/office/VLB405docs. 
 

Connecting to a Wireless Network 

A wireless local area network (WLAN) provides the means to connect two or more devices in a LAN 
without a physical connection. The printer can connect to a wireless LAN that includes a wireless router 
or wireless access point. Before connecting the printer to a wireless network, the wireless router must be 
configured with a service set identifier (SSID) and any necessary credentials. 

Note: Wireless networking is available only on printers with the optional Wireless Network 
Adapter installed. 

 

Installing the Wireless Network Adapter 

The optional wireless network adapter plugs in to the back of the control board. After the adapter is 
installed, and wireless networking is enabled and configured, the adapter is able to connect to a 
wireless network. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLB405&PgName=Man&Language=English
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To install the Wireless Network Adapter: 
1. Power off the printer. 

1

2

 
2. To remove the Wireless Network Adapter Port Cover, press the latch to the left, then pull the cover 

away from the printer. 

 
3. Remove the packaging from the Wireless Network Adapter. 
4. To install the Wireless Network Adapter, follow the installation instructions provided with the 

Wireless Network Adapter. 
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 CAUTION: Pulling on the adapter can cause damage. After the adapter is installed, remove it 
only as needed, and as directed in the Wireless Network Adapter removal instructions. For 
details, refer to Removing the Wireless Network Adapter. 

 

5. Power on the printer. 

 
6. Configure the Wi-Fi Settings. For details about configuring the Wi-Fi settings, refer to the System 

Administrator Guide at www.xerox.com/office/VLB405docs . 
 

Removing the Wireless Network Adapter 
1. Power off the printer. 

1

2

 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLB405&PgName=Man&Language=English


Getting Started 

 

40 Xerox® VersaLink® B405 Multifunction Printer 
 User Guide 
 

2. To open the left-side cover, loosen the bolt on the back of the printer that secures the cover. Slide 
the cover toward the back, then out and away from the printer. 

  
3. Reach into the printer and pull the release lever. Grasp the Wireless Network Adapter with your 

other hand and carefully pull it away from the printer. 
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 CAUTION: Do not use force to pull on the Wireless Network Adapter. If the latch is released 
properly, the adapter pulls out easily. Pulling on a secured adapter can damage it. 

 

4. To reinstall the Wireless Network Adapter Port Cover, insert the tab into the small slot. Gently press 
the port cover against the back of the printer until the cover latches into place. 

 
5. Place the left-side cover into position and slide it toward the front of the printer. Tighten the bolt to 

secure the cover. 
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6. Connect the printer to your computer with a USB cable or through the network using an 
Ethernet cable. 

 
7. Power on the printer. 

 

Note: If the printer was installed previously in a wireless network environment, it could retain setup and 
configuration information from that environment. To prevent the printer from attempting to connect to 
the previous network, reset the wireless settings. For more information, refer to the System Administrator 
Guide at www.xerox.com/office/VLB405docs. 
 

Connecting to Wi-Fi Direct 

You can connect to your printer from a Wi-Fi mobile device, such as a tablet, computer, or smart phone, 
using Wi-Fi Direct. Wi-Fi Direct is disabled by default. 

Note: Wireless networking is available only on printers with the optional Wireless Network Adapter 
installed. 

To connect with Wi-Fi Direct, follow the directions provided with your mobile device. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLB405&PgName=Man&Language=English
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Connecting to a Telephone Line 
 

 WARNING: To reduce the risk of fire, use only No. 26 American Wire Gauge (AWG) or larger 
telecommunication line cord. 

 

1. Ensure that the printer is powered off. 
2. Connect a standard RJ11 cable, No. 26 American Wire Gauge (AWG) or larger, to the Line port on 

the back of the printer. 
3. Connect the other end of the RJ11 cable to an operating telephone line. 
4. Power on the printer. 
5. Enable and configure the Fax functions. 
 

Initial Printer Setup 

Before installing the printer software, verify that the printer is set up correctly. Setup includes enabling 
the optional features and assigning an IP address for the Ethernet network connection. The installation 
wizard starts automatically the first time the printer is started. The installation wizard prompts the 
System Administrator to configure the following settings: 
• Language 
• Network Connection 
• Proxy Server Setup 
• Date and Time 
• Measurements 
• LDAP Settings 
• Apps Setup 
• Security Settings 

For more information on configuring the printer settings, refer to the System Administrator Guide at 
www.xerox.com/office/VLB405docs. 
 

Configuring AirPrint 

AirPrint is a software feature that allows you to print from wired or wireless Apple iOS-based mobile 
devices and Mac OS-based devices without the need to install a print driver. AirPrint-enabled printers 
allow you to print or fax directly from a Mac, an iPhone, iPad, or iPod touch. You can use AirPrint to print 
from a wired device or a wireless device without using a print driver. 

 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLB405&PgName=Man&Language=English
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Notes: 

• Not all applications support AirPrint. 
• Wireless devices must join the same wireless network as the printer. 
• For AirPrint to function, both IPP and Bonjour (mDNS) protocols must be enabled. 
• The device that submits the AirPrint job must be on the same subnet as the printer. To allow 

devices to print from different subnets, configure your network to pass multicast DNS traffic 
across subnets. 

• The Mac OS device must be Mac OS 10.7 or later. 
• AirPrint-enabled printers work with all models of iPad, iPhone (3GS or later), and iPod touch 

(3rd generation or later), running the latest version of iOS. 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 34. 

2. In the Embedded Web Server, click Home > Connectivity. 

Note: If this feature does not appear, log in as a system administrator. 

3. For Mobile Printing, click AirPrint™. 
4. To enable AirPrint™, click the Enable toggle button. 

Note: AirPrint™ is enabled by default when IPP and Bonjour (mDNS) are both enabled. 

− To change the printer name, in the Name field, enter a new name. 
− To enter a location for the printer, in the Location field, enter the location of the printer. 
− To enter a physical location or address for the printer, in the Geo-Location field, enter the 

geographic latitude and longitude coordinates in decimal form. For example, use coordinates 
such as 45.325026, -122.766831 for a location. 

5. Click OK. 
6. To activate your changes, at the prompt, click Restart Now. 
 

Configuring Google Cloud Print 

Google Cloud Print allows you to print documents that are stored in the cloud without using a print 
driver. 

Before you begin: 
• Set up a Google email account. 
• Configure the printer to use IPv4. 
• Configure Proxy Server settings as needed. 
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To configure Google Cloud Print: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 34. 

2. In the Embedded Web Server, click Home > Connectivity. 
3. For Mobile Printing, click Google Cloud Print. 
4. To enable Google Cloud Print, click the Enable toggle button. 
5. Click OK. 
6. Restart the printer, then wait two minutes for the printer to connect. 
7. Refresh your Web browser, then for Mobile Printing, click Google Cloud Print. 
8. Click Printer Registration. 
9. Click Register. 

A printer registration page prints. 
10. To register the printer, in your Web browser, type the URL provided, or use your mobile phone to 

scan the barcode. 
After the printer is registered, a confirmation status window appears. 

11. To access the Google Cloud Print feature, in your Google account, click Manage Your Printer. 

Note: The default printer name appears in this format: Model name (MAC address). 
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Installing the Software 

This section includes: 
• Operating System Requirements ............................................................................................................................... 46 
• Installing the Print Drivers for a Windows Network Printer ............................................................................. 47 
• Installing the Print Drivers for a Windows USB Printer ...................................................................................... 47 
• Installing the Drivers and Utilities for Macintosh OS X ..................................................................................... 48 
• Installing Drivers and Utilities for UNIX and Linux ............................................................................................. 51 
• Installing the Printer as a Web Service on Devices ............................................................................................. 51 

Before installing driver software, verify that the printer is plugged in, turned on, connected correctly, and 
has a valid IP address. The IP address usually appears in the upper right corner of the control panel. If 
you cannot find the IP address, refer to Finding the IP Address of Your Printer on page 34. 

If the Software and Documentation disc is not available, download the latest drivers from 
www.xerox.com/office/VLB405drivers. 
 
 

Operating System Requirements 
• Windows 7, Windows 8.1, Windows Server 2008, Windows 10, Windows Server 2008 R2, and 

Windows Server 2012. 
• Macintosh OS X version 10.9 and later. 
• UNIX and Linux: Your printer supports connection to various UNIX platforms through the 

network interface. 
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Installing the Print Drivers for a Windows Network Printer 
1. Insert the Software and Documentation disc into the appropriate drive on your computer. If the 

installer does not start automatically, navigate to the drive, and double-click the Setup.exe  
installer file. 

2. Select your printer model. 
3. Click Install Drivers. 
4. Select Install Print Driver, Install Scan Driver, or Install Print and Scan Drivers. 
5. At the License Agreement, click I Agree. 
6. From the list of discovered printers, select your printer. 

Note: When installing drivers for a network printer, if your printer does not appear in the list, click 
the IP Address or DNS Name button. In the IP Address or DNS Name field, type the IP address of 
your printer, then click Search to locate and select your printer. If you do not know the IP address of 
the printer, refer to Finding the IP Address of Your Printer on page 34. 

7. Click Next. 
8. If desired, you can name your printer by typing a name in the Queue Name field. 
9. If installing a print driver, make a print driver selection. 
10. If installing a scan driver, make a scan driver selection. 
11. Click Install. 
12. If desired, set the printer as the default printer. 

Note: Before selecting Share Printer, contact your system administrator.  

13. To complete the installation, click Finish, then click Close. 
 

Installing the Print Drivers for a Windows USB Printer 
1. Insert the Software and Documentation disc into the appropriate drive on your computer. 

If the installer does not start automatically, navigate to the drive, and double-click the Setup.exe 
installer file. 

2. Click Install Software. 
3. At the License Agreement, select I Agree, then click Next. 
4. To install the printer support software, select Software, then click Next. 
5. In the Software and Documentation window, clear the check box for any undesired options. 
6. Click Next. 
7. To complete the installation, click Finish. 
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Installing the Drivers and Utilities for Macintosh OS X 
1. Insert the Software and Documentation disc into the appropriate drive on your computer. 
2. Open Xerox® Print Drivers 3.xx.x.dmg/.pkg as needed for your printer. 
3. To run Xerox® Print Drivers 3.xx.x.dmg/.pkg, double-click the appropriate file name. 
4. When prompted, click Continue. 
5. To accept the license agreement, click I Agree. 
6. To accept the current installation location, click Install, or select another location for the installation 

files, then click Install. 
7. If prompted, enter your password, then click OK. 
8. From the list of discovered printers, select your printer, then click Next. 
9. If your printer does not appear in the list of discovered printers: 

a. Click the Network Printer Icon. 
b. Type the IP address of your printer, then click Continue. 
c. Select your printer in the list of discovered printers, then click Continue. 

10. If your printer was not detected, verify that the printer is on and that the Ethernet or USB cable is 
connected properly. 

11. To accept the print queue message, click OK. 
12. Select or clear the Set Printer as Default and Print a Test Page check boxes. 
13. Click Continue, then click Close. 
 

Adding the Printer 

For networking, set up your printer using Bonjour (Rendezvous), or connect using the IP address of your 
printer for an LPD/LPR connection. For a non-network printer, create a desktop USB connection. 

To add the printer using Bonjour: 
1. From the computer Applications folder or from the dock, open System Preferences. 
2. Click Printers & Scanners. 

The list of printers appears on the left of the window. 
3. Under the list of printers, click the plus button (+). 
4. At the top of the window, click the Default icon. 
5. Select your printer from the list, then click Add. 

Note: If your printer was not detected, verify that the printer is on and that the Ethernet cable is 
connected properly. 

To add the printer by specifying the IP address: 
1. From the computer Applications folder or from the dock, open System Preferences. 
2. Click Printers & Scanners. 

The list of printers appears on the left of the window. 
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3. Under the list of printers, click the plus button (+). 
4. Click IP. 
5. From the Protocol drop-down menu, select the protocol. 
6. In the Address field, enter the IP address of the printer. 
7. In the Name field, enter a name for the printer. 
8. From the Print Using drop-down list, choose Select a driver to use. 
9. From the printer software list, select the print driver for your printer model. 
10. Click Add. 
 

For reference:  
Online Support Assistant at: www.xerox.com/office/VLB405support  
 
 

Installing Scan Drivers for Macintosh 
1. Insert the Software and Documentation disc into your computer. 
2. Double-click the disc icon on your desktop to view the .dmg file for your printer. 
3. Open the Scan Installer.dmg file, then navigate to the appropriate installer file for your operating 

system. 
4. Open the Scan Installer package file. 
5. Click Continue to acknowledge the warning and introductory messages. 
6. To accept the license agreement, click Continue, then click Agree. 
7. To accept the current installation location, click Install, or select another location for the installation 

files, then click Install. 
8. Enter your password, then click OK. 
9. Select your printer in the list of discovered printers, then click Continue. 
10. Click Continue Installation. 
11. To restart, click Log Out.

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLB405&PgName=tech&Language=English
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Installing LAN Fax Drivers for Macintosh 
1. Insert the Software and Documentation disc into your computer. 
2. Double-click the disc icon on your desktop to view the .dmg file for your printer. 
3. Open the LAN Fax Installer.dmg file, then navigate to the appropriate installer file for your 

operating system. 
4. Open the LAN Fax Installer package file. 
5. Click Continue to acknowledge the warning and introductory messages. 
6. To accept the license agreement, click Continue, then click Agree. 
7. To accept the current installation location, click Install, or select another location for the installation 

files, then click Install. 
8. Enter your password, then click OK. 
9. Select your printer in the list of discovered printers, then click Continue. 
10. Click Continue Installation. 
11. To finish, click Close. 
12. To register your printer and software, complete the registration form. 
 

Adding a LAN Fax Printer for Macintosh 

After installing the LAN fax driver on a Macintosh computer, use Bonjour to set up your printer. You can 
also add the printer using the IP Address of the printer for an LDP/LPR connection. For non-network 
printers, create a desktop USB connection. 

To add the printer using Bonjour: 
1. From the computer Applications folder or from the dock, open System Preferences. 
2. Click Printers & Scanners. 

The list of printers appears on the left of the window. 
3. Under the list of printers, click the plus button (+). 
4. At the top of the window, click the Default icon. 
5. Select your printer from the list, then click Add. 

Note: If the printer is not detected, ensure that the printer is on and that the cable is connected 
properly. 

6. In the Print Using drop-down list, choose Select Printer Software. 
7. In the printer software list, select the appropriate Xerox® LAN fax driver model, then click OK. 
8. Click Add. 

To add the printer by specifying the IP address: 
1. From the computer Applications folder or from the dock, open System Preferences. 
2. Click Printers & Scanners. 

The list of printers appears on the left of the window. 
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3. Under the list of printers, click the plus button (+). 
4. Click IP. 
5. From the Protocol drop-down menu, select the Protocol. 
6. In the Address field, enter the IP address of the printer. 
7. In the Name field, enter the name of the printer. 
8. In the Print Using drop-down list, choose Select Printer Software. 
9. In the printer software list, select the appropriate Xerox® LAN fax driver model, then click OK. 
10. Click Add. 
 

Installing Drivers and Utilities for UNIX and Linux 

For details on installing print drivers and utilities for UNIX and Linux, refer to UNIX and Linux Printing on 
page 118. 
 

Installing the Printer as a Web Service on Devices 

Web Services on Devices (WSD) allow a client to discover and access a remote device and its associated 
services across a network. WSD supports device discovery, control, and use. 

To install a WSD printer using the Add Device Wizard: 
1. At your computer, click Start, then select Devices and Printers. 
2. To launch the Add Device Wizard, click Add a Device. 
3. In the list of available devices, select the one you want to use, then click Next. 

Note: If the printer you want to use does not appear in the list, click the Cancel button. Add the 
WSD printer manually using the Add Printer Wizard. 

4. Click Close. 

To install a WSD printer using the Add Printer Wizard: 
1. At your computer, click Start, then select Devices and Printers. 
2. To launch the Add Printer Wizard, click Add a Printer. 
3. Click Add a network, wireless, or Bluetooth printer. 
4. In the list of available devices, select the one you want to use, then click Next. 
5. If the printer you want to use does not appear in the list, click The printer that I want is not listed. 
6. Select Add a printer using a TCP/IP address or hostname, then click Next. 
7. From the Device type field, select Web Services Device. 
8. Enter the printer IP address in the Hostname or IP address field, then click Next. 
9. Click Close. 
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More Information 

You can obtain more information about your printer from these sources: 
 

Resource Location 

Installation Guide Packaged with the printer. 

Other documentation for your printer www.xerox.com/office/VLB405docs  

Technical support information for your printer; 
including online technical support, Online Support 
Assistant, and print driver downloads. 

www.xerox.com/office/VLB405support  

Information Pages Print from the control panel. For details, refer to 
Information Pages on page 32. 

Order supplies for your printer www.xerox.com/office/VLB405supplies  

A resource for tools and information, including 
interactive tutorials, printing templates, helpful tips, 
and customized features to meet your individual 
needs. 

www.xerox.com/office/businessresourcecenter  

Local sales and Technical Customer Support www.xerox.com/office/worldcontacts  

Printer registration www.xerox.com/office/register  

Xerox® Direct online store www.direct.xerox.com/  
 

 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLB405&PgName=Man&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLB405&PgName=tech&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=VersaLink+VLB405&PgName=order&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&PgName=businessresourcecenter&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&PgName=customersupport&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&PgName=reg&Language=English
http://www.direct.xerox.com/
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Customize and Personalize Overview 

This chapter provides information on how to customize and personalize your device to meet the specific 
demands of your workflows. 
 

 

You can Customize your Apps, hide, or show Apps on the Home screen, and rearrange 
the order to suit your job priorities. For each App, you can hide or show individual 
features and configure default settings to meet the needs of your workgroup. You 
can save job settings for repeated use. 

Customization enables users to work more productively. 

 

When individual user accounts are configured on the device, you can Personalize the 
device to meet specific user needs. You can configure your personal Home page to 
hide or show only the Apps you use. Each of the feature lists can be tailored to your 
job requirements. Default settings for each app can be specified, and settings for 
regular jobs can be saved for your use. 

Personalization options ensure that the features and functions displayed meet 
individual user needs, improving efficiency. 
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Customizing or Personalizing the Home Screen 

To hide or show an App on the Home screen: 
1. At the printer control panel, press the Home button. 
2. Touch Customize. 
3. To display an installed, but hidden App: 

a. Touch +. 
b. Touch the App that you want to appear on the control panel. 
c. Touch Done. 

4. To hide an installed App: 
a. For the desired App, touch X. 
b. Touch Done. 

5. Verify that only the desired Apps are displayed on the Home screen. 

To rearrange Apps on the Home screen: 
1. At the printer control panel, press the Home button. 
2. Touch Customize. 
3. Touch and hold the required App. 
4. Drag the App to the new location. 
5. Release the App. 
6. Touch Done. 
7. Verify that the Apps appear in the correct location on the Home screen. 
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Customizing or Personalizing the Apps 

Customization enables you to modify the features available, delete a saved preset, or remove 
customized settings applied to an App. 
 

Customizing or Personalizing the Feature List 

To customize the Features list for an App: 
1. At the printer control panel, press the Home button. 
2. Touch the App required. 
3. Scroll to the bottom, then touch Customize. 
4. Touch Feature List. 

Note: For logged-in administrators, a window appears that asks you to confirm if the changes are 
for a Guest or for you. 

5. Touch the desired option. 
− To hide a feature, for the required feature, touch the Eye icon. To signify that the feature is 

hidden, the Eye icon appears with a line across. 
− To show a feature, for the required feature, touch the Eye icon. To signify a feature is visible, 

the Eye icon appears with no line across. 
6. To reorder the menu features, touch and drag the features into the desired order. 
7. To save the current configuration, touch Done. 
 

Customizing or Personalizing the Entry Screen 

The Entry Screen is appears when the Fax, Email, USB or Scan To Apps are selected. The Entry Screen 
provides options for entering recipient or destination details for a job. Use this procedure to choose the 
options that to appear on the Entry Screen. 

To customize the Entry Screen for an App: 
1. At the printer control panel, press the Home button. 
2. Touch the App required. 
3. Scroll to the bottom, then touch Customize. 
4. Touch Entry Screen. 
5. Touch the needed options. 

Note: For logged-in administrators, a window appears that asks you to confirm if the changes are 
for a Guest or for you. 

6. To save the current configuration, touch X. 
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Saving Presets 

You can use this feature to save a particular combination of App settings for future jobs. You can save 
the settings with a name and retrieve them for later use. 

To save the current App settings: 
1. At the printer control panel, press the Home button. 
2. Touch the App required. 
3. Select the job settings. 
4. Scroll to the bottom, then touch Save. 
5. Touch Save as New Preset. 
6. Touch Enter Preset Name, then to enter a preset name, use the keypad. 
7. Touch Next. 
8. Select an icon that best suits the preset that you are creating. 
9. Touch Done. 

Note: The preset is stored within the Preset feature. 
 

Deleting a Saved Preset 

To delete a saved preset: 
1. At the printer control panel, press the Home button. 
2. Touch the App required. 
3. Scroll to the bottom, then touch Customize. 
4. Touch Presets. 
5. Touch the Trash icon that corresponds with the preset that you want to delete. 
6. At the prompt, touch Delete. 
7. Touch Done. 
 

Removing App Customization 

To remove the current App customization settings: 
1. At the printer control panel, press the Home button. 
2. Touch the App required. 
3. Scroll to the bottom, then touch Customize. 
4. Touch Remove App Customization. 
5. At the prompt, touch OK. 
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Customizing App Default Settings 
To customize the App default settings: 

1. At the control panel, press the Home button. 
2. Touch the App required. 
3. Configure the required default settings. 
4. Touch Save. 
5. Touch Save Defaults. The new settings override the previous default settings. 
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• USB ...................................................................................................................................................................................... 110 

Xerox® Apps are a gateway to the features and functions of your device. There are standard Apps 
already installed and displayed on the Home screen. There are also Apps that are installed as standard 
but are hidden when your device is used for the first time. 

For details about Customizing the Home screen and the Apps features, refer to Customize and 
Personalize on page 53. 

A range of Apps are available for download and installation from the Xerox® App Gallery. These include 
Xerox® Extensible Interface Platform (EIP) Apps. EIP Apps enable you to install secure, signed apps on 
compatible printers. 

For more information about using the Xerox® Apps Gallery and downloading Apps, refer to Xerox Apps 
Gallery on page 60. 
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Xerox® App Gallery 

This section includes: 
• Xerox® Apps Gallery Overview .................................................................................................................................... 60 
• Creating a Xerox® App Gallery Account .................................................................................................................. 60 
• Logging in to your Xerox® App Gallery Account .................................................................................................. 61 
• Installing or Updating an App from the Xerox® App Gallery .......................................................................... 61 
 
 

Xerox® Apps Gallery Overview 
 

 

Use the Xerox® App Gallery to find Apps that provide new features or capabilities for 
your device. The Xerox® App Gallery allows you direct access to Apps that can 
improve your productivity, simplify workflows, and enhance your user experience. 

 

To use the Xerox® App Gallery App, ensure that your device uses either the wireless or the wired network 
connection. 

Note: If your device is hosted by a local server inside a firewall and a proxy is enabled, set a proxy 
exception at the device. 

For further information and instructions on using the Xerox® App Gallery, refer to the Xerox® App Gallery 
User Guide available at www.xerox.com. 
 

Creating a Xerox® App Gallery Account 

With an App Gallery account, you have direct access to all the available Apps for your device. An App 
Gallery account allows you to view and acquire Apps, install Apps on your device, and manage your Apps 
and licenses. 

An App Gallery account can be setup using the control panel or the Embedded Web Server. For 
information about accessing the Embedded Web Server, refer to Getting Started on page 34. 

Note: If you have an existing Xerox App Gallery Account, refer to Logging in to your App Gallery Account 
on page 61. 

http://www.xerox.com/XeroxAppGallery
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To create an App Gallery account using the Control Panel: 
1. At the printer control panel, press the Home button. 
2. Touch Xerox App Gallery. 
3. Touch Request an Account. 
4. Touch the Enter your email address. Enter a valid email address using the touch screen keypad, 

then touch Enter. 
5. Touch OK. A message is displayed stating completion instructions have been sent to the email 

address entered. 
6. Touch Close. 
7. Access your email account for the email address that you provided to Xerox App Gallery. 
8. Open the Xerox App Gallery Account Request email, then click the URL link for creating an account. 
9. Review and accept the Terms of Use. To continue creating an account, click the Agree button. 
10. Enter the information required into the appropriate fields: 

− User ID 
− Password 
− Confirm Password 
− First and Last Name 
− Company Name 
− Address (Street, City, State/Province, Postal) 
− Country 

11. Click OK. 
12. After the account is created, a confirmation message appears. 
13. At the printer control panel, log in to your App Gallery Account. 
 

Logging in to your Xerox® App Gallery Account 

When you are logged in to the App Gallery, you can browse available Apps, and install and update Apps. 

To log in to your App Gallery Account: 
1. At the printer control panel, press the Home button. 
2. Touch Xerox® App Gallery. 
3. Enter your User Name using the touch screen keypad, then touch Enter. 
4. Enter your Password using the touch screen keypad, then touch Enter. 
5. Touch Log In. The Xerox® App Gallery appears. 
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Installing or Updating an App from the Xerox® App Gallery 

Xerox® Apps add, extend, or customize the functionality of your device. You can use the Xerox® App 
Gallery App to browse and install Apps at your device control panel. 

To install an App from the App Gallery: 
1. At the printer control panel, press the Home button. 
2. Touch Xerox® App Gallery. 
3. Enter your User Name using the touch screen keypad, then touch Enter. 
4. Enter your Password using the touch screen keypad, then touch Enter. 
5. Touch Log In. The Xerox® App Gallery appears. 
6. Touch the App required, then touch Install. The License Agreement screen appears. 

Note: If the App was installed previously and a new version is available, the button is laeled as 
Update. 

7. Touch Agree. The installation process begins. 
If the App does not successfully install, to attempt the installation process again, touch Install. 

8. To exit the Xerox® App Gallery App, touch Exit. 

To update an App from the App Gallery: 
1. At the printer control panel, press the Home button. 
2. Touch Xerox® App Gallery. 
3. Enter your User Name using the touch screen keypad, then touch Enter. 
4. Enter your Password using the touch screen keypad, then touch Enter. 
5. Touch Log In. The Xerox® App Gallery appears. 
6. Touch the App required, then touch Update. The License Agreement screen appears. 
7. Touch Agree. 
8. When the update is complete, the Update button is labeled as Installed. 
9. To exit the Xerox® App Gallery App, touch Exit. 
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Device 

This section includes: 
• Device Overview ............................................................................................................................................................... 63 
• About .................................................................................................................................................................................... 64 
• Supply Status ..................................................................................................................................................................... 65 
• Billing and Usage Counters .......................................................................................................................................... 66 
• Reset to Factory Defaults ............................................................................................................................................. 66 
• Remote Services................................................................................................................................................................ 67 
 
 

Device Overview 
 

 

The Device App gives you access to information about your printer, including the 
serial number and model. You can view the status of the paper trays, billing and 
supplies information, and print information pages. 

 

Many Device options can be configured to meet your individual needs. For details about configuring all 
of the Device settings, refer to the System Administrator Guide at www.xerox.com/office/VLB405docs . 
 

Device Options 

The following Device options are available: 
 

Option Description 

 

Language Language allows you to set the language that appears on the control panel 
display. 

 

About The About option provides an overview of your device and its current 
settings and status. You can access information pages and reports using 
this option. 

 

Software Update Use this option to check for software updates and configure update 
settings. 

 

Notifications Use the Notifications option to see details of any current alerts or faults on 
the device. A History button displays fault codes and the date they occurred 
on the device. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLB405&PgName=Man&Language=English
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Paper Trays Use the Paper Trays option to see the paper size, type, and color set for 
each paper tray and the tray-capacity status. 

 

Supplies Use the Supplies section to monitor the status of the components you can 
replace. The supply level and estimated number of impressions or days left 
for each unit is displayed. 

 

Billing/Usage Use the Billing/Usage option to view the serial number and the total 
number of impressions made by your device. 

 

General Use the General option to customize settings such as the power-save 
modes, date and time, and control panel brightness. You can configure the 
General settings using the device control panel, or by using the Embedded 
Web Server. 

 

Apps Use Apps to select settings for the Apps installed on your device. 

 

Connectivity Use the Connectivity option to configure network settings at the control 
panel, or join another wireless network. 

 

Support Use this option to access and print the Support Pages to assist with 
troubleshooting errors. 

 

Resets Use the Resets option to reset device settings and font, forms, and macros 
to the factory-default settings. 

For details on configuring the printer settings, refer to the System Administrator Guide at 
www.xerox.com/office/VLB405docs. 
 

About 

The About option provides an overview of your device and its current settings and status. You can access 
information pages and reports using this option. 
 

Information Pages 

Your printer has a set of information pages that you can print. These pages include configuration and 
font information, demonstration pages, and more. 

The following Information Pages are available: 
 

Name Description 

 

Configuration Report The Configuration Report provides printer information including 
installed options, network settings, port setup, tray information, 
and more. 

 

Billing Summary Report The Billing Summary Report provides information about the 
device and a detailed listing of the billing meters and sheet 
counts. 

 

Supplies Usage Report The Supplies Usage Report provides coverage information and 
part numbers for reordering supplies. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLB405&PgName=Man&Language=English
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PostScript Font List The PostScript Font List provides a printout of all PostScript fonts 
that are available on the printer. 

 

PCL Font List The PCL Font List provides a printout of all PCL fonts that are 
available on the printer. 

 

Demonstration Print Demonstration Print provides a demonstration of the current 
print quality. 

 

Startup Page The Startup Page provides basic printer configuration and 
network information. 

 

Job History Report The printer retains information on previous print jobs, including 
the date, time, job type, document name, output color, paper size, 
number of pages, and results. The status of a maximum of 20 
jobs prints on the Job History Report. 

 
 

Supply Status 

You can check the status and percentage of life remaining for your printer supplies at the control panel 
or from the Embedded Web Server. When printer supplies near their replacement time, warning alerts 
appear on the control panel. You can customize the alerts that appear on the control panel and 
configure email alert notifications. 

To check the supplies status at the control panel: 
1. To view status information for the printer supplies, touch Device > Supplies. 
2. To view details about a specific item, including its part number for reordering, touch the desired 

item. 
3. To return to the Supplies screen, touch X. 
4. To return to the Device screen, touch the back arrow. 

To customize supplies alert settings: 
1. To customize the alerts that appear for printer supplies, touch Device > Supplies > Alerts Setup. 
2. To enable supplies alerts, touch the Enable Alerts toggle button. 
3. To configure the printer to display an alert when an item reaches a specific usage percentage level, 

touch the item, then select the percentage. 
4. To customize the alerts for each supply item, to enable or disable an alert, touch the toggle button. 
5. To return to the Supplies screen, touch X. 
6. To return to the Device screen, touch the back arrow. 
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To set up email alerts: 
1. To set up alerts to send to an email address, touch Device > Supplies > Email Alerts. 
2. To enter an email address, touch Add Email, then touch Enter Email Address. 
3. Use the touch screen keyboard to enter an email address, or select an entry from the Address Book, 

then touch OK. 
4. Add more email addresses if necessary. 
5. To customize the alerts for each supply item, to enable or disable an alert, touch the toggle button. 
6. To exit the menu, touch OK. 
7. To return to the Device screen, touch the back arrow. 

To check the supplies status and set up alerts using the Embedded Web Server, refer to the System 
Administrator Guide at www.xerox.com/office/VLB405docs. 
 

Billing and Usage Counters 

The Billing/Usage menu displays the total number of impressions that the printer generated or printed 
during its lifetime. You cannot reset the counters. A page is counted as one side of a sheet of paper. For 
example, a sheet of paper that is printed on two sides counts as two impressions. 

To view the Billing and Usage Counters: 
1. At the printer control panel, press the Home button. 
2. Touch Device > Billing/Usage. 
3. To view more details, touch Usage Counters, then select an option. 

− Impression Counters: This option provides the number of impressions made by the printer. The 
number of impressions cannot equal the number of sheets counted, depending on the printer 
setup. If your printer is set up to count large sheets as large impressions or as multiple smaller 
impressions, the number of impressions can differ. 

− Sheet Counters: This option provides the number of impressions made by the printer. 
Impressions for 2-Sided sheets are identified as a separate line from1-Sided sheets. 

− Images Sent Counters: This option provides the number of images sent using the Fax, Email, 
or Scan features. 

− Fax Impressions Counters: This option provides the number of images sent using the Fax 
features. Each fax feature is identified on a separate line. 

− All Usage Counters: This option provides all of the printer usage information. 
4. After viewing the usage readings, to return to the Home screen, press the Home button. 
 

Reset to Factory Defaults 

The non-volatile memory (NVRAM) stores printer settings, even after the power is turned off. The Reset 
to Factory Defaults feature erases all settings and returns the printer to original factory state. All jobs, 
presets, Apps, and device settings are reset. When complete, the printer restarts, then displays the 
Install Wizard. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLB405&PgName=Man&Language=English
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To reset the printer to factory defaults: 
1. At the printer control panel, press the Home button. 
2. Touch Device > Resets > Reset to Factory Defaults. 
3. At the prompt, touch Reset. 
4. When the process is complete, the printer restarts automatically. 
 

Remote Services 

You can use the Remote Services option in the Embedded Web Server to send error and usage 
information to the Xerox support team to help them resolve problems quickly. 

For information about enabling Remote Services and uploading information to Xerox, refer to the 
System Administrator Guide at www.xerox.com/office/VLB405docs. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLB405&PgName=Man&Language=English
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Address Book 

This section includes: 
• Address Book Overview .................................................................................................................................................. 68 
• Editing the Address Book .............................................................................................................................................. 68 
• Managing Favorites ........................................................................................................................................................ 71 
 
 

Address Book Overview 
 

 

Use the Device Address Book to create individual contacts or group contacts for use 
with the Email, Fax, and Scan To Apps. Contacts can be added to the Device Address 
Book using the control panel or the Embedded Web Server. 

 

The Device Address Book stores a maximum of 2000 contacts. If the Create New Contact button is 
unavailable, the address book has reached its capacity. 

Before you can use this feature, the System Administrator must enable users to view and manage the 
Device Address Book. 
 

Editing the Address Book 

You can create and save contact information for individual contacts or groups. You can manage address 
book contacts at the control panel, or in the Embedded Web Server. 
 

Adding or Editing Contacts in the Address Book at the Control Panel 

To add contacts: 
1. At the printer control panel, press the Home button. 
2. Touch Address Book. 
3. Touch the Plus icon (+), then select Add Contact. 
4. To enter a name, touch the Enter First Name, Enter Last Name, or Enter Company field, then 

enter the information. To move to the next field, touch Next. When finished, touch Enter
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5. Enter the contact details: 

− To add an email address to the contact, touch Add Email. Enter an email address, 
then touch Enter. 

− To add a fax number to the contact, touch Add Fax. Enter a fax number, then touch Enter. 
− To add an SMB scan location, touch Add SMB. Browse to the location required,  

then touch Enter. 
− To add an FTP scan location, touch Add FTP. Browse to the FTP location or enter the FTP 

address, then touch Enter. 

Note: If authentication is required for scan locations, enter a valid login name and password. 

6. To mark the email address or fax number as a favorite, touch the Star icon. 
7. To save the contact, touch OK. 
8. To return to the Home screen, press the Home button. 

To edit or delete contacts: 
1. At the printer control panel, press the Home button. 
2. Touch Address Book. 
3. From the Address Book, touch a contact name, then touch Edit. 
4. To change contact information, touch the information that you want to update, edit as needed, 

then touch OK. 
5. To save your contact changes, touch OK. 
6. To delete a contact, touch Delete Contact, then touch Delete. 
7. To return to the Home screen, press the Home button. 
 

Adding or Editing Groups in the Address Book at the Control Panel 

To add groups: 
1. At the printer control panel, press the Home button, then touch Address Book. 
2. Touch the Plus icon (+), then select Add Group. 
3. Select the group type, enter a name for the group, then touch Enter. 
4. To add group members, touch Add Member. 
5. To add a contact name, from the Favorites or Contacts menu, select a contact. 
6. To add more group members, touch Add Member, then select a contact. 
7. To mark the group as a favorite, touch the Star icon. 
8. To save the group, touch OK. 
9. To return to the Home screen, press the Home button. 
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To edit or delete groups: 
1. At the printer control panel, press the Home button. 
2. Touch Address Book. 
3. From the Address Book, select a group, then touch Edit. 
4. To add group members, touch Add Member. 
5. To add a contact, from the Favorites or Contacts menu, select a contact. 
6. To add more group members, touch Add Member and select a contact. 
7. To remove group members, for each contact, touch the Trash icon. At the prompt, touch Delete. 
8. To save the changes, touch OK. 
9. To delete the group, touch Delete Group, then touch Delete. 
10. To return to the Home screen, press the Home button. 
 

Adding or Editing Contacts in the Address Book in the Embedded Web Server 

To add contacts: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, click Address Book. 
3. Click Add Contact. 
4. To enter a name, click the First Name, Last Name, or Company field, then enter the details. 
5. Enter the contact details. 

− To add an email address to the contact, click the Email Plus icon (+), then enter an email 
address. 

− To add a fax number to the contact, click the Fax Plus icon (+), then enter a fax number. 
− To add an SMB scan location, click the (Network) SMB Plus icon (+), then enter the SMB details. 

Click OK. 
− To add an FTP scan location, click the FTP Plus icon (+), then enter the FTP details. Click OK. 

6. To mark the email address or fax number as a favorite, touch the Star icon. 
7. To save the contact, click OK. 

To edit or delete contacts: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, click Address Book. 
3. From the Address Book, select a contact. 
4. To edit contact information, perform the following steps. 

a. Click the contact name or contact information, then edit as needed. 
b. To clear contact information, for the specific contact information, click the Trash icon. 
c. To save the changes, click OK. 

5. To remove the selected contact from the Address Book, click Delete. At the prompt, click Delete. 
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Adding or Editing Groups in the Address Book in the Embedded Web Server 

To add groups: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, click Address Book. 
3. Click Add Group. 
4. For Enter Group Name, enter a name for the group. 
5. From the menu, select the group type. 
6. To add group members, for Members, click the plus icon (+). 
7. To add contacts to the group, in the Add Members window, for each contact, select the check box. 

When you are finished, click OK. 
8. To save the group, click OK. 

To edit or delete groups: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, click Address Book. 
3. Within the address book, select a group. 
4. To add group members: 

a. For Members, click the plus icon (+). 
b. In the Add Members window, click the check box for each desired member. 
c. To save the changes, click OK. 

5. To remove group members: 
a. For the desired member, click the Trash icon. 
b. At the prompt, click Delete. 
c. Repeat the previous two steps for each member. 
d. To save the changes, click OK. 

6. To remove the selected group from the Address Book, click Delete. At the prompt, click Delete. 
 

Advanced Settings 

The Advanced option provides more settings for importing and exporting contact details and managing 
contacts. You can use the Advanced option to set up a directory service. 

For details about the Advanced options, refer to the System Administrator Guide at 
www.xerox.com/office/VLB405docs . 
 

Managing Favorites 

You can mark contacts as Favorites. A star next to a contact in the list indicates a Favorite. You can mark 
a favorite as a Global Favorite for all services or as a Favorite for email, fax, or scan-to destinations. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLB405&PgName=Man&Language=English
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Managing Favorites at the Control Panel 
1. At the printer control panel, press the Home button, then touch Address Book. 
2. Select a contact, then touch Edit. 
3. To make the contact a Global Favorite, for the contact name, touch the Star icon. 
4. To mark a contact as a Favorite for email, fax, or a scan-to destination: 

a. For each desired feature, touch the Star icon. 
b. To save changes, touch OK. 

5. To clear a contact marked as a Favorite: 
a. To remove the contact as a Global Favorite, for the contact name, touch the Star icon. 
b. To remove the contact from the Favorite list for a selected feature, for the selected feature, 

touch the Star icon. 
c. To save changes, touch OK. 

6. To return to the Home screen, press the Home button. 
 

Managing Favorites in the Embedded Web Server 
1. In the Embedded Web Server, click Address Book. 
2. Select a contact. 
3. To make the contact a Global Favorite, click the Global Favorite Star icon. 
4. To mark a contact as a Favorite for email, fax, or a scan-to destination, for each feature, click the 

Star icon. 
5. To remove a contact marked as a Favorite, for Global Favorite or the selected feature, touch the 

Star icon. The contact is removed from the Global Favorite list, or the Favorite list for the selected 
feature. 

6. To save changes, click OK. 
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Jobs 

This section includes: 
• Jobs Overview .................................................................................................................................................................... 73 
• Managing Jobs .................................................................................................................................................................. 73 
• Managing Special Job Types ....................................................................................................................................... 74 
• Managing Jobs using the Embedded Web Server ............................................................................................... 79 
 
 

Jobs Overview 
 

 

Use Jobs to view current jobs, print saved, personal, and secure jobs, and view details 
of completed jobs. You can pause, delete, print, or view job progress or job details for 
a selected job. 

 
 

Managing Jobs 

From the control panel Jobs menu, you can view lists of active jobs, secure jobs, or completed jobs. You 
can pause, delete, print, or view job progress or job details for a selected job. From the Jobs window in 
the Embedded Web Server, you can view a list of active and completed print jobs. For more details, refer 
to Managing Jobs using the Embedded Web Server on page 79. 

A print job can be held by the printer when it is unable to complete a print job. For example, it needs 
attention, paper, or supplies. When the condition is resolved, the printer automatically resumes printing. 
When you send a secure print job, the job is held until you release it by typing a passcode at the control 
panel. For more details, refer to Managing Special Job Types on page 74. 

To pause the print job with the option to delete it: 
1. At the printer control panel, press the Home button. 
2. Touch Jobs, then touch the name of the desired print job. 
3. Do one of the following: 

− To pause the print job, touch Pause. To resume the print job, touch Resume. 
− To delete the print job, touch Delete. At the prompt, touch Delete. 

Note: If you do not make a selection within 60 seconds, the job automatically resumes. 

4. To return to the Home screen, press the Home button. 
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To view, print, or delete saved and secure jobs: 
1. At the printer control panel, press the Home button. 
2. To view a list of active and completed jobs, touch Jobs. 
3. To view a list of specific job types, touch an option. 

− To view Saved Jobs, touch Saved Jobs. To print the job, touch the job, enter the quantity, then 
touch OK. To delete the job, touch the Trash icon, then touch Delete. 

− To view Personal jobs, touch Personal & Secure Jobs. To print the jobs, touch the folder, then 
touch Print All, or Delete All. 

− For Secure Jobs, touch Personal & Secure Jobs. Touch the folder, enter the passcode number, 
then touch OK. To print a Secure Job, touch the job. To print or delete all the jobs in the folder, 
touch Print All, or Delete All. 

4. To view details about a job, touch the job. 
5. To return to the Home screen, press the Home button. 

Notes: 

• The system administrator can restrict users from deleting jobs. If a system administrator has 
restricted job deletion, you can view the jobs, but not delete them. 

• Only the user that sent the job or the system administrator can delete a Secure Print job. 

To print a job held for resources: 
1. At the printer control panel, press the Home button. 
2. Touch Jobs. 
3. From the jobs list, touch the held job name. The resources required for the job appear on the control 

panel. 
4. Do one of the following: 

− To print the job, replenish the resources required. The job resumes automatically when the 
required resources are available. If the job does not print automatically, touch Resume. 

− To delete the print job, touch Delete. At the prompt, touch Delete. 
5. To return to the Home screen, press the Home button. 
 

Managing Special Job Types 

Special job types allow you to send a print job from your computer, then print it from the printer control 
panel. Select special job types in the print driver, Printing Options tab, under Job Type. 
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Saved Job 

Saved Jobs are documents sent to the printer and, unless deleted, are stored there for future use. Any 
user can print or delete a Saved Job. 

To print a Saved Job: 
1. In your software application, access the print settings. For most software applications, press CTRL+P 

for Windows or CMD+P for Macintosh. 
2. Select your printer, then open the print driver. 

− For Windows, click Printer Properties. Depending on your application, the title of the button 
can vary. 

− For Macintosh, in the Print window, click Preview, then select Xerox Features. 
3. For Job Type, select Saved Job. 
4. Type a job name or select a name from the list, then click OK. 
5. Select any other required printing options. 

− For Windows, click OK, then click Print. 
− For Macintosh, click Print. 

To release a Saved Job: 
1. At the printer control panel, press the Home button. 
2. Touch Jobs. 
3. To view Saved Jobs, touch Saved Jobs. 
4. To print a Saved Job, touch the job name, enter the quantity, then touch OK. 
5. To delete the document after printing, for that job, touch the Trash icon, then at the prompt, touch 

Delete. 
6. To return to the Home screen, press the Home button. 
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Secure Print 

Use Secure Print to print sensitive or confidential information. After you send the job, it is held at the 
printer until you enter your passcode at the printer control panel. 

To print using Secure Print: 
1. In your software application, access the print settings. For most software applications, press CTRL+P 

for Windows or CMD+P for Macintosh. 
2. Select your printer, then open the print driver. 

− For Windows, click Printer Properties. Depending on your application, the title of the button 
varies. 

− For Macintosh, in the Print window, click Preview, then select Xerox Features. 
3. For Job Type, select Secure Print. 
4. Type the passcode, confirm the passcode, then click OK. 
5. Select any other required printing options. 

− For Windows, click OK, then click Print. 
− For Macintosh, click Print. 

To release a Secure Print job: 
1. At the printer control panel, press the Home button. 
2. Touch Jobs. 
3. To view Secure Print jobs, touch Personal & Secure Jobs. 
4. Touch your folder. 
5. Enter the passcode number, then touch OK. 
6. Select an option: 

− To print a Secure Print job, touch the job. 
− To print all the jobs in the folder, touch Print All. 
− To delete a Secure Print job, touch the Trash icon, then at the prompt, touch Delete. 
− To delete all the jobs in the folder, touch Delete All. 

Note: After a Secure Print job is printed, it is deleted automatically. 

7. To return to the Home screen, press the Home button. 
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Personal Print 

Personal Print allows you to store a document in the printer, then print it from the control panel. 

Note: This feature is only available on a Windows computer printing to a network printer. 

Personal Print is a type of saved job with these features: 
• A Personal Print job appears in a folder named after the user ID associated with the print job. 
• A Personal Print job does not use a passcode. 
• Any user can print or delete a Personal Print job. 
• You can print all jobs in the list at once, delete an individual job, or delete all jobs in the list. 
• After a Personal Print job is printed, it is deleted automatically. 

To print using Personal Print: 
1. In your software application, access the print settings. For most software applications, click File > 

Print or for Windows, press CTRL+P. 
2. Select your printer, then click Printer Properties. Depending on your application, the title of the 

button varies. 
3. For Job Type, select Personal Print. 
4. Select any other required printing options, then click OK. 
5. To send the job to the printer, click Print. 

To release a Personal Print job: 
1. At the printer control panel, press the Home button. 
2. Touch Jobs. 
3. To view Personal Print jobs, touch Personal & Secure Jobs. 
4. Touch your folder. 
5. If prompted for a passcode, touch Skip. 

Note: When your folder contains Secure Print jobs and Personal Print jobs, the passcode prompt 
appears. 

6. Select an option. 
− To print a Personal Print job, touch the job. 
− To print all the jobs in the folder, touch Print All. 
− To delete all the jobs in the folder, touch Delete All. 

7. To return to the Home screen, press the Home button. 
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Sample Set 

The Sample Set job type prints one copy of a multiple-copy print job before printing the remaining 
copies. After reviewing the sample set, you can either print the remaining copies or delete them at the 
printer control panel. 

Sample Set is a type of saved job with these features: 
• A Sample Set job appears in a folder named after the user ID associated with the print job. 
• A Sample Set job does not use a passcode. 
• Any user can print or delete a Sample Set job. 
• A Sample Set prints one copy of a job to allow you to proofread the job before printing any 

remaining copies. 

After a Sample Set job is printed, it is deleted automatically. 

To print using Sample Set: 
1. In your software application, access the print settings. For most software applications, press CTRL+P 

for Windows or CMD+P for Macintosh. 
2. Select your printer, then open the print driver. 

− For Windows, click Printer Properties. Depending on your application, the title of the button 
varies. 

− For Macintosh, in the Print window, click Preview, then select Xerox Features. 
3. For Job Type, select Sample Set. 
4. Select any other required printing options. 

− For Windows, click OK, then click Print. 
− For Macintosh, click Print. 

To release a Sample Set: 
1. At the printer control panel, press the Home button. 
2. To view available jobs, touch Jobs. 
3. Touch the Sample Set job. 

Note: The Sample Set file description shows the job as Held for Future Printing, and shows the 
number of remaining copies of the job. 

4. Select an option. 
− To print the remaining copies of the job, touch Release. 
− To delete the remaining copies of the job, touch Delete. 

5. To return to the Home screen, press the Home button. 
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Managing Jobs using the Embedded Web Server 

You can view a list of active jobs and delete print jobs from the Active Jobs list in the Embedded Web 
Server. You can use the Embedded Web Server to submit jobs for printing at the device. You can print 
.pdf, .ps, .pcl, .prn, .xps, .jpg, .tif and .txt files directly from the Embedded Web Server without opening 
another application or the print driver. The files can be stored on a local computer hard drive, mass 
storage device, or network drive. 

To manage jobs using the Embedded Web Server: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, click Jobs. 
3. Click the job name. 
4. Do one of the following: 

− To pause the print job, click Pause. To resume the print job, click Resume. 
− To delete the print job, click Delete. At the prompt, click Delete. 

5. To return to the Home screen, click Home. 

To submit jobs for printing using the Embedded Web Server: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, click Home. 
3. In the Quick Links area, click Submit File. 
4. Click the Submit field. 
5. In the selection window, select a file to print, then click Open. 
6. To print the document, click Submit. 
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Copy 

This section includes: 
• Copy Overview ................................................................................................................................................................... 80 
• Making a Copy .................................................................................................................................................................. 80 
• Copy Workflows ................................................................................................................................................................ 83 
 
 

Copy Overview 
 

 

To make a copy, the device scans your original documents and temporarily stores the 
images. It then prints the images based on the options selected. 

 

If Authentication or Accounting has been enabled on your device, enter your login details to access Copy 
features. 

You can adjust various settings for individual Copy jobs and save settings as Presets for future jobs. The 
list of features can be customized, and some features could be hidden from view when the App is 
installed. To view all available features and to find out more about customizing the Copy App, refer to 
Customize and Personalize on page 53. 

For information about all the App features and available settings, refer to Apps Features on page 247. 
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Making a Copy 

To make a copy: 
1. At the printer control panel, press the Home button. 
2. To clear previous App settings, touch Reset. 
3. Load your original documents. 

− Use the document glass for single pages or paper that cannot be fed using the duplex 
automatic document feeder. Lift the automatic document feeder, then place the original 
document face down in the upper-left corner of the document glass. 

 
− For multiple, single, or 2-sided pages, use the duplex automatic document feeder. Remove any 

staples or paper clips from the pages. Insert the original documents face up in the automatic 
document feeder, with the top of the page entering the feeder first. Adjust the paper guides so 
that they fit against the document originals. 

 
4. Touch Copy, then enter the number of copies needed. 

Note: To amend the number of copies entered, touch the X button, then enter the required quantity. 

5. If scanning from 2-sided original documents, touch 2-Sided, then select an option. 
6. Adjust copy settings as needed. 

For details about available features, refer to Apps Features on page 247. 
7. Touch Start. If you placed documents in the feeder, scanning continues until the feeder is empty.
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8. If you are scanning from the document glass, when prompted, do one of the following: 

− To complete the job and return to the Copy app, touch Done. 
− To scan another page, load a new original document on the document glass, then touch Add 

Page. 
− To delete the scan and return to the Copy app, touch Cancel, then touch Delete. 

Note: If you are scanning a document from the automatic document feeder, a prompt 
does not appear. 

9. To return to the home screen, press the Home button. 
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Copy Workflows 

This section includes: 
• Changing the Page Layout ........................................................................................................................................... 83 
• Book Copying ..................................................................................................................................................................... 83 
• Shifting the Image .......................................................................................................................................................... 84 
• Creating a Booklet ........................................................................................................................................................... 85 
• Adding a Front Cover ...................................................................................................................................................... 86 
• Erasing the Edges of Copies ......................................................................................................................................... 86 
• Printing a Sample Copy ................................................................................................................................................. 87 
• Adding Annotations ........................................................................................................................................................ 88 

Note: Some features are hidden from view when the Copy App is installed. For more information refer to 
Customize and Personalize on page 53. 
 
 

Changing the Page Layout 

You can use Page Layout to place a defined number of pages on one or both sides of the paper. 

To change the page layout: 
1. At the printer control panel, press the Home button. 
2. Touch Copy. 
3. Touch Page Layout. 
4. Select the required number of pages per side. 
5. To change the Original Orientation, touch Page Layout, then touch More. Select Portrait or 

Landscape. 

Note: The Original Orientation option is only available when the selected number of pages per slide 
is 2, 4, or 8. 

6. To change the Image Order, touch Page Layout, then touch More. Select one of the following 
options. 
− Right then Down: This option prints the images across the page, row by row. 
− Down then Right: This option prints the images down the page, column by column. 

Note: The Image Order option is only available when the selected number of pages per slide  
is 4 or 8. 

7. Touch OK. 
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Book Copying 

You can use the Book Copying feature to copy books, magazines, or other bound documents. You can 
use this feature to copy images for different results. 
• Copy either the left or right page onto a single sheet of paper 
• Copy both the left and right pages onto two sheets of paper 
• Copy both the left and right pages as a single image onto one sheet of paper 

Note: To make copies from books, magazines, or other bound documents, use the document glass 
only. Do not place bound original documents in the document feeder. 

To set up book copying: 
1. At the printer control panel, press the Home button. 
2. Touch Copy. 
3. Touch Book Copying. 
4. Touch Mode, then select one of the following options: 

− Off: This option is the default setting. 
− Both Pages: This option scans both pages of an open book onto two sheets of paper. 
− Left/Right Page Only: This option scans the left or right page of an open book onto a single 

sheet of paper. 
5. If Binding Edge Erase is required, touch Binding Edge Erase, then move the slider to the right to 

erase up to 50 mm (1.97 in). 
6. Touch OK. 
 

Shifting the Image 

You can change the placement of an image on the copy page. This is useful if the image is smaller than 
the page size.For image shift to work correctly, position original documents as follows: 
• Document Feeder: Position original documents face up, short edge entering the feeder first. 
• Document Glass: Position original documents face down, in the upper-left corner of the document 

glass, short edge to the left. 

To change the placement of the image: 
1. At the printer control panel, press the Home button. 
2. Touch Copy. 
3. Touch Image Shift. 
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4. Select one of the following options. 
− Off: This option is the default setting. 
− Auto Center: This option centers the image on the page. 
− Snap to Edge: This option shifts the image to the edge of the document. Select one of the 

image-position options. 
• Mirror Side 1: This option allows you to set the Image Shift for Side 1, and matches the 

Side 2 Image Shift accordingly. To move the image to the required edge of the page, 
touch the appropriate arrow. 

• Independent Sides: This option allows you to position the images on Side 1 and Side 2 
independently of each other. To move each image to the required edge of the page, touch 
the appropriate arrow. 

− Manual: This option allows you to specify the amount of Image Shift required. Select one of 
the image-position options. 
• Mirror Side 1: This option allows you to set the Image Shift for Side 1, and matches the 

Side 2 Image Shift accordingly. Touch the appropriate fields. To adjust the image shift, 
move the slider. 

• Independent Sides: This option allows you to position the images on Side 1 and Side 2 
independently of each other. Touch the appropriate fields. To adjust the image shift, move 
the slider. 

5. To specify the orientation of the original document, touch Original Orientation, then select an 
option. 

6. Touch OK. 
 

Creating a Booklet 

The booklet feature reduces the original page images to fit two images on each side of the printed page. 
You can print copies in booklet format. 

Notes: 

• This function is available on printers with an optional Productivity Kit installed only. 
• In Booklet mode, the printer scans all of the original documents before it prints the copies. 

To create a booklet: 
1. At the printer control panel, press the Home button. 
2. Touch Copy. 
3. Touch Booklet Creation. 

Note: If Reduce/Enlarge has been adjusted, a message appears confirming that Reduce/Enlarge 
has changed to Auto%. If Paper Supply has been set to Auto Select, a message appears confirming 
that Paper Supply has changed to Tray 1. 

4. Touch the Booklet Creation toggle button. 
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5. Touch Original Document, then select the option that matches your original documents: 
− 1-Sided Original: This option scans only one side of the original image and produces 1-sided 

output files. 
− 2-Sided Original: This option scans both sides of the original image. 
− 2-Sided, Rotate Side 2: This option scans both sides of the original image, rotating the 

second side. 
6. If a cover sheet is required, touch the Cover toggle button, then adjust Paper Supply and Print On 

Cover as needed. 
7. Touch OK. 
 

Adding a Front Cover 

You can print the first page of your copy job on different paper, such as colored or heavyweight paper. 
The printer selects the special paper from a different tray. The cover can be blank or printed. 

Note: This function is available on printers with an optional Productivity Kit installed only. 

To add a front cover to your copy job: 
1. At the printer control panel, press the Home button. 
2. Touch Copy. 
3. Touch Front Cover. 
4. Touch the Front Cover toggle button. 

Note: If Paper Supply is set to Auto Select, a notification appears confirming that the Paper Supply 
has been changed to Tray 1. 

5. Touch Printing Options, then select an option. 
− Blank: This option inserts a blank front cover. 
− Print on Side 1 Only: This option prints on the front side of the cover only. 
− Print on Side 2 Only: This option prints on the back side of the cover only. 
− Print on Both Sides: This option prints on both sides of the cover. 

6. Touch Paper Supply, then select the required paper source. 
7. Touch OK. 
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Erasing the Edges of Copies 

You can erase content from the edges of your copies using the Edge Erase feature. You can specify the 
amount to erase on the right, left, top, and bottom edges. 

To erase the edges of copies: 
1. At the printer control panel, press the Home button. 
2. Touch Copy. 
3. Touch Edge Erase. 
4. Select one of the following options. 

− All Edges: This option erases all four edges by the same amount. To adjust the amount to 
erase, move the slider. 

− Print to Edge: This option prints to the edge of the paper. 
− Individual Edges: This option allows you to specify different amounts to erase from the edges. 

Select an erase option. 
• Mirror Edges: This option allows you to set the Edge Erase for Side 1, and matches the 

Side 2 Edge Erase accordingly. To adjust the edge erase, move the slider. 
• Independent Edges: This option allows you to set the Edge Erase on Side 1 and Side 2 

independently of each other. Touch the appropriate field. To adjust the Edge Erase, move 
the slider. 

5. To specify the orientation of the original document, touch Original Orientation, then select an 
option. 

6. Touch OK. 
 

Printing a Sample Copy 

Sample Copy allows you to print a test copy of a job to inspect before printing multiple copies. This 
feature is useful for complex or high-volume jobs. After you print and inspect the test copy, you can 
choose to print or cancel the remaining copies. 

To print a sample copy of your job: 
1. At the printer control panel, press the Home button. 
2. Touch Copy. 
3. Adjust the copy settings as needed. 
4. Enter the number of copies needed. 
5. Touch the Sample Copy toggle button. 
6. Touch the Start button. The sample copy prints. 
7. Inspect the sample copy, then select one of the following options. 

− If the copy is unsatisfactory, touch Delete. The job is canceled and no more copies are printed. 
− If the copy is satisfactory, touch Release. The remaining copies are printed. 

8. To return to the home screen, press the Home button. 
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Adding Annotations 

You can use the Annotations feature to add a page number, comment, date, or Bates Stamp to your 
copies. 

Notes: 

• This function is available on printers with an optional Productivity Kit installed only. 
• If Booklet Creation is selected, you cannot add Annotations. 

To add annotations: 
1. At the printer control panel, press the Home button. 
2. Touch Copy. 
3. Touch Annotations. 
4. To insert page numbers: 

a. Select the required page location, then touch Page Number. 
b. Enter the starting page number. 
c. To adjust which pages contain the selected annotation, touch Apply To, then select All Pages 

or All Pages Except First. 
d. Touch OK. 

5. To insert a comment: 
a. Select the required page location, then touch Comment. 
b. Select the required entry, then touch OK. 

Note: To create a comment, touch the edit icon for Not in Use. Enter the required text, then touch 
OK. 

c. To adjust which pages contain the selected annotation, touch Apply To, then select the 
required option. 

d. Touch OK. 
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6. To insert the current date: 
a. Select the required page location, then touch Date Stamp. 
b. Touch Format, then select the required date format. 
c. To adjust which pages contain the selected annotation, touch Apply To, then select the 

required option. 
d. Touch OK. 

7. To insert a Bates Stamp: 
a. Select the required page location, then touch Bates Stamp. 
b. Touch Prefix, then select the required entry. Touch OK. 

Note: To create a prefix, touch the edit icon for Not in Use. Enter the required text, then touch OK. 

c. Touch Starting Number. Enter the required starting number, then touch OK. 
d. Touch Number of Digits, then select the required option. 
e. To adjust which pages contain the selected annotation, touch Apply To, then select the 

required option. 
f. Touch OK. 

8. To change the text formatting, touch Format & Style. Adjust the settings as required, then touch 
OK. 

9. Touch OK. 
10. If necessary, to remove all entered annotations, touch Delete All. 

Note: Not all annotations are available in all page locations. 
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ID Card Copy 

This section includes: 
• ID Card Copy Overview .................................................................................................................................................. 90 
• Copying an ID Card ......................................................................................................................................................... 90 
 
 

ID Card Copy Overview 
 

 

You can use the ID Card Copy App to copy both sides of an ID card or small 
document onto one side of paper. To copy the card properly, place each side in the 
upper-left corner of the document glass. The printer stores both sides of the 
document, then prints them side by side on the paper. 

 

The ID Card Copy App is hidden from view on initial device setup. The list of features can be customized, 
and some features can be hidden from view. For more information about adding and customizing Apps, 
refer to Customize and Personalize on page 53. 

For information about all the App features and available settings, refer to Apps Features on page 247. 
 

Copying an ID Card 

To copy an ID card: 
1. At the printer control panel, press the Home button. 
2. To clear previous App settings, touch Reset. 
3. Lift the automatic document feeder, then place the original document in the upper-left corner of 

the document glass. 
4. Touch ID Card Copy. 
5. Adjust the settings as required. 
6. Touch Scan. 
7. When scanning is finished, lift the automatic document feeder. Flip the original document, then 

place it in the upper-left corner of the document glass. 
8. To scan the second side of the original document and print the copies, touch Scan. 
9. To return to the home screen, press the Home button. 
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Email 

This section includes: 
• Email Overview .................................................................................................................................................................. 91 
• Sending a Scanned Image in an Email .................................................................................................................... 91 
 
 

Email Overview 
 

 

You can use the Email app to scan images and attach them to emails. You can 
specify the file name and format of the attachment, and include a subject heading 
and message for the email. 

 

You can adjust various settings for individual Email jobs and save settings as Presets for future jobs. The 
list of features can be customized, and some features could be hidden from view when the App is 
installed. To view all available features and to find out more about customizing the Email App, refer to 
Customize and Personalize on page 53. 

For information about all the App features and available settings, refer to Apps Features on page 247. 
 

Sending a Scanned Image in an Email 

To send a scanned image in an email: 
1. At the printer control panel, press the Home button. 
2. To clear previous App settings, touch Reset. 
3. Load your original documents. 

− For single pages or paper that cannot be fed using the duplex automatic document feeder, use 
the document glass. Lift the automatic document feeder, then place the original documents 
face down in the upper-left corner of the document glass. 
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− For multiple, single, or 2-sided pages, use the duplex automatic document feeder. Remove any 
staples or paper clips from the pages. Insert the original documents face up in the automatic 
document feeder, with the top of the page entering the feeder first. Adjust the paper guides so 
that they fit against the document originals. 

 
4. Touch Email. 
5. Enter recipients: 

− To enter the email address manually into the To field, type the address using the touch screen 
keypad. Touch Enter. 

− To select a contact or group from the Address Book, touch the Address Book icon. Touch 
Favorites or Contacts, then select a recipient. 

6. If scanning from 2-sided original documents, touch 2-Sided Scanning, then select an option. 
7. Adjust the email settings as needed: 

− To save the scanned document with a specific file name, touch the attachment file name, enter 
a new name using the touch screen keypad, then touch Enter. 

− To save the scanned document with a specific file format, touch the attachment file format, 
then select the required format. 
To create a searchable file or to add password protection, select More from the file format. 

− To change the subject line, touch Subject, enter a new subject line using the touch screen 
keypad, then touch Enter. 

− To change the email body message, touch Message, enter a new message, then touch OK. 
For details about available features, refer to Apps Features on page 247. 

8. To start the scan, touch Send. 
9. If you are scanning from the document glass, when prompted, to finish, touch Done, or to scan 

another page, touch Add Page. You can also touch Cancel Job. 

Note: If you are scanning a document from the automatic document feeder, a prompt does not 
appear. 

10. To return to the Home screen, press the Home button. 
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Scan To 

This section includes: 
• Scan To Overview ............................................................................................................................................................. 93 
• Scanning to an Email Address ..................................................................................................................................... 93 
• Scanning to a USB Flash Drive .................................................................................................................................... 94 
• Scanning to a User Home Folder ............................................................................................................................... 95 
• Scan to Desktop ................................................................................................................................................................ 96 
• Scanning to a Shared Folder on a Network Computer ...................................................................................... 97 
• Scanning Images into an Application on a Connected Computer ................................................................ 99 
 
 

Scan To Overview 
 

 

The Scan To feature provides several methods for scanning and storing an original 
document. The scanning procedure using your printer differs from that of desktop 
scanners. The printer is connected typically to a network rather than a single 
computer, so you select a destination for the scanned image at the printer. 

 

The printer supports the following scanning functions: 
• Scan original documents to an email address. 
• Scan original documents to a USB Flash drive. 
• Scan original documents to your home folder. 
• Scan original documents to a shared network location using SMB and FTP transfer protocols. 

You can adjust various settings for individual Scan To jobs and save settings as Presets for future jobs. 
The list of features can be customized, and some features could be hidden from view when the App is 
installed. To view all available features and to find out more about customizing the Scan To App, refer to 
Customize and Personalize on page 53. 

For information about all the App features and available settings, refer to Apps Features on page 247. 
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Scanning to an Email Address 

Before you scan to an email address, ensure that you configure the printer with the email server 
information. For details, refer to the System Administrator Guide at www.xerox.com/office/VLB405docs. 

To scan an image and send it to an email address: 
1. Load the original document on the document glass or into the duplex automatic document feeder. 
2. At the control panel, touch the Home button. 
3. Touch Scan To. 
4. Enter recipients: 

− To enter the email address manually, touch Email, then enter an email address. Touch Enter. 
− To select a contact or group from the Address Book, touch Contacts. 

5. To save the scanned document as a specific file name, touch the attachment file name, then enter 
a new name using the touch screen keypad. Touch Enter. 

6. To save the scanned document as a specific file format, touch the attachment file format, then 
select the required format. 

Note: To make scanned documents searchable, your system administrator can enable the 
Searchable feature. 

7. Adjust scanning options as needed. 
8. To change the subject line, from Email Features, touch Subject, then enter a new subject line using 

the touch screen keypad. Touch Enter. 
9. To change the email body message, from Email Features, touch Message, then enter a new 

message. Touch OK. 
10. To begin the scan, touch Scan. 
11. If you are scanning from the document glass, when prompted, to finish, touch Done, or to scan 

another page, touch Add Page. 

Note: If you are scanning a document from the automatic document feeder, a prompt does not 
appear. 

12. To return to the Home screen, press the Home button. 
 

Scanning to a USB Flash Drive 

You can scan a document and store the scanned file on a USB Flash drive. The Scan to USB function 
produces scans in .jpg, .pdf, .pdf (a), .xps, and .tif file formats. 

Notes: 

• If the device is in Power Saver mode, before proceeding with the USB scan, to wake the device, 
press the Power/Wake button. 

• Only USB Flash drives formatted to the typical FAT32 file system are supported. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLB405&PgName=Man&Language=English
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To scan to a USB Flash drive: 
1. Load the original document on the document glass or in the duplex automatic document feeder. 
2. At the printer control panel, press the Home button. 
3. Insert your USB Flash drive into the USB memory port on the front of the printer. 
4. At the USB Drive has been detected screen, touch Scan to USB. 

Note: If this feature does not appear, enable the feature or contact the system administrator. 

5. To save the scanned file to a specific folder on the USB Flash drive, navigate to the directory where 
you want to save your file, then touch OK. 

6. To save the scanned document as a specific file name, touch the attachment file name, then enter 
a new name using the touch screen keypad. Touch Enter. 

7. To save the scanned document as a specific file format, touch the attachment file format, then 
select the required format. 

8. Adjust scanning features as needed. 
9. To begin the scan, press Scan. 

The printer scans your images to the folder that you specified. 
10. If you are scanning from the document glass, when prompted, to finish, touch Done or to scan 

another page, touch Add Page. 

Note: If you are scanning a document from the automatic document feeder, a prompt does not 
appear. 

 

 WARNING: Do not remove the USB Flash drive while the device is scanning and processing 
the job. If you remove the Flash drive before the transfer is complete, the file can become 
unusable and other files on the drive can be damaged. 

 

11. To return to the Home screen, press the Home button. 
 

Scanning to a User Home Folder 

Scan to Home allows you to scan documents that are saved to a home directory on an external 
server. The home directory is distinct for each authenticated user. The directory path is established 
through LDAP. 
 

Before You Begin 

To scan to the home folder defined in an LDAP directory, first ensure that the home folder locations are 
defined for each user. 

If you want to scan to a shared folder on the network, create a shared folder on your network with read 
and write access privileges. 
 



Xerox® Apps 

 

96 Xerox® VersaLink® B405 Multifunction Printer 
 User Guide 
 

Scanning to a Home Folder 
Note: If LDAP Network Authentication is configured, the Home button appears as an option that 
you can select on the Scan To screen. 

1. Load the original document on the document glass or into the duplex automatic document feeder. 
2. At the printer control panel, press the Home button. 
3. To log in to the printer, touch Log In. 
4. Enter your user name, then touch Next. 
5. Enter your password, then touch OK. 
6. To scan to a home folder, select an option: 

− Touch Scan To. On the Scan To screen, touch Home. 
− Touch My Folder. 

7. To save the scanned document as a specific file name, touch the attachment file name, enter a new 
name using the touch screen keypad, then touch Enter. 

8. To save the scanned document as a specific file format, touch the attachment file format, then 
select the desired format. 

9. Adjust scanning options as needed. 
10. To begin the scan, press Scan. 

If you are scanning from the document glass, when prompted, to finish, touch Done, or to scan 
another page, touch Add Page. 

Note: If you are scanning a document from the automatic document feeder, a prompt does not 
appear. 

11. To return to the Home screen, press the Home button. 
 

Scan to Desktop 

Before you begin: 
• Before scanning, ensure that your computer and the printer are plugged in, powered on, and 

connected to an active network. 
• On your computer, ensure that you have the correct print driver software installed. For details, refer 

to Installing the Software on page 46. 
• On your computer, ensure that the printer is installed using WSD. For details, refer to Installing the 

Software on page 46. 
• On your printer, ensure that WSD is enabled. For details, refer the System Administrator Guide at 

www.xerox.com/office/VLB405docs. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLB405&PgName=Man&Language=English
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To Scan to Desktop: 
1. Load the original document on the document glass or into the duplex automatic document feeder. 
2. At the printer control panel, press the Home button. 
3. Touch Scan to Desktop. 
4. To select a destination, touch the computer address. 
5. To begin the scan, press Scan. 

The Windows Fax and Scan application opens on your PC desktop. The image file of your scan is 
saved to the Scanned Documents folder. 

6. If you are scanning from the document glass, when prompted, to finish, touch Done, or to scan 
another page, touch Add Page. 

Note: If you are scanning a document from the automatic document feeder, a prompt does not 
appear. 

7. To return to the Home screen, press the Home button. 
 

Scanning to a Shared Folder on a Network Computer 

Before you can use the printer as a scanner on a network: 
• Create a shared folder on your computer hard drive. 
• Access the Embedded Web Server, then create an address that points the scanner to the computer. 
 

Sharing a Folder on a Windows Computer 
1. Open Windows Explorer. 
2. Right-click the folder you want to share, then select Properties. 
3. Click the Sharing tab, then click Advanced Sharing. 
4. Select Share this folder. 
5. Click Permissions. 
6. Select the Everyone group, and verify that all permissions are enabled. 
7. Click OK. 

Note: Remember the Share name for later use. 

8. Click OK again. 
9. Click Close. 
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Sharing a Folder in Macintosh OS X Version 10.7 and Later 
1. From the Apple menu, select System Preferences. 
2. From the Internet & Wireless menu, select Sharing. 
3. From the Service menu, select File Sharing. 
4. Under Shared Folders, click the plus icon (+). 
5. Browse to the folder that you want to share on the network, then click Add. 
6. To modify access rights for your folder, select the folder. The groups activate. 
7. From the Users list, click Everyone, then use the arrows to select Read & Write. 
8. Click Options. 
9. To share the folder, select Share files and folders using SMB. 
10. To share the folder with specific users, next to the user name, select On. 
11. Click Done. 
12. Close the System Preferences window. 

Note: When you open a shared folder, a Shared Folder banner appears in the Finder for the folder 
and subfolders. 

 

Adding an SMB Folder as an Address Book Entry from the Embedded Web Server 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 34. 

2. Click Address Book, then click Add Contact. 
3. For Network (SMB), click the plus icon (+), then enter the following information: 

− Nickname: Enter the name that you want to appear in the Address Book. 
− Type: Select the network connection type. 
− IP Address: Port: Enter the IP address of your computer, then enter the default port number. 
− Share: Enter a name for the directory or folder. For example, to save scanned files to a shared 

folder named scans, type scans. 
− Document Path: Enter the path of the folder on the SMB server. For example, to save the 

scanned files to a folder named colorscans inside the scans folder, type colorscans. 
− Login Name: Enter your computer user name. 
− Password: Enter your computer login password. 
− Retype Password: Enter your login password again. 

4. To save your network information, click OK. 
5. To save your contact, click OK. 
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Adding a Folder as an Address Book Entry Using the Control Panel 
1. At the printer control panel, touch the Home button. 
2. Touch Address Book. 
3. Touch the plus icon (+), then select Add Contact. 
4. Enter the name to appear in the address book. 
5. Touch Add (SMB), then navigate to the desired folder. 

Note: Login credentials are required for computers on secured networks. 

6. To save changes, touch OK. 
 

Scanning to a Shared Folder on a Networked Computer 
1. Load the original document on the document glass or into the duplex automatic document feeder. 
2. At the printer control panel, press the Home button. 
3. Touch Scan To. 
4. Touch Contacts. 
5. From the Contacts list, select the shared folder. 
6. To save the scanned document as a specific file name, touch the attachment file name, enter a new 

name using the touch screen keypad, then touch Enter. 
7. To save the scanned document as a specific file format, touch the attachment file format, then 

select the desired format. 
8. Adjust scanning options as needed. 
9. To begin the scan, press Scan. 
10. If you are scanning from the document glass, when prompted, to finish, touch Done, or to scan 

another page, touch Add Page. 

Note: If you are scanning a document from the automatic document feeder, a prompt 
does not appear. 

11. To return to the Home screen, press the Home button. 
 

Scanning Images into an Application on a Connected Computer 

You can import images directly from the scanner into a folder on your computer. With a Macintosh® 
computer and some Windows® applications, you can import the images directly into an application. 
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Scanning an Image into an Application 
Note: Some Windows applications, including Microsoft Office 2007 and newer, do not support this 
feature. 

1. Load the original document on the document glass or in the duplex automatic document feeder. 
2. At your computer, open the application into which you want to scan the image. 
3. In the application, select the menu item to acquire the image. 
4. From the Paper Source menu in Windows, or from the Scan From menu on a Macintosh® computer, 

select one of the following: 
− For the Document Glass, select Flatbed. 
− For the Duplex Automatic Document Feeder, select Document Feeder. 

5. Specify other scan driver settings as needed. 
6. To begin the scan, click Scan. 

The printer scans the document and places the image in your application. 
 

Scanning from Windows Control Panel 
1. Load the original document on the document glass or in the duplex automatic document feeder. 
2. On your computer, select Start > Devices and Printers. 
3. From the Devices and Printers window, right-click the printer icon, then select Start Scan. 
4. Select the paper source for your original document from the menu. 
5. Adjust scanning options as needed. 
6. To preview the document or select a portion of the document to scan, select Preview. 

The printer scans a preview copy of the image. 
7. To select part of the document, use the corner points to resize the frame. 
8. Click Scan. 
9. To import the scan, in the Import Pictures and Video window, click Import. 

The scanned image is stored in the default My Pictures folder. 
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Fax 

This section includes: 
• Fax Overview .................................................................................................................................................................... 101 
• Sending a Fax .................................................................................................................................................................. 101 
• Fax Workflows ................................................................................................................................................................. 104 
 
 

Fax Overview 
 

 

When you send a fax from the printer control panel, the document is scanned and 
transmitted to a fax machine, using a dedicated telephone line. You can use the 
Fax feature to fax documents to a fax number, or individual contact, or to a group 
of contacts. 

 

You can also use the Fax feature to do the following: 
• Delay the send of your fax job for up to 24 hours. 
• Send a fax from your computer. 
• Forward fax documents to an email address. 
• Print a fax from a secure folder. 

The fax function works best with an analog phone line. Voice-Over-Internet Protocols (VOIPs) such as 
FIOS and DSL are not supported. Before you use the fax, configure the Fax Settings to ensure they are 
compatible with your local connection and regulations. The Fax Settings include optional features you 
can use to configure the printer for faxing. 

Note: Not all options listed are supported on all printers. Some options apply only to a specific 
printer model, configuration, operating system, or print driver type. 

For details, refer to the System Administrator Guide at www.xerox.com/office/VLB405docs. 

You can adjust various settings for individual Fax jobs and save settings as Presets for future jobs. The 
list of features can be customized, and some features could be hidden from view when the App is 
installed. To view all available features and to find out more about customizing the Fax App, refer to 
Customize and Personalize on page 53. 

For information about all the App features and available settings, refer to Apps Features on page 247. 
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Sending a Fax 

To send a fax: 
1. At the printer control panel, press the Home button. 
2. To clear previous App settings, touch Reset. 
3. Load your original documents. 

− Use the document glass for single pages or paper that cannot be fed using the single-pass 
duplex automatic document feeder. Lift the automatic document feeder, then place the 
original document face down in the upper-left corner of the document glass. 

 
− For single, multiple, or 2-sided pages, use the duplex automatic document feeder. Remove any 

staples or paper clips from the pages. Insert the original documents face up in the automatic 
document feeder, with the top of the page entering the feeder first. Adjust the paper guides so 
that they fit against the document originals. 

 
4. Touch Fax. 
5. Enter a recipient fax number using the touch screen keypad, then touch Enter. To add a number 

from the fax address book, touch the Address Book icon. 

Note: To insert a pause as needed, touch the Special Characters icon, then touch Dial Pause. To 
enter longer pauses, touch Dial Pause multiple times. 

6. If scanning from 2-sided original documents, touch 2-Sided Scanning, then select an option. 
7. Adjust fax settings as needed. 

For details about available features, refer to Apps Features on page 247. 
8. Touch Send.
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9. If you are scanning from the document glass, when prompted, do one of the following: 

− To complete the job and return to the Fax app, touch Done. 
− To scan another page, load a new original document on the document glass, then touch 

Add Page. 
− To delete the scan and return to the Fax app, touch Cancel, then touch Delete. 

Note: If you are scanning a document from the automatic document feeder, a prompt does not 
appear. 

10. To return to the Home screen, press the Home button. 
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Fax Workflows 

This section includes: 
• Sending a Delayed Fax ................................................................................................................................................ 104 
• Sending a Cover Sheet with a Fax ........................................................................................................................... 105 
• Forwarding a Fax to an Email Address .................................................................................................................. 105 
• Printing a Secure Fax .................................................................................................................................................... 106 
• Sending a Fax Manually .............................................................................................................................................. 106 
• Polling a Remote Fax Machine ................................................................................................................................. 107 
• Sending a Fax From Your Computer ....................................................................................................................... 108 
 
 

Sending a Delayed Fax 

You can set a time in the future for the printer to send your fax job. You can delay the send of your fax 
job for up to 24 hours. 

Note: Before you use this feature, ensure that the printer is set to the current time. For details, refer to 
the System Administrator Guide at www.xerox.com/office/VLB405docs. 

To specify the time to send your fax: 
1. At the printer control panel, press the Home button. 
2. Touch Fax. 
3. To add a recipient fax number, use the touch screen keypad, or, to add a contact from the Address 

Book, touch the Address Book icon. 
4. Load original documents into the printer, then adjust the settings as needed. For details, refer to 

Sending a Fax on page 101. 
5. Touch Delay Send. 
6. Touch Specific Time, enter the required time, then touch OK. 
7. Touch Send. The fax is scanned and saved, then sent at the time that you specified. 
8. If you are scanning from the document glass, when prompted, do one of the following: 

− To complete the job and return to the Fax app, touch Done. 
− To scan another page, load a new original document on the document glass, then touch Add 

Page. 
− To delete the scan and return to the Fax app, touch Cancel, then touch Delete. 

Note: If you are scanning a document from the automatic document feeder, a prompt does not 
appear. 

9. To return to the Home screen, press the Home button. 
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Sending a Cover Sheet with a Fax 

You can send a cover sheet with your fax. The cover sheet lists recipient information from the fax 
address book, and sender information from the Company Name Fax Line setting. 

To send a cover sheet with a fax: 
1. At the printer control panel, press the Home button, then touch Fax. 
2. Add fax recipient names and adjust fax settings, as needed. For details, refer to Sending a Fax on 

page 101. 
3. Touch Cover Sheet. 
4. Touch Add Cover Sheet. 
5. To add predefined comments in the From or To fields, touch Blank Comment, then select from the 

list of predefined comments. 

Note: If no predefined comments have been added, the list is unavailable. To populate the list with 
predefined comments, refer to Adding Predefined Comments on page 105. 

6. Touch OK. 
 

Adding Predefined Comments 

To add a predefined comment: 
1. At the printer control panel, press the Home button. 
2. Touch Device > Apps > Fax. 
3. Touch Cover Sheet Comments. 
4. Select a Not in Use comment. 
5. Enter the required text, then touch OK. 
6. To return to the Home screen, press the Home button. 
 

Forwarding a Fax to an Email Address 

You can configure the device to forward faxes to an email address. You can specify the types of faxes to 
forward, for example, received faxes, sent faxes, or sent and received faxes. 

Note: Before you can forward a fax to an email address, ensure that Fax Forwarding feature is 
enabled. For details, refer to the System Administrator Guide at www.xerox.com/office/VLB405docs. 
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To forward a fax to an email address: 
1. At the printer control panel, press the Home button. 
2. Touch Device > Apps > Fax. 
3. Touch Fax Forwarding > Fax Forwarding. 
4. Select Receive Only, Send Only, or Send & Receive. 
5. Touch Add Email. To enter an email address, use the touch screen keypad, or select a contact from 

the Address Book. 
6. To add a subject line, touch Subject, enter your subject line text, then touch OK. 
7. To add a filename for attachments, touch Attachment, then enter a filename. 
8. To change the file format for attachments, touch the current format extension, then select a new 

format. 

Note: The default file format is .pdf. 

9. To save the settings, touch OK. 
10. For the new settings to take effect, press the Home button, then at the prompt, touch Restart Now. 
 

Printing a Secure Fax 
When the Fax Secure Receive option is enabled, all faxes that the device receives are held in the Job 
list until you enter a passcode. After you enter the passcode, the faxes are released and printed. 

Note: Before you can receive a Secure Fax, ensure that the Secure Fax Receive feature is enabled. 
For details, refer to the System Administrator Guide at www.xerox.com/office/VLB405docs . 

To print a secure fax: 
1. At the printer control panel, press the Home button, then touch Jobs. 
2. Touch Personal & Secure Jobs. 
3. Touch your assigned private folder. 
4. Enter your passcode, then touch OK. 
5. Select a job to print, or touch Print All. 
6. To return to the Home screen, press the Home button. 
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Sending a Fax Manually 

You can use the Manual Send feature to enable the fax modem speaker temporarily. This feature is 
helpful to dial international numbers, or to use phone systems that require you to wait for a specific 
audio tone. 

To send a fax manually: 
1. At the printer control panel, press the Home button, then touch Fax. 
2. Touch Manual Send. 

Note: To display the menu without entering a fax number, at the top of the screen, touch Fax. 

3. Adjust the fax settings as needed. 
4. Touch Dial, then enter a fax number using the touch screen keypad. 
5. To send the fax, touch Scan. 
6. If you are scanning from the document glass, when prompted, do one of the following: 

− To complete the job and return to the Fax app, touch Done. 
− To scan another page, load a new original document on the document glass, then touch Add 

Page. 
− To delete the scan and return to the Fax app, touch Cancel, then touch Delete. 

Note: If you are scanning a document from the automatic document feeder, a prompt does not 
appear. 

7. To return to the Home screen, press the Home button. 
 

Polling a Remote Fax Machine 

Fax Polling allows the printer to retrieve a fax stored on another fax machine that supports fax polling. 

Note: This feature is hidden from view when the Fax App is installed, for more information refer to 
Customize and Personalize on page 53. 

To poll a remote fax machine: 
1. At the printer control panel, press the Home button, then touch Fax. 
2. Touch Polling. 

Note: To display the menu without entering a fax number, at the top of the screen, touch Fax. 

3. Enter the fax number of the fax machine that you want to poll. 
− To enter a fax number manually, touch Enter Fax Number. 
− To add a number from the fax address book, touch the Address Book icon. 

4. To initiate the polling process, touch Retrieve. 
5. To return to the Home screen, press the Home button. 
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Sending a Fax From Your Computer 

This section includes: 
• Sending a Fax From Windows Applications ......................................................................................................... 108 
• Sending a Fax From Macintosh Applications ...................................................................................................... 108 

You can send a fax to the printer from an application on your computer. 
 
 

Sending a Fax From Windows Applications 

You can use the print driver to send a fax from Windows applications. 

You can use the fax window to enter recipients, create a cover page with notes, and set options. You can 
send a confirmation sheet, set the send speed, resolution, send time, and dialing options. 

To send a fax from Windows applications: 
1. With the desired document or image open in your application, open the Print dialog box. For most 

software applications, click File > Print or press CTRL+P. 
2. Select the required printer, then to open the print driver dialog box, click Printer Properties. 
3. On the Printing Options tab, from the Job Type list, select Fax. 
4. In the Fax window, click the Recipients tab. 
5. To add recipients manually: 

a. Click the Add Recipient icon. 
b. Type the recipient name and fax number, then add other information as required. 
c. Click OK. 
d. To add more recipients, repeat this procedure. 

6. To add existing contacts from a phonebook: 
a. Click the Add From Phonebook icon. 
b. Select the required phonebook from the list. 
c. Select names from the list, or search for a contact using the search bar. 
d. To add the selected contacts to the Fax Recipients list, click the Down Arrow. 
e. Click OK. 
f. To add more recipients, repeat this procedure. 

7. To include a cover sheet, click the Cover Sheet tab. From the Cover Sheet Options list, select Print a 
Cover Sheet. Enter the details as needed, then click OK. 

8. On the Options tab, select the required options, then click OK. 
9. To save your settings and return to the main print dialogue page, click OK. 
10. Click Print. In the Fax Confirmation window, click OK. 
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Sending a Fax From Macintosh Applications 

You can use the fax driver to send a fax from many Macintosh applications. To install the fax driver, refer 
to Installing the Software on page 46. 

To send a fax from Macintosh applications: 
1. With the desired document or image open in your application, open the Print dialog box. For most 

software applications, click File > Print or press CMD+P. 
2. Select the required printer. 
3. To access the fax driver settings, click Preview, select Xerox Features, then from Job Type list, select 

Fax. 
4. To add a recipient, in the Fax window, click the Recipients tab, then click the Add Recipient icon. 
5. Type the recipient name and fax number, add other information as needed, then click OK. 
6. To add more recipients, repeat this procedure. 
7. To include a cover sheet, click the Cover Sheet tab. 
8. From the Cover Sheet list, select Print a Cover Sheet, then enter the details as needed. 
9. On the Options tab, select the required options. To save your settings and return to the main print 

dialog window, click OK. 
10. To send the fax, click Print. 
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USB 

This section includes: 
• USB Overview .................................................................................................................................................................. 110 
• Scanning to a USB Flash Drive .................................................................................................................................. 110 
• Printing From a USB Flash Drive .............................................................................................................................. 111 
 
 

USB Overview 
 

 

Use the USB feature to save jobs to a USB Flash drive, or to print jobs already stored 
on a USB Flash drive. Jobs in a print-ready format, for example PDF, TIFF or JPEG can 
be printed. 

 

To create a print-ready file, select the Print to File option when you print your documents from programs 
such as Microsoft® Word. Many advanced publishing programs can provide additional methods to create 
print-ready files. 
 

Scanning to a USB Flash Drive 

You can scan a document and store the scanned file on a USB Flash drive. The Scan to USB function 
produces scans in .jpg, .pdf, .pdf (a), .xps, and .tif file formats. 

Notes: 

• If the device is in Power Saver mode, before proceeding with the USB scan, to wake the device, 
press the Power/Wake button. 

• Only USB Flash drives formatted to the typical FAT32 file system are supported. 
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To scan to a USB Flash drive: 
1. Load the original document on the document glass or in the duplex automatic document feeder. 
2. At the printer control panel, press the Home button. 
3. Insert your USB Flash drive into the USB memory port on the front of the printer. 
4. At the USB Drive has been detected screen, touch Scan to USB. 

Note: If this feature does not appear, enable the feature or contact the system administrator. 

5. To save the scanned file to a specific folder on the USB Flash drive, navigate to the directory where 
you want to save your file, then touch OK. 

6. To save the scanned document as a specific file name, touch the attachment file name, then enter 
a new name using the touch screen keypad. Touch Enter. 

7. To save the scanned document as a specific file format, touch the attachment file format, then 
select the required format. 

8. Adjust scanning features as needed. 
9. To begin the scan, press Scan. 

The printer scans your images to the folder that you specified. 
10. If you are scanning from the document glass, when prompted, to finish, touch Done or to scan 

another page, touch Add Page. 

Note: If you are scanning a document from the automatic document feeder, a prompt 
does not appear. 

 

 WARNING: Do not remove the USB Flash drive while the device is scanning and processing the 
job. If you remove the Flash drive before the transfer is complete, the file can become unusable 
and other files on the drive can be damaged. 

 

11. To return to the Home screen, press the Home button. 
 

Printing From a USB Flash Drive 
You can print a file stored on a USB Flash drive. The USB port is on the front of the printer. 

Notes: 

• If the device is in Power Saver mode, before proceeding with the Print job, to wake the device, 
press the Power Saver button. 

• Only USB Flash drives formatted to the typical FAT32 file system are supported. 

To print from a USB Flash drive: 
1. Insert the USB Flash drive into the USB memory port on the printer. 
2. At the USB Drive has been detected screen, touch Print from USB. 

Note: If this feature does not appear, enable the feature or contact the system administrator. For 
details, refer to the System Administrator Guide at www.xerox.com/office/VLB405docs.
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3. Add files to the Document Source Table. 
− To print a group of print-ready files, for the USB drive or folder, touch the Select All icon. Verify 

that your files are selected. 
− To print a specific file, browse to that file, then touch the file name or icon. 

4. Touch OK. 
5. Confirm that the required files are listed. 

− To select more files, touch Add Document, then touch OK. 
− To remove a file name from the list, touch the file name, then touch Remove. 

6. Select the paper supply, quantity, and 2-sided printing options. 
7. Touch Print. 
8. When you are finished, remove the USB Flash drive. 

To print from a USB Flash drive that is already inserted in the printer: 
1. If the USB Flash drive is already in the USB memory port, press the Home button. 
2. Touch USB. 
3. Touch Print from USB. 

Note: If this feature does not appear, enable the feature or contact the system administrator.  
For details, refer to the System Administrator Guide at www.xerox.com/office/VLB405docs. 

4. Add files to the Document Source Table. 
− To print a group of print-ready files, for the USB drive or folder, touch the Select All icon. Verify 

that your files are selected. 
− To print a specific file, browse to that file, then touch the file name or icon. 

5. Touch OK. 
6. Confirm that the required files are listed. 

− To select more files, touch Add Document, then touch OK. 
− To remove a file name from the list, touch the file name, then touch Remove. 

7. Select the paper supply, quantity, and 2-sided printing options. 
8. Touch Print. 
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Printing Overview 

Before printing, your computer and the printer must be plugged in, turned on, and connected. Ensure 
that you have the correct print driver software installed on your computer. For details, refer to Installing 
the Software on page 46. 
1. Select the appropriate paper. 
2. Load paper in the appropriate tray. On the printer control panel, specify the size, color, and type. 
3. Access the print settings in your software application. For most software applications, press CTRL+P 

for Windows, or CMD+P for Macintosh. 
4. Select your printer. 
5. Access the print driver settings by selecting Properties or Preferences for Windows, or Xerox® 

Features for Macintosh. The title of the button can vary depending on your application. 
6. Modify the print driver settings as necessary, then click OK. 
7. Click Print to send the job to the printer. 
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Selecting Printing Options 

This section includes: 
• Print Driver Help.............................................................................................................................................................. 115 
• Windows Printing Options .......................................................................................................................................... 116 
• Macintosh Printing Options ....................................................................................................................................... 117 
• UNIX and Linux Printing .............................................................................................................................................. 118 
• Mobile Printing Options ............................................................................................................................................... 121 

Printing options, also called print driver software options, are specified as Printing Preferences in 
Windows, and Xerox® Features in Macintosh. Printing options include settings for 2-sided printing, page 
layout, and print quality. Printing options that are set from Printing Preferences become the default 
setting. Printing options that are set from within the software application are temporary. The application 
and the computer do not save the settings after the application is closed. 
 
 

Print Driver Help 

Xerox® print driver software Help information is available from the Printing Preferences window. Click the 
Help (?) button in the bottom left corner of the Printing Preferences window to see the Help. 

 

Information about Printing Preferences appears in the Help window. From there, you can select by topic 
or use the search field to enter the topic or function for which you need information. 
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Windows Printing Options 

Selecting Printing Options for an Individual Job for Windows 

To use special printing options for a particular job, you can change the Printing Preferences before 
sending the job to the printer. 
1. With the document open in your software application, access the print settings. For most software 

applications, click File > Print or press CTRL+P for Windows. 
2. Select your printer and click the Properties or Preferences button to open the Printing Preferences 

window. The title of the button can vary depending on your application. 
3. Click a tab in the Printing Preferences window, then make selections. 
4. Click OK to save and close the Printing Preferences window. 
5. Click Print to send the job to the printer. 
 
 

Setting Default Printing Options for Windows 

When you print from any software application, the printer uses the print job settings specified in the 
Printing Preferences window. You can specify your most common printing options and save them so that 
you do not have to change them every time you print. 

For example, if you want to print on both sides of the paper for most jobs, specify 2-sided printing in 
Printing Preferences. 
1. Navigate to the list of printers on your computer: 

− For Windows Server 2008 and later, click Start > Settings > Printers. 
− For Windows 7, click Start > Devices and Printers. 
− For Windows 8, click Start > Control Panel > Devices and Printers. 
− For Windows 10, click the Windows Start icon > Settings > Devices > Printers & Scanners. 

Scroll down in the window, then under Related settings, click Devices and printers. 

Note: If you are using a custom Start Menu application, it can change the navigation path to your 
list of printers. 

2. In the list of printers, right-click the icon for your printer, then click Printing preferences. 
3. In the Printing Preferences window, click a tab, then select the options. To save the settings, 

click OK. 

Note: For more information about Windows print driver options, click the Help button (?) in the 
Printing Preferences window. 
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Selecting Printing Defaults in Windows for a Shared Network Printer 
1. Navigate to the list of printers on your computer: 

− For Windows Server 2008 and later, click Start > Settings > Printers. 
− For Windows 7, click Start > Devices and Printers. 
− For Windows 8, click Start > Control Panel > Devices and Printers. 
− For Windows 10, click the Windows Start icon > Settings > Devices > Printers & Scanners. 

Scroll down in the window, then under Related settings, click Devices and printers. 

Note: If the Control Panel icon does not appear on the desktop, right-click the desktop, then select 
Personalize > Control Panel Home > Devices and Printers. 

2. In the list of printers, right-click the icon for your printer, then select Printer properties. 
3. In the printer Properties dialog box, click the Advanced tab. 
4. On the Advanced tab, click Printing Defaults. 
5. Make your selections on the print driver tabs as needed, then click Apply. 
6. To save the settings, click OK. 
 

Saving a Set of Commonly Used Printing Options for Windows 

You can define and save a set of options, so that you can apply them to future print jobs. 

To save a set of printing options: 
1. With the document open in your application, click File > Print. 
2. To open the Printing Preferences window, select your printer, then click Properties or Preferences. 
3. In the Printing Properties window, click the tabs, then select the desired settings 
4. In the Printing Properties window, click Saved Settings, then click Save As. 
5. To save the set of options in the Saved Settings list, type a name for the set of printing options, 

then click OK. 
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Macintosh Printing Options 

Selecting Printing Options for Macintosh 

To use specific printing options, change the settings before sending the job to the printer. 
1. With the document open in your application, click File > Print. 
2. Select your printer. 
3. In the Print window, click Preview, then select Xerox Features. 

Note: To see all printing options, click Show Details. 

4. Select any other required printing options from the lists. 
5. Click Print to send the job to the printer. 
 

Saving a Set of Commonly Used Printing Options for Macintosh 

You can define and save a set of options, so that you can apply them to future print jobs. 

To save a set of printing options: 
1. With the document open in your application, click File > Print. 
2. Select your printer from the Printers list. 
3. Select the required printing options from the lists in the Print dialog box. 

Note: To see all printing options, click Show Details. 

4. Click Presets > Save Current Settings as Preset. 
5. Type a name for the printing options. To save the set of options in the Presets list, click OK. 
6. To print using these options, select the name from the Presets list. 
 

UNIX and Linux Printing 

The Xerox® Print Driver package provides tools for you to manage printers connected in UNIX and Linux 
environments. 

The Xerox® print drivers provide a GUI-based driver dialog for printer feature selections. You can select 
print drivers based on your operating system. 
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Xerox® Printer Manager 

Xerox® Printer Manager is an application that allows you to manage and print to multiple printers in 
UNIX and Linux environments. 

Xerox® Printer Manager allows you to: 
• Configure and check the status of network connected printers. 
• Set up a printer on your network as well as monitor the operation of the printer once installed. 
• Perform maintenance checks and view supplies status at any time. 
• Provide a common look and feel across the many different suppliers of UNIX and Linux operating 

systems. 
 

Installing the Xerox® Printer Manager 

Before you begin: 

Ensure that you have root or superuser privileges to install Xerox® Printer Manager. 

To install the Xerox® Printer Manager: 
1. Download the appropriate package for your operating system. To locate print drivers for your 

printer, go to www.xerox.com/office/drivers . 
2. On the print driver website, navigate to your printer model. 
3. For your printer model, click Drivers & Downloads. 
4. From the Operating System menu, select your operating system. 
5. To identify the print driver for your printer model, review the list of available print drivers. 

Note: For additional information on each driver, click Description. 

6. To select the print driver for your printer model and operating system, click its name. 
7. To begin the download, read the End User License Agreement, then click accept. 

The file automatically downloads to the default location for your computer file downloads. 
8. To install the Xerox® Print Driver package: 

a. Open the package with your OS package manager. 
b. To install using a command-line utility, change to the directory where you downloaded the file. 

To run the installer, type the appropriate command-line utility for your operating system. For 
example: 
• Red Hat: rpm -U <filename>.rpm 
• Debian-based Linux: dpkg -i <filename>.deb 
• AIX: rpm -U <filename>.rpm 
• HPUX: <filename>.depot.gz  
• Solaris: pkgadd -d <filename>.pkg 

Note: Most installations create a Xerox directory in /opt/Xerox/prtsys. For additional information 
about utilities included in the OS package manager, refer to the manual included with the package. 
For example, man xeroxprtmgr. 
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Launching Xerox® Printer Manager 

To launch Xerox® Printer Manager, do one of the following tasks. 
• For UNIX, log in as root. From a terminal window, type xosdprtmgr, then press Enter or Return. 
• For Linux, type sudo xeroxprtmgr, then press Enter or Return. 
 

Printing with xeroxprint 

Xerox has its own print command. You can use the following command: 

xeroxprint -d<Some_Queue> -o[Options] <Somefile> 
 



Printing 

 

 Xerox® VersaLink® B405 Multifunction Printer 121 
 User Guide 
 

Printing from a Linux Workstation 

To print from a Linux workstation, install either a Xerox® print driver for Linux or a CUPS print driver. You 
do not need both drivers. 

Xerox recommends that you install one of the full-featured custom print drivers for Linux. To locate 
drivers for your printer, go to www.xerox.com/office/drivers. 

If you use CUPS, ensure that CUPS is installed and running on your workstation. The instructions for 
installing and building CUPS are contained in the CUPS Software Administrators Manual, written and 
copyrighted by Easy Software Products. For complete information on CUPS printing capabilities, refer to 
the CUPS Software Users Manual available from www.cups.org/documentation.php. 
 

Installing the PPD on the Workstation 
1. If available, download the Xerox® PPD for CUPS from the Drivers and Downloads page on the Xerox 

Support website. 
2. Copy the PPD into the CUPS ppd/Xerox folder on your workstation. If you are unsure of the location 

of the folder, use the Find command to locate the PPD files. 
3. Follow the instructions that are included with the PPD. 
 

Adding the Printer 
1. Verify that the CUPS daemon is running. 
2. Open a Web browser and type http://localhost:631/admin, then click Enter or Return. 
3. For User ID, type root. For password, type the root password. 
4. Click Add Printer and follow the onscreen prompts to add the printer to the CUPS printer list. 
 

Printing with CUPS 

CUPS supports the use of both the System V (lp) and Berkeley (lpr) printing commands. 
1. To print to a specific printer in System V, type: lp -dprinter filename, then click Enter. 
2. To print to a specific printer in Berkeley, type: lpr -Pprinter filename, then click Enter. 
 

Mobile Printing Options 

This printer can print from iOS and Android mobile devices. 
 

Printing with Wi-Fi Direct 

You can connect to your printer from a Wi-Fi mobile device, such as a tablet, computer, or smart phone, 
using Wi-Fi Direct. 

For details, refer to Connecting with Wi-Fi Direct on page 42. 

For details on using Wi-Fi Direct, refer to the documentation provided with your mobile device. 

Note: Depending on which mobile device you are using, the printing procedure varies. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&PgName=driver&Language=English
http://www.cups.org/documentation.php
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Printing with AirPrint 

You can print directly from your iPhone, iPad, iPod touch, or Mac using AirPrint. To enable AirPrint for 
your printer, refer to Configuring AirPrint on page 43. To use AirPrint, ensure that your mobile device is 
connected to the same wireless network as the printer. 

To print with AirPrint: 
1. Open the email, photograph, website page, or document that you want to print. 
2. Tap the Action icon. 
3. Tap Print. 
4. Select your printer, then set the printer options. 
5. Tap Print. 
 

Printing from a Mopria-Enabled Mobile Device 

Mopria is a software feature that enables users to print from mobile devices without requiring a print 
driver. You can use Mopria to print from your mobile device to Mopria-enabled printers. 

Notes: 

• Mopria and all of its required protocols are enabled by default. 
• Ensure that you have the latest version of the Mopria Print Service installed on your mobile 

device. You can obtain a free download from the Google Play Store. 
• Wireless devices must join the same wireless network as the printer. 
• The name and location of your printer appears in a list of Mopria-enabled printers on 

connected devices. 

To print using Mopria, follow the directions provided with your mobile device. 
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Printing From a USB Flash Drive 

You can print a file stored on a USB Flash drive. The USB port is on the front of the printer. 

Notes: 

• If the device is in Power Saver mode, before proceeding with the Print job, to wake the device, 
press the Power Saver button. 

• Only USB Flash drives formatted to the typical FAT32 file system are supported. 

To print from a USB Flash drive: 
1. Insert the USB Flash drive into the USB memory port on the printer. 
2. At the USB Drive has been detected screen, touch Print from USB. 

Note: If this feature does not appear, enable the feature or contact the system administrator. For 
details, refer to the System Administrator Guide at www.xerox.com/office/VLB405docs. 

3. Add files to the Document Source Table. 
− To print a group of print-ready files, for the USB drive or folder, touch the Select All icon. Verify 

that your files are selected. 
− To print a specific file, browse to that file, then touch the file name or icon. 

4. Touch OK. 
5. Confirm that the required files are listed. 

− To select more files, touch Add Document, then touch OK. 
− To remove a file name from the list, touch the file name, then touch Remove. 

6. Select the paper supply, quantity, and 2-sided printing options. 
7. Touch Print. 
8. When you are finished, remove the USB Flash drive. 

To print from a USB Flash drive that is already inserted in the printer: 
1. If the USB Flash drive is already in the USB memory port, press the Home button. 
2. Touch USB. 
3. Touch Print from USB. 

Note: If this feature does not appear, enable the feature or contact the system administrator. For 
details, refer to the System Administrator Guide at www.xerox.com/office/VLB405docs. 

4. Add files to the Document Source Table. 
− To print a group of print-ready files, for the USB drive or folder, touch the Select All icon. Verify 

that your files are selected. 
− To print a specific file, browse to that file, then touch the file name or icon. 

5. Touch OK. 
6. Confirm that the required files are listed. 

− To select more files, touch Add Document, then touch OK. 
− To remove a file name from the list, touch the file name, then touch Remove. 

7. Select the paper supply, quantity, and 2-sided printing options. 
8. Touch Print. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLB405&PgName=Man&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLB405&PgName=Man&Language=English
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Printing Features 

This section includes: 
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• Selecting Job Completion Notification for Windows ....................................................................................... 135 
 

Managing Jobs 
From the Jobs window in the Embedded Web Server, you can view a list of active and completed 
print jobs. 

From the control panel Jobs menu, you can view lists of active jobs, secure jobs, or completed jobs. You 
can pause, delete, print, or view job progress or job details for a selected job. When you send a secure 
print job, the job is held until you release it by typing a passcode at the control panel. For details, refer to 
Printing Special Job Types on page 125. 

To pause the print job with the option to delete it: 
1. At the printer control panel, press the Home button. 
2. Touch Jobs, then touch the name of the desired print job. 
3. Do one of the following: 

− To pause the print job, touch Pause. To resume the print job, touch Resume. 
− To delete the print job, touch Delete. At the prompt, touch Delete. 

Note: If you do not make a selection within 60 seconds, the job automatically resumes. 

4. To return to the Home screen, press the Home button. 
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To view, print, or delete jobs: 
1. At the printer control panel, press the Home button. 
2. To view a list of active and completed jobs, touch Jobs. 
3. To view a list of specific job types, touch an option. 

− To view Saved Jobs, touch Saved Jobs. To print the job, touch the job, enter the quantity, then 
touch OK. To delete the job, touch the Trash icon, then touch Delete. 

− To view Personal jobs, touch Personal & Secure Jobs. To print the jobs, touch the folder, then 
touch Print All, or Delete All. 

− For Secure Jobs, touch Personal & Secure Jobs. Touch the folder, enter the passcode number, 
then touch OK. To print a Secure Job, touch the job. To print or delete all the jobs in the folder, 
touch Print All, or Delete All. 

4. To view details about a job, touch the job. 
5. To return to the Home screen, press the Home button. 

Notes: 

• The system administrator can restrict users from deleting jobs. If a system administrator has 
restricted job deletion, you can view the jobs, but not delete them. 

• Only the user that sent the job or the system administrator can delete a Secure Print job. 
 

Printing Special Job Types 

Special job types allow you to send a print job from your computer, then print it from the printer control 
panel. Select special job types in the print driver, Printing Options tab, under Job Type. 
 

Saved Job 

Saved Jobs are documents sent to the printer and, unless deleted, are stored there for future use. Any 
user can print or delete a Saved Job. 

To print a Saved Job: 
1. In your software application, access the print settings. For most software applications, press CTRL+P 

for Windows or CMD+P for Macintosh. 
2. Select your printer, then open the print driver. 

− For Windows, click Printer Properties. Depending on your application, the title of the button 
can vary. 

− For Macintosh, in the Print window, click Preview, then select Xerox Features. 
3. For Job Type, select Saved Job. 
4. Type a job name or select a name from the list, then click OK. 
5. Select any other required printing options. 

− For Windows, click OK, then click Print. 
− For Macintosh, click Print. 
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To release a Saved Job: 
1. At the printer control panel, press the Home button. 
2. Touch Jobs. 
3. To view Saved Jobs, touch Saved Jobs. 
4. To print a Saved Job, touch the job name, enter the quantity, then touch OK. 
5. To delete the document after printing, for that job, touch the Trash icon, then at the prompt, touch 

Delete. 
6. To return to the Home screen, press the Home button. 
 

Secure Print 

Use Secure Print to print sensitive or confidential information. After you send the job, it is held at the 
printer until you enter your passcode at the printer control panel. 

To print using Secure Print: 
1. In your software application, access the print settings. For most software applications, press CTRL+P 

for Windows or CMD+P for Macintosh. 
2. Select your printer, then open the print driver. 

− For Windows, click Printer Properties. Depending on your application, the title of the button 
varies. 

− For Macintosh, in the Print window, click Preview, then select Xerox Features. 
3. For Job Type, select Secure Print. 
4. Type the passcode, confirm the passcode, then click OK. 
5. Select any other required printing options. 

− For Windows, click OK, then click Print. 
− For Macintosh, click Print. 

To release a Secure Print job: 
1. At the printer control panel, press the Home button. 
2. Touch Jobs. 
3. To view Secure Print jobs, touch Personal & Secure Jobs. 
4. Touch your folder. 
5. Enter the passcode number, then touch OK. 
6. Select an option: 

− To print a Secure Print job, touch the job. 
− To print all the jobs in the folder, touch Print All. 
− To delete a Secure Print job, touch the Trash icon, then at the prompt, touch Delete. 
− To delete all the jobs in the folder, touch Delete All. 

Note: After a Secure Print job is printed, it is deleted automatically. 

7. To return to the Home screen, press the Home button. 
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Personal Print 

Personal Print allows you to store a document in the printer, then print it from the control panel. 

Note: This feature is only available on a Windows computer printing to a network printer. 

Personal Print is a type of saved job with these features: 
• A Personal Print job appears in a folder named after the user ID associated with the print job. 
• A Personal Print job does not use a passcode. 
• Any user can print or delete a Personal Print job. 
• You can print all jobs in the list at once, delete an individual job, or delete all jobs in the list. 
• After a Personal Print job is printed, it is deleted automatically. 

To print using Personal Print: 
1. In your software application, access the print settings. For most software applications, click File > 

Print or for Windows, press CTRL+P. 
2. Select your printer, then click Printer Properties. Depending on your application, the title of the 

button varies. 
3. For Job Type, select Personal Print. 
4. Select any other required printing options, then click OK. 
5. To send the job to the printer, click Print. 

To release a Personal Print job: 
1. At the printer control panel, press the Home button. 
2. Touch Jobs. 
3. To view Personal Print jobs, touch Personal & Secure Jobs. 
4. Touch your folder. 
5. If prompted for a passcode, touch Skip. 

Note: When your folder contains Secure Print jobs and Personal Print jobs, the passcode prompt 
appears. 

6. Select an option. 
− To print a Personal Print job, touch the job. 
− To print all the jobs in the folder, touch Print All. 
− To delete all the jobs in the folder, touch Delete All. 

7. To return to the Home screen, press the Home button. 
 

Sample Set 

The Sample Set job type prints one copy of a multiple-copy print job before printing the remaining 
copies. After reviewing the sample set, you can either print the remaining copies or delete them at the 
printer control panel. 

Sample Set is a type of saved job with these features: 
• A Sample Set job appears in a folder named after the user ID associated with the print job. 
• A Sample Set job does not use a passcode. 
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• Any user can print or delete a Sample Set job. 
• A Sample Set prints one copy of a job to allow you to proofread the job before printing any 

remaining copies. 

After a Sample Set job is printed, it is deleted automatically. 

To print using Sample Set: 
1. In your software application, access the print settings. For most software applications, press CTRL+P 

for Windows or CMD+P for Macintosh. 
2. Select your printer, then open the print driver. 

− For Windows, click Printer Properties. Depending on your application, the title of the button 
varies. 

− For Macintosh, in the Print window, click Preview, then select Xerox Features. 
3. For Job Type, select Sample Set. 
4. Select any other required printing options. 

− For Windows, click OK, then click Print. 
− For Macintosh, click Print. 

To release a Sample Set: 
1. At the printer control panel, press the Home button. 
2. To view available jobs, touch Jobs. 
3. Touch the Sample Set job. 

Note: The Sample Set file description shows the job as Held for Future Printing, and shows the 
number of remaining copies of the job. 

4. Select an option. 
− To print the remaining copies of the job, touch Release. 
− To delete the remaining copies of the job, touch Delete. 

5. To return to the Home screen, press the Home button. 
 

Selecting Paper Options for Printing 

There are two ways to select the paper for your print job. You can let the printer select which paper to 
use based on the document size, paper type, and paper color you specify. You can also select a specific 
tray loaded with the desired paper. 

Note: To enable printing on envelopes, refer to Adjusting the Fuser for Printing on Envelopes on 
page 158. 

• For Windows, paper options are in the Paper field on the Printing Options tab. 
• For Macintosh, in the Print window, in Xerox Features, paper options are in the Paper field for 

Paper/Output. 
 



Printing 

 

 Xerox® VersaLink® B405 Multifunction Printer 129 
 User Guide 
 

Scaling 

Scaling reduces or enlarges the original document to match the selected output paper size. 
• For Windows, the scale options are on the Printing Options tab, in the Paper field. 
• For Macintosh, the scale options are in the Print window for Preview. To view more printing options, 

click Show Details. 

The following scaling options are available: 
• Automatically Scale scales the document to fit the selected Output Paper Size. The scaling amount 

appears in the percentage box below the sample image. 
• No Scaling does not change the size of the page image printed on the output paper, and 100% 

appears in the percentage box. If the original size is larger than the output size, the page image is 
cropped. If the original size is smaller than the output size, extra space appears around the page 
image. 

• Manually Scale scales the document by the amount entered in the percentage box below the 
preview image. 

 

Printing on Both Sides of the Paper 

Printing a 2-Sided Document 

If your printer supports Automatic 2-Sided Printing, the options are specified in the print driver. The print 
driver uses the settings for portrait or landscape orientation from the application for printing the 
document. 

Note: Ensure that the paper size and weight are supported. For details, refer to Supported Paper Sizes 
and Weights for Automatic 2-Sided Printing on page 143. 
 

2-Sided Page Layout Options 

You can specify the page layout for 2-sided printing, which determines how the printed pages turn. 
These settings override the application page orientation settings. 
• 1-Sided Print: This option prints on one side of the media. Use this option when printing on 

envelopes, labels, or other media that cannot be printed on both sides. 
• 2-Sided Print: This option prints the job on both sides of the paper to allow binding on the long 

edge of the paper. The following illustrations show the result for documents with portrait and 
landscape orientations, respectively: 
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• 2-Sided Print, Flip on Short Edge: Prints on both sides of the paper. The images print to allow 
binding on the short edge of the paper. The following illustrations show the result for documents 
with portrait and landscape orientations, respectively: 

   

Note: 2-Sided Printing is part of the Earth Smart settings. 

To change your default print driver settings, refer to Setting Default Printing Options for Windows on 
page 116. 
 

Printing Mirror Images 

If the PostScript driver is installed, you can print pages as a mirror image. Images mirror left to right 
when printed. 
 

Printing Multiple Pages to a Single Sheet 

When printing a multiple-page document, you can print more than one page on a single sheet of paper. 

To print 1, 2, 4, 6, 9, or 16 pages per side, select Pages Per Sheet on the Page Layout tab. 
• For Windows, Page Layout is on the Document Options tab. 
• For Macintosh, in the Print window, Layout is on the Preview list. 

 
 

Print Quality 

Print-quality modes: 
• Standard print-quality mode: 600 x 600 dpi 
• Enhanced print-quality mode: 1200 x 1200 dpi 
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Image Options 

Image options controls how the printer uses lightness and contrast to produce your document. The 
Windows PostScript print driver and the Macintosh print drivers provide the widest range of controls on 
the Image Options tab. 
• For Windows, Lightness and Contrast features are on the Image Options tab. 
• For Macintosh, in the Print window, in Xerox Features, Image Options is on the Paper/Output list. 
 

Lightness 

The Lightness feature allows you to adjust the overall lightness or darkness of the text and images in 
your printed job. 
 

Contrast 

You can use the Contrast feature to adjust the variation between light and dark areas of the print job. 
 

Image Shift 

Image Shift allows you to modify the location of the image on the page. You can shift the printed image 
along the X and Y axes of each sheet of paper. 
 

Printing Booklets 

With 2-sided printing, you can print a document in the form of a small booklet. You can create booklets 
from any paper size that is supported for 2-sided printing. 

The print driver automatically reduces each page image and prints four page images per sheet of paper, 
two page images on each side. The pages are printed in the correct order so that you can fold and staple 
the pages to create the booklet. 
• For Windows, Booklet Layout is on the Page Layout tab. Page Layout is on the Document  

Options tab. 
• For Macintosh, in the Print window, in Xerox Features, Booklet Layout is on the Paper/Output list. 
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When you print booklets using the Windows PostScript or Macintosh driver, you can specify the gutter 
and creep. 
• Gutter: Specifies the horizontal distance in points between the page images. A point is 0.35 mm 

(1/72 in.). 
• Creep: Specifies how much the page images shift outward in tenths of a point. Shifting 

compensates for the thickness of the folded paper, which can cause the page images to shift 
outward slightly when folded. You can select a value from zero to 1 point. 

 

Gutter Creep 

 

 

 
 

 
 

Using Special Pages 

The Special Pages options control how covers, inserts, and exception pages are added to your printed 
document. 
• For Windows, the Special Pages tab is on the Document Options tab. 
• For Macintosh, in the Print window, in Xerox Features, Special Pages is on the Paper/Output 

drop-down list. 
 

Printing Cover Pages 

A cover page is the first or last page of a document. You can select paper sources for the cover pages 
that are different from the source used for the body of a document. For example, you can use your 
company letterhead for the first page of a document. You can use heavyweight paper for the first and 
last pages of a report. You can use any applicable paper tray as the source for printing cover pages. 

The following options are available: 
• No Covers: This option does not print cover pages. No cover pages are added to the document. 
• Front Only: This option prints the first page on paper from the specified tray. 
• Back Only: This option prints the back page on paper from the specified tray. 
• Front and Back: Same: This option prints the front and back cover pages from the same tray. 
• Front and Back: Different: This option prints the front and back cover pages from different trays. 

After making a selection for printing the cover pages, you can select the paper for the front and back 
covers by size, color, or type. You can use blank or pre-printed paper, and you can print side one, side two, 
or both sides of the cover pages. 
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Printing Insert Pages 

You can add blank or pre-printed insert pages before page one of each document or after designated 
pages within a document. Adding an insert after designated pages within a document separates 
sections, or acts as a marker or placeholder. Ensure that you specify the paper to use for the insert pages. 
• Insert Options provides the options to place an insert After Page X, where X is the specified page, or 

Before Page 1. 
• Insert Quantity specifies the number of pages to insert at each location. 
• Pages: Specifies the page or range of pages that use the exception page characteristics. Separate 

individual pages or page ranges with commas. Specify pages within a range with a hyphen. For 
example, to specify pages 1, 6, 9, 10, and 11, type 1,6,9-11. 

• Paper: Displays the default size, color, and type of paper selected in Use Job Settings. 
• Job Setting: Displays the attributes of the paper for the remainder of the job. 
 

Printing Exception Pages 

Exception pages have different settings from the rest of the pages in the job. You can specify differences 
such as page size, page type, and page color. You can also change the side of the paper on which to print 
as your job requires. A print job can contain multiple exceptions. 

For example, your print job contains 30 pages. You want five pages to print on only one side of a special 
paper, and the remainder of the pages printed 2-sided on regular paper. You can use exception pages to 
print the job. 

In the Add Exceptions window, you can set the characteristics of the exception pages and select the 
alternate paper source: 
• Pages: Specifies the page or range of pages that use the exception page characteristics. Separate 

individual pages or page ranges with commas. Specify pages within a range with a hyphen. For 
example, to specify pages 1, 6, 9, 10, and 11, type 1,6,9-11. 

• Paper: Displays the default size, color, and type of paper selected in Use Job Settings. 
• 2-Sided Printing allows you to select 2-sided printing options. Click the Down arrow to select an 

option: 
− 1-Sided Print prints the exception pages on one side only. 
− 2-Sided Print prints the exception pages on both sides of the paper and flips the pages on the 

long edge. The job then can be bound on the long edge of the pages. 
− 2-Sided Print, Flip on Short Edge prints the exception pages on both sides of the paper and 

flips the pages on the short edge. The job then can be bound on the short edge of the pages. 
− Use Job Setting prints the job using the attributes shown in the Job Settings box. 

• Job Setting: Displays the attributes of the paper for the remainder of the job. 

Note: Some combinations of 2-sided printing with certain paper types and sizes can produce 
unexpected results. 
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Printing Watermarks for Windows 

A watermark is special purpose text that can be printed across one or more pages. For example, you can 
add a word like Copy, Draft, or Confidential as a watermark instead of stamping it on a document before 
distribution. 

Note: This feature is only available on a Windows computer printing to a network printer. 

To print a watermark: 
1. In the print driver, click the Document Options tab. 
2. Click the Watermark tab. 
3. From the Watermark menu, select the watermark. You can choose from preset watermarks, or 

create a customized watermark. You can also manage watermarks from this menu. 
4. Under Text, select an option: 

− Text: Enter the text in the field, then specify the font. 
− Time Stamp: Specify the date and time options, then specify the font. 
− Picture: To locate the picture, click the Browse icon. 

5. Specify the scaling angle and position of the watermark. 
− Select the scaling option that specifies the size of the picture in relation to the original image. 

Use the arrows to scale the image in increments of 1%. 
− To define the angle of the image on the page, specify the position option or to rotate the 

image left or right by increments of 1, use the arrows. 
− To define the location of the image on the page, specify the position option, or to move the 

image in each direction in increments of 1, use the arrows. 
6. Under Layering, select how to print the watermark. 

− Print in Background prints the watermark behind the text and graphics in the document. 
− Blend: This option combines the watermark with the text and graphics in the document. A 

blended watermark is translucent, so you can see both the watermark and the document 
content. 

− Print in Foreground prints the watermark over the text and graphics in the document. 
7. Click Pages, then select the pages to print the watermark: 

− Print on All Pages prints the watermark on all pages of your document. 
− Print on Page 1 Only prints the watermark only on the first page of the document. 

8. If you select a picture as a watermark, specify the lightness settings for the image. 
9. Click OK. 
 



Printing 

 

 Xerox® VersaLink® B405 Multifunction Printer 135 
 User Guide 
 

Orientation 

Orientation allows you to select the direction that the page prints. 
• For Windows, the Orientation tab is on the Document Options tab. 

Note: The orientation setting in your application print dialog box may override the orientation 
options in the print driver. 

• For Macintosh, Orientation options are in the Print window for Preview. 

The following options are available: 
• Portrait: Orients the paper so that the text and images print across the short dimension 

of the paper. 

 
• Landscape: Orients the paper so that the text and images print across the long dimension of the 

paper. 

 
• Rotated Landscape: Orients the paper so that the content is rotated 180 degrees and with the long 

bottom side up. 

 
Note: For Macintosh, to print portrait text and images in landscape orientation, clear the Auto 
Rotate check box. 

 

Printing Banner Pages 

To enable or disable Banner Pages, contact your system administrator, or refer to the System 
Administrator Guide at www.xerox.com/office/VLB405docs. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLB405&PgName=Man&Language=English
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Selecting Job Completion Notification for Windows 

You can select to be notified when your job finishes printing. A message appears on your computer 
screen with the name of the job and the name of the printer where it was printed. 

Note: This feature is only available on a Windows computer printing to a network printer. 

To select job completion notification from the Advanced tab: 
1. Click Notifications. 
2. Click Notify for Completed Jobs, then select an option. 

− Enabled: This option turns on notifications. 
− Disabled: This option turns off the Notification feature. 

3. Click OK. 
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Using Custom Paper Sizes 

This section includes: 
• Printing on Custom Paper Sizes ................................................................................................................................ 137 
• Defining Custom Paper Sizes ..................................................................................................................................... 137 

You can print on custom paper sizes that are within the minimum and maximum size range supported by 
the printer. For details, refer to Supported Custom Paper Sizes on page 143. 
 
 

Printing on Custom Paper Sizes 
Note: Before printing on a custom paper size, use the Custom Paper Sizes feature in printer 
properties to define the custom size. For details, refer to Defining Custom Paper Sizes on page 137. 

 

Printing on Custom Paper Size from Windows 
Note: Before printing on custom-size paper, define the custom size in the printer properties. 

1. Load the custom-size paper in the tray. 
2. In the application, click File > Print, then select your printer. 
3. In the Print dialog box, click Printer Properties. 
4. On the Printing Options tab, from the Paper list, select the required custom paper size and type. 
5. Select any other required options, then click OK. 
6. In the Print dialog box, click Print. 
 

Printing on Custom Paper Size from Macintosh 
1. Load the custom-size paper. For details, refer to Loading Paper on page 145. 
2. In the application, click File > Print. 
3. From the Paper Size list, select the custom paper size. 
4. Click Print. 
 

Defining Custom Paper Sizes 

To print custom paper sizes, define the custom width and length of the paper in the print driver software 
and on the printer control panel. When setting the paper size, ensure that you specify the same size as 
the paper in the tray. Setting the wrong size can cause a printer error. Print driver settings override 
control panel settings when you print using the print driver software on your computer. 
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Creating and Saving Custom Paper Sizes in the Print Driver 

You can print custom-size paper from any paper tray. Custom-size paper settings are saved in the print 
driver and are available for you to select in all your applications. 

For detail on supported paper sizes for each tray, refer to Supported Custom Paper Sizes on page 143. 

To create and save custom sizes for Windows: 
1. In the print driver, click the Printing Options tab. 
2. For Paper, click the arrow, then select Other Size > Advanced Paper Size > Output Paper Size > 

New. 
3. In the New Custom Paper Size window, enter the height and width of the new size.  
4. To specify the units of measurement, at the bottom of the window, click the Measurements button, 

then select Inches or Millimeters. 
5. To save, in the Name field, type a title for the new size, then click OK. 

To create and save custom sizes for Macintosh: 
1. In the application, click File > Print. 
2. Click Paper Size, then select Manage Custom Sizes. 
3. To add a new size, in the Manage Paper Sizes window, click the plus sign (+). 
4. Double-click Untitled, then type a name for the new custom size. 
5. Enter the height and width of the new custom size. 
6. Click the arrow for the Non-Printable Area field, then select the printer from the list. Or, for User 

Defined margins, set the top, bottom, right, and left margins. 
7. To save the settings, click OK. 
 

Defining a Custom Paper Size at the Control Panel 

You can print custom-size paper from any paper tray. Custom-size paper settings are saved in the print 
driver and are available for you to select in all your applications. 
1. At the printer control panel, press the Home button. 
2. Touch Device > Paper Trays. 
3. Touch the desired tray for your custom-size paper. 
4. Touch the current size setting, then from the list, touch Custom. 
5. In the Custom Paper Size screen, enter the height and width of the new size. 
6. To save the setting, touch OK. 
7. To return to the Home screen, press the Home button. 
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This chapter includes: 
• Supported Paper ............................................................................................................................................................. 140 
• Loading Paper ................................................................................................................................................................. 145 
• Printing on Special Paper ............................................................................................................................................ 155 
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Supported Paper 

This section includes: 
• Ordering Paper ................................................................................................................................................................ 140 
• General Paper Loading Guidelines .......................................................................................................................... 140 
• Paper That Can Damage Your Printer .................................................................................................................... 140 
• Paper Storage Guidelines ............................................................................................................................................ 141 
• Supported Standard Paper Sizes .............................................................................................................................. 142 
• Supported Paper Types and Weights ..................................................................................................................... 142 
• Supported Standard Paper Sizes for Automatic 2-Sided Printing ............................................................... 143 
• Supported Paper Types and Weights for Automatic 2-Sided Printing....................................................... 143 
• Supported Custom Paper Sizes ................................................................................................................................. 143 
• Cardstock ........................................................................................................................................................................... 144 

Your printer is designed to use various paper and other media types. To ensure the best print quality and 
to avoid jams, follow the guidelines in this section. 

For best results, use Xerox paper and media recommended for your printer. 
 
 

Ordering Paper 

To order paper or other media, contact your local reseller or visit www.xerox.com/office/VLB405supplies. 
 

General Paper Loading Guidelines 
• Do not overfill the paper trays. Do not load paper above the maximum fill line in the tray. 
• Adjust the paper guides to fit the paper size. 
• Fan paper before loading it in the paper tray. 
• If excessive jams occur, use paper or other approved media from a new package. 
• Do not print on label media once a label has been removed from a sheet. 
• Use only paper envelopes. Print envelopes 1-sided only. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=VersaLink+VLB405&PgName=order&Language=English
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Paper That Can Damage Your Printer 

Some paper and other media types can cause poor output quality, increased paper jams, or damage 
your printer. Do not use the following: 
• Rough or porous paper 
• Inkjet paper 
• Non-laser glossy or coated paper 
• Paper that has been photocopied 
• Paper that has been folded or wrinkled 
• Paper with cutouts or perforations 
• Stapled paper 
• Envelopes with windows, metal clasps, side seams, or adhesives with release strips 
• Padded envelopes 
• Plastic media 
• Transparencies 
 

 CAUTION: The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee 
does not cover damage caused by using unsupported paper or specialty media. The Xerox 
Total Satisfaction Guarantee is available in the United States and Canada. Coverage could 
vary outside these areas. Please contact your local representative for details. 

 
 

Paper Storage Guidelines 

Storing your paper and other media properly contributes to optimum print quality. 
• Store paper in dark, cool, relatively dry locations. Most paper is susceptible to damage from 

ultraviolet and visible light. Ultraviolet light, from the sun and fluorescent bulbs, is particularly 
damaging to paper. 

• Reduce the exposure of paper to strong lights for long periods of time. 
• Maintain constant temperatures and relative humidity. 
• Avoid storing paper in attics, kitchens, garages, or basements. These spaces are more likely to 

collect moisture. 
• Store paper flat, either on pallets, cartons, shelves, or in cabinets. 
• Avoid food or drinks in the area where paper is stored or handled. 
• Do not open sealed packages of paper until you are ready to load them into the printer. Leave 

stored paper in the original packaging. The paper wrapper protects the paper from moisture loss 
or gain. 

• Some special media is packaged inside resealable plastic bags. Store the media inside the bag until 
you are ready to use it. Keep unused media in the bag and reseal it for protection. 
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Supported Standard Paper Sizes 
 

Tray European Standard Sizes North American Standard Sizes 

All Trays A4 (210 x 297 mm, 8.3 x 11.7 in.) 
A5 (148 x 210 mm, 5.8 x 8.3 in.) 
215 x 315 mm, 8.5 x 12.4 in. 

Legal (216 x 356 mm, 8.5 x 14 in.) 
Folio (216 x 330 mm, 8.5 x 13 in.) 
Letter (216 x 279 mm, 8.5 x 11 in.) 
Executive (184 x 267 mm, 7.25 x 10.5 in.) 
203 x 254 mm, 8 x 10 in. Statement (140 x 216 mm, 
5.5 x 8.5 in.) 

Tray 1 
Bypass Tray 

A6 (105 x 148 mm, 4.1 x 5.8 in.) Postcard (101.6 x 152.4 mm, 4 x 6 in.) 
127 x 178 mm, 5 x 7 in. 

Bypass Tray C5 envelope (162 x 229 mm, 
6.4 x 9 in.) 
C6 envelope (114 x 162 mm, 
4.5 x 6.38 in.) 
DL envelope (110 x 220 mm, 
4.33 x 8.66 in.) 

Monarch envelope (98 x 190 mm, 3.9 x 7.5 in.) 
No. 10 envelope (241 x 105 mm, 4.1 x 9.5 in.) 

  
 

Supported Paper Types and Weights 
 

Trays Paper Types Weights 

All Trays Plain 
Hole-Punched 
Recycled 
Custom 

60–90 g/m² 

Bond 
Letterhead 
Pre-Printed 

90–105 g/m² 

Lightweight Cardstock 106–163 g/m² 

Cardstock 164–220 g/m² 

Bypass Tray Envelopes 
Labels 

60–216 g/m² 
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Supported Standard Paper Sizes for Automatic 2-Sided Printing 
 

European Standard Sizes North American Standard Sizes 

A4 (210 x 297 mm, 8.3 x 11.7 in.) 
A5 (148 x 210 mm, 5.8 x 8.3 in.) 
215 x 315 mm, 8.5 x 12.4 in. 

Legal (216 x 356 mm, 8.5 x 14 in.) 
Letter (216 x 279 mm, 8.5 x 11 in.) 
Folio (216 x 330 mm, 8.5 x 13 in.) 
Executive (184 x 267 mm, 7.25 x 10.5 in.) 
203 x 254 mm, 8 x 10 in. 
Statement (140 x 216 mm, 5.5 x 8.5 in.) 

  
 

Supported Paper Types and Weights for Automatic 2-Sided Printing 
 

Paper Type Weight 

Plain 
Hole-Punched 
Recycled 
Custom 

60–90 g/m² 

Bond 
Letterhead 
Pre-Printed 

90–105 g/m² 

Lightweight Cardstock 106-163 g/m²  
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Supported Custom Paper Sizes 
 

Tray Number Paper Sizes 

Tray 1 Width: 76.2–215.9 mm (3–8.5 in.) 
Length: 127.0–355.6 mm (5–14 in.) 

Tray 2–4 Width: 139.7–215.9 mm (5.5–8.5 in.) 
Length: 210–355.6 mm (8.3–14 in.) 

Bypass Tray Width: 76.2–215.9 mm (3–8.5 in.) 
Length: 127.0–355.6 mm (5–14 in.) 

2-Sided Printing Width: 139.7–215.9 mm (5.5–8.5 in.) 
Length: 210–355.6 mm (8.3–14 in.) 

  
 

Cardstock 

You can print Cardstock and Lightweight Cardstock up to 220 g/m² from any tray. 
• For types and weights of supported Cardstock for 1-Sided printing, refer to Supported Paper Types 

and Weights on page 142. 
• For types and weights of supported Cardstock for 2-Sided printing, refer to Supported Paper Types 

and Weights for Automatic 2-Sided Printing on page 143. 
 



Paper and Media 

 

 Xerox® VersaLink® B405 Multifunction Printer 145 
 User Guide 
 

Loading Paper 

This section includes: 
• Changing Paper Settings ............................................................................................................................................. 145 
• Loading Paper in Trays 1-4 ......................................................................................................................................... 145 
• Loading Paper in the Bypass Tray ........................................................................................................................... 148 
• Loading Small Paper Sizes in the Bypass Tray .................................................................................................... 150 
• Configuring Trays 1-4 for the Paper Length ........................................................................................................ 153 
 
 

Changing Paper Settings 

When you load paper into a tray, you can change the paper tray settings. The following options are 
available: 

− Fully Adjustable: If you select this paper setting, you can change the paper size, type, and 
color when you load paper into the tray. 

− Dedicated: If you select this paper setting, you cannot change the paper size, type, and color 
when you load paper into the tray. 

− Bypass: When paper is present in this tray, it is used for print jobs where you did not specify a 
particular tray. 

For details about how to change the paper tray setting when loading paper in trays 1–4, refer to Loading 
Paper in Trays 1–4 on page 145. For details about how to change the paper setting when loading paper 
in the bypass tray, refer to Loading Paper in the Bypass Tray on page 148. 
 

Loading Paper in Trays 1-4 

You can adjust the length of the paper tray to accommodate A4, Letter (8.5 x 11 in.), and Legal (8.5 x 14 
in.) paper sizes. 

Note: Trays 2–4 are optional. 
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To load paper in Trays 1–4: 
1. To remove the tray from the printer, pull out the tray until it stops, lift the front of the tray slightly, 

then remove it. 

 
2. Adjust the paper length and width guides as shown. 

 
3. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. 

This procedure separates any sheets that are stuck together and reduces the possibility of jams. 

 
4. Load paper into the tray with the print side face up. 

− Load hole-punched paper with the holes to the left. 
− For 1-sided printing, load letterhead paper face up with the top of the paper toward the back of 

the tray. 
− For 2-sided printing, load letterhead and pre-printed paper face down with the top edge going 

into the printer. 
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Note: Do not load paper above the maximum fill line. Overfilling the tray can cause the printer to 
jam. 

 
5. Adjust the length and width guides to fit the paper. 

 
6. Slide the tray back into the printer. 

 
Notes: 

• If the tray does not go all the way in, ensure that the paper lift at the back of the tray 
is locked down. 

• To avoid paper jams, do not remove the paper cover while printing is in progress. 
• If the tray is extended for legal-size paper, the tray protrudes when it is inserted into the 

printer. 
• To confirm the same paper size, type, or color, touch OK. 
• To select a new paper size, type or color, touch the current setting, then select a new setting. 

When you are finished, touch OK. 
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7. To change a paper tray to Dedicated mode: 
a. At the printer control panel, press the Home button. 
b. Touch Device > Paper Trays. 
c. In the Paper Trays menu, touch the preferred tray. 
d. To dedicate the tray for a paper size, type, or color, touch Tray Mode, then touch Dedicated. 

• To select a paper or envelope size, touch the current size setting, then select a size. 
• To select a paper type, touch the current paper type, then select a paper type. 
• To select a paper color, touch the current paper color, then select a paper color. 

e. To save the settings, touch OK. 
f. To return to the Home screen, press the Home button. 

 

Loading Paper in the Bypass Tray 

The Bypass Tray supports the widest variety of media types. It is intended primarily for small-quantity 
jobs that use special media. 

To load paper in the bypass tray: 
1. Open the bypass tray. If the bypass tray is loaded with paper already, remove any paper that is a 

different size or type. 

 
2. Pull out the extension tray for larger sizes. 
3. Move the width guides to the edges of the tray. 
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4. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. 
This procedure separates any sheets that are stuck together and reduces the possibility of jams. 

 
Note: To avoid jams and misfeeds, do not remove paper from its packaging until you are ready to 
use it. 

5. Load the paper in the tray. Load hole-punched paper with the holes to the left. 

 
− For 1-sided printing, load letterhead or pre-printed paper face up with the top edge going into 

the printer. 

 
− For 2-sided printing, load letterhead and pre-printed paper face down with the top edge facing 

you. 
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Note: Do not load paper above the maximum fill line. Overfilling the tray can cause the printer 
to jam. 

6. Adjust the width guides until they touch the edges of the paper. 

 
7. If the control panel prompts you, verify the size, type, and color on the touch screen. If you are not 

prompted, change the paper settings. 
a. At the printer control panel, press the Home button. 
b. Touch Device > Paper Trays. 
c. In the Paper Trays menu, touch the bypass tray icon. 

• To select a paper or envelope size, touch the current size setting, then select a size. 
• To select a paper type, touch the current paper type, then select a paper type. 
• To select a paper color, touch the current paper color, then select a paper color. 

d. To save a setting, touch OK. 
8. To return to the Home screen, press the Home button. 
 

Loading Small Paper Sizes in the Bypass Tray 

The Bypass Tray supports the widest variety of media types. It is intended primarily for small-quantity 
jobs that use special media. 

To load small paper sizes in the bypass tray: 
1. Open the bypass tray. If the bypass tray is loaded with paper already, remove any paper that is a 

different size or type. 
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2. To remove the bypass tray from the printer, pull the tray straight out of the printer. 

 
3. If the bypass tray is loaded with paper already, remove any paper that is a different size or type. 

Raise the paper stop. 

 
4. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. 

This procedure separates any sheets that are stuck together and reduces the possibility of jams. 
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Note: To avoid jams and misfeeds, do not remove paper from its packaging until you are ready to 
use it. 

5. Load the paper in the tray. 

 
Note: Do not load paper above the maximum fill line. Overfilling the tray can cause the printer to 
jam. 

6. Adjust the width guides and the paper stop until they touch the edges of the paper. 

 
7. Slide the tray back into the printer. 

 



Paper and Media 

 

 Xerox® VersaLink® B405 Multifunction Printer 153 
 User Guide 
 

8. If the control panel prompts you, verify the size, type, and color on the screen. If you are not 
prompted, change the paper settings. 
a. At the printer control panel, press the Home button. 
b. Touch Device > Paper Trays. 
c. In the Paper Trays menu, touch the bypass tray icon. 

• To select a paper or envelope size, touch the current size setting, then select a size. 
• To select a paper type, touch the current paper type, then select a paper type. 
• To select a paper color, touch the current paper color, then select a paper color. 

d. To save the settings, touch OK. 
9. To return to the Home screen, press the Home button. 
 

Configuring Trays 1-4 for the Paper Length 

You can adjust the lengths of trays 1–4 to accommodate A4, Letter (8.5 x 11 in.), and larger paper sizes. 
For the longer-length settings, the trays protrude from the front of the printer. 

To change Trays 1–4 to match the paper length: 
1. Remove all paper from the tray. 
2. To remove the tray from the printer, pull out the tray until it stops, lift the front of the tray slightly, 

then remove it. 

 
3. Configure the tray. 

− To compress the tray for shorter paper, hold the back of the tray with one hand. With the other 
hand, press the release latch at the front of the tray, then push the ends inward until they latch. 
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− To extend the tray for longer paper, hold the back of the tray with one hand. With the other 
hand, press the release latch at the front of the tray, then pull the ends outward until they 
latch. 
To protect the paper when the tray is extended, place the paper cover over the extended 
section of the paper tray. 

 
Note: If the tray is extended for Legal-size paper, the tray protrudes when it is inserted into 
the printer. 

 
4. Load paper into the tray before inserting it back into the printer. For details, refer to Loading Paper 

into Trays 1–4 on page 145. 
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Printing on Special Paper 

This section includes: 
• Envelopes .......................................................................................................................................................................... 155 
• Labels .................................................................................................................................................................................. 160 

To order paper or other media, contact your local reseller or visit www.xerox.com/office/VLB405supplies. 
 

For reference:  
www.xerox.com/rmlna Recommended Media List (United States) 
www.xerox.com/rmleu Recommended Media List (Europe) 
 

 
 

Envelopes 

You can print envelopes from the bypass tray only. 
 

Guidelines for Printing Envelopes 
• Use only paper envelopes. 
• Do not use envelopes with windows or metal clasps. 
• Print quality depends on the quality and construction of the envelopes. If you do not get the desired 

results, try another envelope brand. 
• Maintain constant temperatures and relative humidity. 
• Store unused envelopes in their packaging to avoid excess moisture and dryness which can affect 

print quality and cause wrinkling. Excessive moisture can cause the envelopes to seal before or 
during printing. 

• Remove air bubbles from the envelopes before loading them into the tray by setting a heavy book 
on top of them. 

• In the print driver software, select Envelope as the paper type. 
• Do not use padded envelopes. Use envelopes that lie flat on a surface. 
• Do not use envelopes with heat activated glue. 
• Do not use envelopes with press and seal flaps. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=VersaLink+VLB405&PgName=order&Language=English
http://www.xerox.com/printer-supplies/recommended-paper/enus.html
http://www.xerox.com/rmleu
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Loading Envelopes in the Bypass Tray 
1. Open the bypass tray. 

 
2. Move the width guides to the edges of the tray. 

 
Note: If you do not load envelopes immediately after you remove them from the packaging, they 
can bulge. Flatten them to avoid jams. 
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3. To load envelopes, select an option: 
− For Number 10 envelopes, load the envelopes print side up, flaps down, with the short edge 

going into the printer. 

 
Note: When you load Monarch or DL envelopes, remove the Bypass Tray. For details, refer to 
Loading Small Paper Sizes in the Bypass Tray on page 150. 

 
− For C5 envelopes, do one of the following steps. 

• Insert envelopes with the print side up, flaps open and down, and the bottom of the 
envelope going into the printer. 
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• Insert envelopes with the print side up, flaps closed and down, and flaps going into 
the printer. 

 
Note: For envelopes to print correctly, when you load envelopes with the flaps open, in the print 
driver, select Portrait, Landscape, or Rotated Landscape, as needed. To flip the images, in the print 
driver, use Rotate Image 180 Degrees. 

4. If the control panel prompts you, verify the size, type, and color on the screen. If you are not 
prompted, change the paper settings. 
a. At the printer control panel, press the Home button. 
b. Touch Device > Paper Trays. 
c. In the Paper Trays menu, touch the bypass tray icon. 

• To select an envelope size, touch the current size setting, then select an envelope size. 
• To select a paper type, touch the current paper type, then select envelope. 
• To select an envelope color, touch the current paper color, then select a color. 

d. To save the settings, touch OK. 
5. To return to the Home screen, press the Home button. 
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Adjusting the Fuser for Printing Envelopes 

The Fuser has two switches that require adjustment to enable printing on Envelopes. If the switches are 
not set to the correct position for Envelope printing, image quality issues and poor fusing can occur. 

To adjust the Fuser to enable printing on Envelopes: 
1. On the back of the printer, lift the door release latch, then pull open the door. 

 
2. To open the Fuser, lift both green fuser levers to their full-upright position. 

 
3. Locate the two gray Fuser switches, then slide each one to the setting for envelopes. 
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4. Lower the green levers to their original position. 

 
5. Close the rear door. 

 
6. Print your document. 
7. When printing completes, to print all other paper types, repeat these steps to return the gray 

switches back to the paper setting. 
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Labels 

You can print labels from any tray. 
 

Guidelines for Printing Labels 
• Use labels designed for laser printing. 
• Do not use vinyl labels. 
• Do not feed a sheet of labels through the printer more than once. 
• Do not use dry gum labels. 
• Print only on one side of the sheet of labels. Use full sheet labels only. 
• Store unused labels flat in their original packaging. Leave the sheets of labels inside the original 

packaging until ready to use. Return any unused sheets of labels to the original packaging and 
reseal it. 

• Do not store labels in extremely dry or humid conditions or extremely hot or cold conditions. Storing 
them in extreme conditions can cause print-quality problems or cause them to jam in the printer. 

• Rotate stock frequently. Long periods of storage in extreme conditions can cause labels to curl and 
jam in the printer. 

• In the print driver software, select Label as the paper type. 
• Before loading labels, remove all other paper from the tray. 
 

 CAUTION: Do not use any sheet where labels are missing, curled, or pulled away from the 
backing sheet. It could damage the printer. 

 
 

Loading Labels in Trays 1-4 
1. To remove the tray, lift the front of it slightly, then pull it out of the printer. 
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2. Adjust the paper length and width guides as shown. 

 
3. Load labels into the tray with the label side face up. 

Note: Do not load paper above the maximum fill line. Overfilling the tray can cause paper jams. 

 
4. Adjust the length and width guides to fit the paper. 
5. Slide the tray back into the printer. 
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6. Push the tray completely back into the printer. 

Note:  

• If the tray does not go in all the way, ensure that the paper lift plate at the back of the tray is 
locked down. 

• If the tray is extended for legal-size paper, the tray protrudes when it is inserted into 
the printer. 

7. If the control panel prompts you, verify the size, type, and color on the screen. If you are not 
prompted, change the paper settings. 
a. At the printer control panel, press the Home button. 
b. Touch Device > Paper Trays. 
c. In the Paper Trays menu, touch the desired tray. 
d. To configure the printer to prompt you to set the paper type and size when paper is loaded, 

touch Tray Mode, then touch Fully Adjustable. 
e. To dedicate the tray for a paper size, type, or color, touch Tray Mode, then touch Dedicated. 

• To select a paper or envelope size, touch the current size setting, then select a size. 
• To select a paper type, touch the current paper type, then select Labels. 
• To select a paper color, touch the current paper color, then select a paper color. 

f. To save the settings, touch OK. 
8. To return to the Home screen, press the Home button. 
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Loading Labels in Tray 1 and the Bypass Tray 
1. Remove all paper from the bypass tray. 

 
2. Load Labels in the bypass tray, face up, with the top edge of the page going into the printer first. 
3. Adjust the width guides until they touch the edges of the paper. 

 
4. If the control panel prompts you, verify the size, type and color on the screen. If you are not 

prompted, change the paper settings. 
a. At the printer control panel, press the Home button. 
b. Touch Device > Paper Trays. 
c. In the Paper Trays menu, touch the bypass tray icon. 

• To select a paper size, touch the current size setting, then select a size. 
• To select a paper type, touch the current paper type, then select labels. 
• To select a paper color, touch the current paper color, then select a paper color. 

d. To save the settings, touch OK. 
5. To return to the Home screen, press the Home button. 
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General Precautions 
 

 CAUTION: Do not expose the drum cartridge to direct sunlight or strong indoor fluorescent 
lighting. Do not touch or scratch the surface of the drum. 

  

 CAUTION: When cleaning your printer do not use organic or strong chemical solvents or 
aerosol cleaners. Do not pour fluids directly into any area. Use supplies and cleaning materials 
only as directed in this documentation. 

  

 WARNING: Keep all cleaning materials out of the reach of children. 
  

 WARNING: Do not use pressurized spray cleaning aids on or in the printer. Some pressurized 
sprays contain explosive mixtures and are not suitable for use in electrical applications. Use of 
pressurized spray cleaners increases the risk of fire and explosion. 

  

 WARNING: Do not remove the covers or guards that are fastened with screws. You cannot 
maintain or service any parts that are behind these covers and guards. Do not attempt any 
maintenance procedure that is not described in the documentation supplied with your printer. 

  

 WARNING: Internal parts of the printer can be hot. Use caution when doors and covers  
are open. 

 

• Do not place anything on top of the printer. 
• Do not leave the covers and doors open for any length of time, especially in well-lit places. 

Light exposure can damage the drum cartridge. 
• Do not open covers and doors during printing. 
• Do not tilt the printer while it is in use. 
• Do not touch the electrical contacts or gears. Doing so could damage the printer and cause 

the print quality to deteriorate. 
• Ensure any parts removed during cleaning are replaced before you plug in the printer. 
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Cleaning the Printer 

This section includes: 
• Cleaning the Exterior of the Printer ........................................................................................................................ 167 
• Cleaning the Interior .................................................................................................................................................... 169 
 
 

Cleaning the Exterior of the Printer 

Clean the exterior of the printer once a month. 
• Wipe the paper tray, output tray, control panel, and other parts with a damp, soft cloth. 
• After cleaning, wipe with a dry, soft cloth. 
• For stubborn stains, apply a small amount of mild detergent to the cloth and gently wipe the 

stain off. 
 

Cleaning the Scanner 

To ensure optimum print quality, clean the document glass regularly. Cleaning helps avoid output with 
streaks, smears, and other marks that transfer from the glass while scanning documents. 
1. Slightly dampen a soft, lint-free cloth with water. 
2. Remove any paper or other media from the output tray. 
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3. Open the document cover. 

 
4. Wipe the surfaces of the document glass until they are clean and dry. 

Note: For best results, use Xerox® Glass Cleaner to remove marks and streaks. 
 

   
 

5. Wipe the white underside of the document cover until it is clean and dry. 

 
6. Close the document cover. 
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Cleaning the Document Feeder Rollers 

Ensure that the Document Feeders are cleaned when you clean the scanner. 
1. Open the document feeder cover. 

 
2. With a clean, lint-free cloth that is moistened with water, wipe the feed rollers and the separation 

pad until they are clean. 

 
3. Close the document feeder cover. 
 

Cleaning the Interior 

Clean the interior of the printer regularly to prevent stains inside the printer that can deteriorate print 
quality. Clean the printer interior whenever you replace a drum cartridge. 

After clearing paper jams or replacing a toner cartridge, inspect inside the printer before closing the 
printer covers and doors. 
• Remove any remaining pieces of paper or debris. For details, refer to Clearing Paper Jams on page 

190. 
• Remove any dust or stains with a clean, dry, lint-free cloth. 
 

 WARNING: Never touch a labeled area on or near the heat roller in the fuser. You can get 
burned. If a sheet of paper is wrapped around the heat roller, do not try to remove it 
immediately. Power off the printer immediately and wait 40 minutes for the fuser to cool. Try 
to remove the paper jam after the printer has cooled. 
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Adjustments and Maintenance Procedures 

This section includes: 
• Adjusting Paper Registration ..................................................................................................................................... 170 
 
 

Adjusting Paper Registration 

Use Adjust Paper Registration to adjust the placement of the printed image on the page. The 
adjustment allows you to place the top, bottom, left, and right margins exactly where you want. You can 
specify the image position on both the front and back sides of the paper, for each installed paper tray. 
 

Verifying Paper Registration 
1. At the printer control panel, press the Home button. 
2. Log in as administrator. For details, refer to For details, refer to the System Administrator Guide at 

www.xerox.com/office/VLB405docs . 
3. Touch Device > Support > Image Position. 
4. Select the source paper tray for the registration print. 

a. Touch Paper Supply. 
b. Touch the desired tray. 

5. If your printer has automatic 2-sided printing, select the sides that you want to optimize. 
− To select a sample registration page for adjusting side 1, touch Adjusted Side, then touch Side 

1. 
− To select a sample registration page for adjusting both sides, touch Adjusted Side, then touch 

Side 2. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLB405&PgName=Man&Language=English
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6. Specify the consecutive number of sample pages to print. 
a. Touch Print Settings. 
b. To increase or decrease the number of sample pages, for Quantity, touch Plus (+) or Minus (-), 

then touch OK. 
7. To print the sample pages, touch Print Sample. 
8. When printing is completed, touch Close. 
9. On the sample pages, for Side 1, use a ruler to measure the distance of the printed image from the 

top, bottom, left, and right edges. 

Note: For identification, a single dot is printed on Side 1, and two dots are printed on Side 2. 

 
10. For Side 2, measure the distance of the printed image from the top, bottom, left, and right edges. 
11. If the image is centered, no adjustment is required. If not centered, adjust the paper registration. 

For details, refer to Performing a Paper Registration Adjustment. 
 

Performing a Paper Registration Adjustment 
1. At the printer control panel, press the Home button. 
2. Log in as administrator. For details, refer to the System Administrator Guide at 

www.xerox.com/office/VLB405docs. 
3. Touch Device > Support > Image Position. 
4. To adjust registration, select the source paper tray. 

a. Touch Paper Supply. 
b. Touch the desired tray. 

5. Using the chart printed in Verifying Paper Registration, select the side for registration. 
a. For adjusting Side 1, touch Adjusted Side, then touch Side 1. 
b. For adjusting Side 2, touch Adjusted Side, then touch Side 2. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLB405&PgName=Man&Language=English
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6. To adjust the registration, touch Lead/Side Registration. 
a. To adjust the side-to-side registration, for Side Registration, touch Plus (+) or Minus (-). 
b. To adjust the top-to-bottom registration, for Lead Registration, touch Plus (+) or Minus (-). 

For reference, position the chart so that Side-1 or Side-2 dots are at the bottom of the page. 
• For Lead Registration, a positive value shifts the image down the page. 
• For Side Registration, a positive value shifts the image to the left. 

 
7. To save your settings, touch OK. 
8. As needed, repeat steps 4 through 6 to enter additional values. 
9. Print another sample page, then repeat the process until you complete the registration corrections. 
10. To return to the Home screen, press the Home button. 
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Supplies 

This section includes: 
• Consumables ................................................................................................................................................................... 173 
• Routine Maintenance Items ...................................................................................................................................... 173 
• Ordering Supplies ........................................................................................................................................................... 174 
• Toner Cartridges ............................................................................................................................................................. 176 
• Recycling Supplies .......................................................................................................................................................... 177 
 
 

Consumables 

Consumables are printer supplies that get depleted during the operation of the printer. The consumable 
supply for this printer is the genuine Xerox® Black Toner Cartridge. 
 

Notes: 

• Each consumable includes installation instructions. 
• Install only new cartridges in your printer. If a used toner cartridge is installed, then the toner 

remaining amount displayed could be inaccurate. 
• To ensure print quality, the toner cartridge has been designed to cease functioning at a 

predetermined point. 
 

 CAUTION: Use of toner other than genuine Xerox® Toner can affect print quality and printer 
reliability. Xerox® Toner is the only toner designed and manufactured under strict quality 
controls by Xerox for specific use with this printer. 

 
 

Routine Maintenance Items 

Routine maintenance items are printer parts that have a limited life and require periodic replacement. 
Replacements can be parts or kits. Routine maintenance items are typically customer replaceable. 
 

Note: Each routine maintenance item includes installation instructions. 
 

Routine maintenance items for this printer include the following: 
• Drum Cartridge 
• Maintenance Kit, which includes a Fuser and Transfer Roller 
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Ordering Supplies 

When to Order Supplies 

A warning appears on the control panel when supplies near their replacement time. Verify that you have 
replacements on hand. It is important to order these items when the messages first appear to avoid 
interruptions to your printing. An error message appears on the control panel when supplies must 
be replaced. 

Order supplies from your local reseller or go to www.xerox.com/office/VLB405supplies . 
 

 CAUTION: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service 
Agreement, and Total Satisfaction Guarantee do not cover damage, malfunction, or 
degradation of performance caused by use of non-Xerox supplies, or the use of Xerox supplies 
not specified for this printer. The Total Satisfaction Guarantee is available in the United 
States and Canada. Coverage could vary outside these areas. Please contact your Xerox 
representative for details. 

 
 

Supply Status 

You can check the status and percentage of life remaining for your printer supplies at the control panel 
or from the Embedded Web Server. When printer supplies near their replacement time, warning alerts 
appear on the control panel. You can customize the alerts that appear on the control panel and 
configure email alert notifications. 

To check the supplies status at the control panel: 
1. To view status information for the printer supplies, touch Device > Supplies. 
2. To view details about a specific item, including its part number for reordering, touch the desired 

item. 
3. To return to the Supplies screen, touch X. 
4. To return to the Device screen, touch the back arrow. 

To customize supplies alert settings: 
1. To customize the alerts that appear for printer supplies, touch Device > Supplies > Alerts Setup. 
2. To enable supplies alerts, touch the Enable Alerts toggle button. 
3. To configure the printer to display an alert when an item reaches a specific usage percentage level, 

touch the item, then select the percentage. 
4. To customize the alerts for each supply item, to enable or disable an alert, touch the toggle button. 
5. To return to the Supplies screen, touch X. 
6. To return to the Device screen, touch the back arrow. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=VersaLink+VLB405&PgName=order&Language=English
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To set up email alerts: 
1. To set up alerts to send to an email address, touch Device > Supplies > Email Alerts. 
2. To enter an email address, touch Add Email, then touch Enter Email Address. 
3. Use the touch screen keyboard to enter an email address, or select an entry from the Address Book, 

then touch OK. 
4. Add more email addresses if necessary. 
5. To customize the alerts for each supply item, to enable or disable an alert, touch the toggle button. 
6. To exit the menu, touch OK. 
7. To return to the Device screen, touch the back arrow. 

To check the supplies status and set up alerts using the Embedded Web Server, refer to the System 
Administrator Guide at www.xerox.com/office/VLB405docs. 
 

Supplies Usage Report 

The Supplies Usage Report provides coverage information and part numbers for reordering supplies. The 
date a supply item was installed also appears on the report. 

To print the Supplies Usage Report: 
1. At the printer control panel, press the Home button. 
2. Touch Device > About > Information Pages. 
3. Touch Supplies Usage Report. 
4. To return to the Home screen, press the Home button. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLB405&PgName=Man&Language=English
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Toner Cartridges 

This section includes: 
• General Precautions ...................................................................................................................................................... 176 
• Replacing a Toner Cartridge ...................................................................................................................................... 176 
 
 

General Precautions 
 

 WARNINGS:  

• When replacing a toner cartridge, be careful not to spill the toner. If any toner spills, 
avoid contact with clothes, skin, eyes, and mouth. Do not inhale the toner dust. 

• Keep toner cartridges out of the reach of children. If a child accidentally swallows toner, 
have the child spit out the toner, and rinse out their mouth with water. Consult a 
physician immediately. 

• Use a damp cloth to wipe off spilled toner. Never use a vacuum cleaner to remove spills. 
Electric sparks inside the vacuum cleaner can cause a fire or explosion. If you spill a 
large volume of toner, contact your local Xerox representative. 

• Never throw a toner cartridge into an open flame. Remaining toner in the cartridge can 
catch fire and cause burn injuries or an explosion. 

 

 WARNING: Do not remove the covers or guards that are fastened with screws. You cannot 
maintain or service any parts that are behind these covers and guards. Do not attempt any 
maintenance procedure that is not described in the documentation supplied with your printer. 

 

• Do not open covers and doors during printing. 
• Do not leave the covers and doors open for any length of time, especially in well-lit places. 

Light exposure can damage the drum cartridge. 
• Do not place anything on top of the printer. 
• Do not tilt the printer while it is in use. 
• Do not touch the electrical contacts or gears. Doing so could damage the printer and cause 

the print quality to deteriorate. 
• Ensure any parts removed during cleaning are replaced before you plug in the printer. 
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Replacing a Toner Cartridge 

A message appears on the control panel when a toner cartridge must be replaced. 

Note: Each toner cartridge includes installation instructions. 
 

Printer Status Message Cause and Solution 

Reorder Toner The toner cartridge is low. Order a new toner cartridge. 

Out of Toner The toner cartridge is empty. Replace the toner cartridge 
with a new one. 

  
 

Recycling Supplies 

For more information on the Xerox® supplies recycling program, go to: www.xerox.com/gwa. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=VersaLink+VLB405&PgName=recyclesupplies&Language=English
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Managing the Printer 

This section includes: 
• Viewing the Meter Reading........................................................................................................................................ 178 
• Printing the Billing Summary Report ...................................................................................................................... 178 
 
 

Viewing the Meter Reading 

The Billing/Usage menu displays the total number of impressions that the printer generated or printed 
during its lifetime. You cannot reset the counters. A page is counted as one side of a sheet of paper. For 
example, a sheet of paper that is printed on two sides counts as two impressions. 

Note: If you provide regular billing information for your device, you can use the Remote Services Upload 
feature to simplify the process. You can enable Remote Services to send billing meter readings to Xerox 
automatically so that you do not have to collect the readings manually. Refer to the System 
Administrator Guide for further information. 

To view the billing information for your printer: 
1. At the printer control panel, press the Home button. 
2. Touch Device > Billing/Usage. 
3. To view more details, touch Usage Counters and select an option. 
4. After viewing the usage readings, to return to the Home screen, press the Home button. 
 

Printing the Billing Summary Report 

The Billing Summary Report provides information about the device and a detailed listing of the billing 
meters and sheet counts. 

To print the Billing Summary Report: 
1. At the printer control panel, press the Home button. 
2. Touch Device > About > Information Pages. 
3. Touch Billing Summary Report. 
4. To return to the Home screen, press the Home button. 
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Moving the Printer 
 

 WARNINGS:  

• To lift the printer, always use at least two people to grasp the hand holds on each side of 
the printer. 

• To prevent you from dropping the printer or injury, lift the printer firmly by gripping the 
recessed areas on both sides of the printer. Never lift the printer by gripping any other areas. 

• If optional 550-Sheet Feeders are installed, uninstall them before you move the printer. If 
the optional 550-Sheet Feeders are not fixed to the printer securely, they can fall to the 
ground and cause injury. 

 

Follow these instructions when moving the printer: 
1. Power off the printer, then disconnect the power cord and other cables from the back of the printer. 

 WARNING: To prevent electric shock, never touch the power plug with wet hands. When 
removing the power cord, ensure that you pull the plug and not the cord. Pulling the cord can 
damage it, which can lead to fire or electric shock. 

 

2. Remove any paper or other media from the output tray. If the output tray extension is open, 
close it. 
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3. Remove the paper from the paper tray. 
4. Keep the paper wrapped and away from humidity and dirt. 

 
5. Lift and carry the printer as shown in the illustration. 

 
Notes: 

• When moving the printer, do not tilt it more than 10 degrees in any direction. Tilting the printer 
more than 10 degrees can cause toner spillage. 

• When moving the printer over a long distance, remove the drum cartridge and toner cartridge 
to prevent toner from spilling. 

 

 CAUTION: Failure to repackage the printer properly for shipment can result in damage not 
covered by the Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee. The 
Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee do not cover damage to 
the printer caused by improper moving. 

 

After moving the printer: 
1. Reinstall any parts that you removed. 
2. Reconnect the printer to the cables and power cord. 
3. Plug in and power on the printer. 
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General Troubleshooting 

This section includes: 
• Printer Does Not Power On ......................................................................................................................................... 182 
• Printer Resets or Powers Off Frequently ................................................................................................................ 183 
• Printer Does Not Print ................................................................................................................................................... 183 
• Printing Takes Too Long .............................................................................................................................................. 184 
• Document Prints From Wrong Tray ........................................................................................................................ 185 
• Automatic 2-Sided Printing Problems .................................................................................................................... 185 
• Printer is Making Unusual Noises ............................................................................................................................. 185 
• Paper Tray Will Not Close ........................................................................................................................................... 185 
• Condensation has Formed Inside the Printer ...................................................................................................... 186 

This section contains procedures to help you locate and resolve problems. Resolve some problems by 
simply restarting the printer. 
 
 

Printer Does Not Power On 
 

Probable Causes Solutions 

The power switch is not turned on. At the printer control panel, press the Power/Wake button. For 
details, refer to Powering On and Off the Printer on page 28. 

The power cord is not plugged into the outlet 
correctly. 

Power off the printer, and plug the power cord securely into the 
outlet. 

The printer requires a full reset. Power off the printer, then unplug the power cord and wait 30 
seconds. Plug the power cord into the outlet securely, then press 
the Power/Wake button. 

Something is wrong with the outlet 
connected to the printer. 

• Plug another electrical appliance into the outlet and check if 
it operates properly. 

• Try a different outlet. 

The printer is connected to an outlet with a 
voltage or frequency that does not match the 
printer specifications. 

Use a power source with the specifications listed in the Electrical 
Specifications on page 222. 

 

 CAUTION: Plug the three-wire cord with grounding prong directly into a grounded AC outlet. 
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Printer Resets or Powers Off Frequently 
 

Probable Causes Solutions 

The power cord is not plugged into the outlet 
correctly. 

Power off the printer, confirm that the power cord is plugged in 
correctly to the printer and the outlet, then power on the printer. 

A system error occurred. Power off the printer, then power on again. Print the Error History 
Report. For details, refer to Printing the Error History Report on 
page 214. If the error persists, contact your Xerox representative. 

The printer is connected to an uninterruptible 
power supply. 

Power off the printer, then connect the power cord to a suitable 
outlet. 

The printer is connected to a power strip 
shared with other high-power devices. 

Plug the printer directly into the outlet or into a power strip that is 
not shared with other devices. 

The Auto Power Off feature is enabled to 
save power. 

Increase the Auto Power Off timer setting or disable the Auto 
Power Off feature. For details, refer to the System Administrator 
Guide at www.xerox.com/office/VLB405docs . 

 
 

Printer Does Not Print 
 

Probable Causes Solutions 

The printer is in Power Saver mode. On the control panel, press the Power/Wake button. 

The printer has an error. If the Status LED is blinking amber, follow the instructions on the 
control panel to clear the error. If the error persists, contact your 
Xerox representative. 

The printer is out of paper. Load paper into the tray. 

The incorrect paper is loaded for the print job. Load the correct paper in the appropriate tray. On the printer 
control panel, specify the correct paper size, type and color. 

The paper settings for the print job do not 
match any paper loaded in the paper trays at 
the printer. 

From the print driver, select a paper tray containing the correct 
paper. 

A toner cartridge is empty. Replace the empty toner cartridge. 

No control panel indicators are lit. Power off the printer, confirm that the power cord is plugged in 
correctly to the printer and the outlet, then power on the printer. If 
the error persists, contact your Xerox representative. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLB405&PgName=Man&Language=English
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Probable Causes Solutions 

The printer is busy. • If the Status LED is flashing blue, a previous print job could be 
the problem. 
a. At your computer, use the printer properties to delete all print 

jobs in the print queue. 
b. At the control panel, touch Jobs, then delete all pending 

print jobs. 
• Load the paper in the tray. 
• If the Status LED does not flash once after you send a print job, 

check the connection between the printer and the computer. 
Power off the printer, then power on. 

The printer cable is disconnected. If the Status LED does not flash once after you send a print job, 
check the connection between the printer and the computer. 

There is a network-connectivity issue. If the printer is connected to a network:  
a. Verify that the Ethernet cable is connected to the printer. 
b. On the printer Ethernet connector, verify that the green LED 

is On. If not, reseat both ends of the Ethernet cable. 
c. Examine the TCP/IP address in the Communication section 

of the Configuration Report. For details, refer to Printing the 
Configuration Report on page 33. 

d. If the TCP/IP address is 0.0.0.0, the printer needs more time 
to acquire an IP address from the DHCP server. Wait 2 
minutes, then print the Configuration Report again. 

e. If the TCP/IP address is unchanged, or begins with 169, 
contact your network administrator. 

There is a wireless network setup or 
connectivity issue. 

Verify that the Wireless Network Adapter is installed and properly 
configured. For details, refer to Connecting to a Wireless Network on 
page 37. 

 
 

Printing Takes Too Long 
  

Probable Causes Solutions 

The printer is set to a slower printing mode. 
For example, the printer could be set to print 
on Heavyweight paper. 

It takes more time to print on certain types of special paper. Ensure 
that the paper type is set properly in the driver and at the printer 
control panel. For details, refer to Print Speed on page 224. 

The printer is in Power Saver mode. It takes time for printing to start when the printer is coming out of 
Power Saver mode. 

The way the printer was installed on the 
network could be an issue. 

Determine if a print spooler or a computer sharing the printer is 
buffering all print jobs and then spooling them to the printer. 
Spooling can slow print speeds. To test the speed of the printer, 
print some information pages such as the Demonstration Print. For 
details, refer to Information Pages on page 32. If the page prints at 
the rated speed of the printer, there could be a network or printer 
installation issue. For more help, contact the system administrator. 

The job is complex. Wait. No action needed. 

The print-quality mode in the driver is set to 
Enhanced. 

Change the print-quality mode in the print driver to Standard. 
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Document Prints From Wrong Tray 
 

Probable Causes Solutions 

Application and print driver have conflicting 
tray selections. 

1. Check the tray selected in the print driver. 
2. Go to the page setup or printer settings of the application from 

which you are printing. 
3. Set the paper source to match the tray selected in the print 

driver or set the paper source to Automatically Select. 
 

Note: To have the print driver select the tray, set the tray used as 
the paper source to Auto Selection Enabled. 

 

  
 

Automatic 2-Sided Printing Problems 
 

Probable Causes Solutions 

Unsupported or incorrect paper. Ensure that you are using a supported paper size and weight for 
2-sided printing. Envelopes, cardstock, and labels cannot be used for 
2-sided printing. For details, refer to Supported Standard Types and 
Weights for Automatic 2-Sided Printing on page 143. 

Your printer model is not configured with 
automatic 2-sided printing. 

Ensure that your printer supports automatic 2-sided printing. For 
details, refer to Printer Configurations and Options on page 216. 

Incorrect setting. In the print driver Printing Options tab, select 2-Sided Print. 
 
 

Printer is Making Unusual Noises 
 

Probable Causes Solutions 

There is an obstruction or debris inside the 
printer. 

Power off the printer and remove the obstruction or debris. If you 
cannot remove it, contact your Xerox representative. 

 
 

Paper Tray Will Not Close 
 

Probable Causes Solutions 

The paper tray does not fully close. • If the tray is extended for legal-size paper, the tray protrudes 
when it is inserted into the printer. For details, refer to 
Configuring Trays 1 or 2 for the Paper Length on page 153. 

• Some debris or an object is blocking the tray. 
• The tray is hanging up on the table or shelf on which it is 

located. 
• At the back of the paper tray, push the paper lift down until it 

clicks into place. Insert the tray into the printer. If the paper lift 
does not click into place correctly, replace the paper tray. 
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Condensation has Formed Inside the Printer 

Moisture can condense inside a printer where the humidity is above 85% or when a cold printer is 
located in a warm room. Condensation can form in a printer after it has been sitting in a cold room that 
is heated quickly. 
 

Probable Causes Solutions 

The printer has been sitting in a cold room. Allow the printer to operate for several hours at room temperature. 

The relative humidity of the room is too high. • Reduce the humidity in the room. 
• Move the printer to a location where the temperature and 

relative humidity are within the operating specifications. 
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Paper Jams 

This section includes: 
• Locating Paper Jams ..................................................................................................................................................... 187 
• Minimizing Paper Jams ................................................................................................................................................ 188 
• Clearing Paper Jams...................................................................................................................................................... 190 
• Troubleshooting Paper Jams ..................................................................................................................................... 201 
 
 

Locating Paper Jams 
 

 WARNING: Never touch a labeled area on or near the heat roller in the fuser. You can get 
burned. If a sheet of paper is wrapped around the heat roller, do not try to remove it 
immediately. Power off the printer immediately and wait 40 minutes for the fuser to cool. Try 
to remove the jam after the printer has cooled. If the error persists, contact your Xerox 
representative. 

  

 CAUTION: Do not attempt to clear any paper jams using tools or instruments. This can 
permanently damage the printer. 
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The following illustration shows where paper jams can occur along the paper path: 

 
1. Trays 2, 3 and 4 - Optional 
2. Duplex Automatic Document Feeder 
3. Fuser 
4. Bypass Tray 
5. Tray 1 
 

Minimizing Paper Jams 

The printer is designed to function with minimal paper jams using Xerox supported paper. Other paper 
types can cause jams. If supported paper is jamming frequently in one area, clean that area of the 
paper path. 

The following can cause paper jams: 
• Selecting the incorrect paper type in the print driver. 
• Using damaged paper. 
• Using unsupported paper. 
• Loading paper incorrectly. 
• Overfilling the tray. 
• Adjusting the paper guides improperly. 
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Most jams can be prevented by following a simple set of rules: 
• Use only supported paper. 
• Follow proper paper handling and loading techniques. 
• Always use clean, undamaged paper. 
• Avoid paper that is curled, torn, moist, creased, or folded. 
• To separate the sheets before loading into the tray, fan the paper. 
• Observe the paper tray fill line; never overfill the tray. 
• Adjust the paper guides in all trays after inserting the paper. A guide that is not properly adjusted 

can cause poor print quality, misfeeds, skewed prints, and printer damage. 
• After loading the tray, at the control panel, select the correct paper type and size. 
• When printing, select the correct type and size in the print driver. 
• Store paper in a dry location. 

Avoid the following: 
• Polyester coated paper that is designed especially for inkjet printers. 
• Paper that is folded, wrinkled, or excessively curled. 
• Loading more than one type, size, or weight of paper in a tray at the same time. 
• Overfilling the tray. 
• Allowing the output tray to overfill. 

For a detailed list of supported paper, refer to Supported Paper on page 140. 
 



Troubleshooting 

 

190 Xerox® VersaLink® B405 Multifunction Printer 
 User Guide 
 

Clearing Paper Jams 

This section includes: 
• Clearing Document Feeder Jams ............................................................................................................................. 190 
• Clearing Paper Jams from the Bypass Tray ......................................................................................................... 191 
• Clearing Paper Jams from the Tray 1 Area .......................................................................................................... 194 
• Clearing Paper Jams from Tray 2, 3 and 4 Areas ............................................................................................... 196 
• Clearing Paper Jams from the Fuser Area ............................................................................................................ 198 
 
 

Clearing Document Feeder Jams 

To resolve the error that appears on the control panel, clear all paper from the document feeder areas. 
1. Open the Top Cover, then remove any paper. 

 
2. If paper is jammed in the Duplex Automatic Document Feeder, open the Document Cover, then 

remove any jammed paper. 
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3. Close the Document Cover, then reload the document in the Duplex Automatic Document Feeder. 

 

To prevent paper jams: 
• Do not load original documents above the MAX fill line. 
• Adjust the paper guides so that they fit against the paper. 
• Use supported paper only. For details, refer to Duplex Automatic Document Feeder Guidelines on 

page 23. 
 

Clearing Paper Jams from the Bypass Tray 

To resolve the error that appears on the control panel, clear all paper from the paper path. 
1. Remove any paper from the Bypass Tray. 
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2. Grasp both sides of the Bypass Tray, then pull it straight out of the printer. 

 
3. Pull out Tray 1 until it stops. 

 
4. To remove the tray, lift the front of it slightly, then pull it out of the printer. 
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5. Remove the jammed paper. 

 
6. Insert Tray 1 into the printer, then push it all the way in. 

 
Note: If the tray is extended for legal-size paper, the tray protrudes when it is inserted into the 
printer. 

7. Insert the Bypass Tray completely into the printer. 

 
8. When paper trays are set to Fully Adjustable, you are prompted to verify or change the 

paper settings. 
− To confirm the same paper size, type, or color, touch OK. 
− To select a new paper size, type or color, touch the current setting, then select a new setting. 

When finished, touch OK. 
9. To return to the Home screen, press the Home button. 
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Clearing Paper Jams from the Tray 1 Area 

To resolve the error that appears on the control panel, clear all paper from the paper path. 
1. Remove any paper from the Bypass Tray. 

 
2. Grasp both sides of the Bypass Tray, then pull it straight out of the printer. 

 
3. Pull out Tray 1 until it stops. 
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4. To remove the tray, lift the front of it slightly, then pull it out of the printer. 

 
5. Remove any crumpled paper from the tray and any remaining paper jammed in the printer. 

 
6. Insert Tray 1 into the printer, then push it in all the way. 
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Note: If the tray is extended for legal-size paper, the tray protrudes when it is inserted into 
the printer. 

7. Insert the Bypass Tray completely into the printer. 

 
8. When paper trays are set to Fully Adjustable, you are prompted to verify or change the paper 

settings. 
− To confirm the same paper size, type, or color, touch OK. 
− To select a new paper size, type or color, touch the current setting, then select a new setting. 

When finished, touch OK. 
9. To return to the Home screen, press the Home button. 
 

Clearing Paper Jams from Tray 2, 3 and 4 Areas 

To resolve the error that appears on the control panel, clear all paper from the paper path. 
1. Pull out Tray 2, 3, or 4 until it stops. 
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2. To remove the tray, lift the front of it slightly, then pull it out of the printer. 

 
3. Remove any crumpled paper from the tray and any remaining paper jammed at the front of the 

printer. 

 
4. At the back of the printer, open the Tray 2 Door, then remove any paper jammed at the back of the 

printer. 
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5. Insert the tray into the printer, then push it in all the way in. 

Note: If the tray is extended for legal-size paper, the tray protrudes when it is inserted into 
the printer. 

 
6. When paper trays are set to Fully Adjustable, you are prompted to verify or change the paper 

settings. 
− To confirm the same paper size, type, or color, touch OK. 
− To select a new paper size, type or color, touch the current setting, select a new setting, then 

touch OK. 
7. To return to the Home screen, press the Home button. 
 

Clearing Paper Jams from the Fuser Area 

To resolve the error that appears on the control panel, clear all paper from the paper path. 
1. Lift the door release latch, then pull open the door. 
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2. If paper is jammed in the Fuser, raise both green levers to open the Fuser. 

 
3. To open the paper guide, raise the green handle. 

 
4. Remove any jammed paper from the Fuser area. 

 
5. Close the paper guide on the Fuser. 
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6. Lower the green levers to their original position. 

 
7. Remove any jammed paper from the back of the printer. 

 
8. Close the rear door. 
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Troubleshooting Paper Jams 

This section includes: 
• Multiple Sheets Pulled Together .............................................................................................................................. 201 
• Paper Misfeeds ................................................................................................................................................................ 201 
• Label and Envelope Misfeeds .................................................................................................................................... 202 
• Paper Jam Message Stays On ................................................................................................................................... 202 
• Jams During Automatic 2-Sided Printing .............................................................................................................. 203 
 
 

Multiple Sheets Pulled Together 
 

Probable Causes Solutions 

The paper tray is too full. Remove some of the paper. Do not load paper past fill line. 

The edges of the paper are not even. Remove the paper, align the edges, and then reload it. 

The paper is moist from humidity. Remove the paper from the tray, and replace it with new dry 
paper. 

Too much static electricity is present. Try a new ream of paper. 

Using unsupported paper. Use only Xerox®-approved paper. For details, refer to Supported 
Paper on page 140. 

Humidity is too high for coated paper. • Feed paper one sheet at a time. 
• Try loading paper in the Bypass tray. 

The feed rollers are dirty. With a clean, lint-free cloth moistened with water, wipe the feed 
rollers until they are clean. For details, refer to Cleaning the 
Printer on page 167. 
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Paper Misfeeds 
 

Probable Causes Solutions 

The paper is not correctly positioned in the 
tray. 

• Remove the misfed paper and reposition it properly in the 
tray. 

• Adjust the paper guides in the tray to match the size of the 
paper. 

The paper tray is too full. Remove some of the paper. Do not load paper past the fill line. 

The paper guides are not correctly adjusted 
to the paper size. 

Adjust the paper guides in the tray to match the size of the 
paper. 

The tray contains warped or wrinkled paper. Remove the paper, smooth it out, and reload it. If it still 
misfeeds, do not use that paper. 

The paper is moist from humidity. Remove the moist paper and replace it with new, dry paper. 

Using paper of the wrong size, thickness,  
or type. 

Use only Xerox approved paper. For details, refer to Supported 
Paper on page 140. 

The feed rollers are dirty. With a clean, lint-free cloth moistened with water, wipe the feed 
rollers until they are clean. For details, refer to Cleaning the 
Printer on page 167. 

 
 

Label and Envelope Misfeeds 
 

Probable Causes Solutions 

The label sheet is facing the wrong way in the 
tray. 

• Load label sheets according to the instructions from the 
manufacturer. 

• Load labels in the tray, face up. 
For details, refer to Labels on page 160. 

Labels are missing, curled, or pulled away 
from the backing sheet. 

Do not use any sheet where labels are missing, curled, or pulled 
away from the backing sheet. 

Envelopes are loaded incorrectly. You can print envelopes from the Bypass tray or Tray 1. 
For details, refer to Envelopes on page 155. 

Envelopes are wrinkling. • The heat and pressure of the laser printing process can 
cause wrinkling. 

• Use supported envelopes. For details, refer to Guidelines for 
Printing Envelopes on page 155. 

Note: When you load envelopes long-edge feed, ensure that you 
specify landscape orientation in the print driver. 
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Paper Jam Message Stays On 
 

Probable Causes Solutions 

Some paper remains jammed in the printer. Recheck the media path and make sure that you have removed 
all of the jammed paper. 

One of the printer doors is open. Check the doors on the printer. Close any door that is open. 
  

Note: Check for, and remove, torn pieces of paper in the paper path. 
 
 

Jams During Automatic 2-Sided Printing 
 

Probable Causes Solutions 

Using paper of the wrong size, thickness, or 
type. 

Use paper of the correct size, thickness, or type. For details, refer 
to Supported Paper Sizes for Automatic 2-Sided Printing on page 
143. 

Paper is loaded in the wrong tray. Ensure that paper is loaded into the correct tray. For details, refer 
to Supported Paper on page 140. 

Tray is loaded with mixed paper. Load the tray with only one type and size of paper. 
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Print-Quality Problems 

Your printer is designed to produce consistently high-quality prints. If you observe print-quality problems, 
use the information in this section to troubleshoot the problem. For more information, go to 
www.xerox.com/office/VLB405support. 
 

 CAUTION: The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee 
does not cover damage caused by using unsupported paper or specialty media. The Xerox 
Total Satisfaction Guarantee is available in the United States and Canada. Coverage could 
vary outside these areas. Please contact your local representative for details. 

 

Note: To ensure consistent print quality, the toner cartridges and imaging units for many models of 
equipment are designed to cease functioning at a predetermined point. 
 

Controlling Print-Quality 

Various factors can affect the quality of the output of your printer. For consistent and optimum print 
quality, use paper designed for your printer and set the paper type correctly. Follow the guidelines in this 
section to maintain optimum print quality from your printer. 

Temperature and humidity affect the quality of the printed output. The guaranteed range for optimal 
print quality is 15–28ºC (59–82ºF) and 20–70% relative humidity. 
 

Paper and Media 

Your printer is designed to use various paper and other media types. Follow the guidelines in this section 
for the best print quality and to avoid jams: 
• Use only Xerox approved paper. For details, refer to Supported Paper on page 140. 
• Use only dry, undamaged paper. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLB405&PgName=tech&Language=English
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 CAUTIONS: Some paper and other media types can cause poor output quality, increased paper 
jams, or damage your printer. Do not use the following: 

• Rough or porous paper 
• Inkjet paper 
• Non-laser glossy or coated paper 
• Paper that has been photocopied 
• Paper that has been folded or wrinkled 
• Paper with cutouts or perforations 
• Stapled paper 
• Envelopes with windows, metal clasps, side seams, or adhesives with release strips 
• Padded envelopes 
• Plastic media 
• Transparencies 

• Ensure the paper type selected in your print driver matches the paper type on which you are 
printing. 

• If you have the same size paper loaded in more than one tray, ensure that the proper tray is 
selected in the print driver. 

• Store your paper and other media properly for optimum print quality. For details, refer to Paper 
Storage Guidelines on page 141. 

 

Solving Print-Quality Problems 

When the print quality is poor, select the closest symptom from the following table and refer to the 
corresponding solution to correct the problem. You can also print a Demonstration Print page to more 
precisely determine the print-quality problem. For details, refer to Information Pages on page 32. 

If the print quality does not improve after performing the appropriate action, contact your Xerox 
representative. 

Note: To maintain print quality, the toner cartridge is designed to provide a warning message when 
the toner level is low. When the toner cartridge reaches this level, a warning message appears. 
When the toner cartridge is empty, another message prompts you to replace the toner cartridge. 
The printer stops printing until you install a new toner cartridge. 
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Symptom Solutions 

The output is too light. 

 

• To check the toner level, check the control panel, use the print driver, 
or the Embedded Web Server. If the toner cartridge is near empty, 
replace it. 

• Verify that the toner cartridge is approved for use in this printer, and 
replace it as needed. For best results, use a genuine Xerox toner 
cartridge. 

• Replace the paper with a recommended size and type, and confirm 
that your printer and print driver settings are correct. 

• Verify that the paper is dry and that supported paper is used. If not, 
change the paper. 

• Change the Paper Type settings in the print driver. In the print driver 
Printing Options tab, select Paper, then change the Other Type 
setting. 

Toner smears or print rubs off. 
The output has stains on the back 
side. 

 

• Change the Paper Type settings in the print driver. For example, 
change Plain to Lightweight Cardstock. In the print driver Printing 
Options tab, select Paper, then change the Other Type setting. 

• Verify that the paper is the correct size, type, and weight. If not, 
change the paper settings. 

• Verify that the printer is plugged into an outlet that is providing the 
correct voltage and power. Review the electrical specification of the 
printer with an electrician if necessary. For details, refer to Electrical 
Specifications on page 222. 

Random spots on the output, or the 
image is blurry. 

 

• Ensure that the toner cartridge is installed correctly. 
• If you used a non-genuine brand toner cartridge, install a genuine 

Xerox toner cartridge. 
• Use the Rough paper type setting, or try a paper with a smoother 

surface. 
• Ensure that the humidity in the room is within specifications. For 

details, see Relative Humidity on page 221. 

The output is blank. 

 

• Power off the printer, then power on again. 
• If the error persists, contact your Xerox representative. 
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Symptom Solutions 

Streaks appear in the output. 

 

• Replace the Drum Cartridge. 
• If the error persists, contact your Xerox representative. 

The output has a mottled 
appearance. 

 

• Verify that the paper is the correct size, type, and weight. If not, 
change the paper settings. 

• Ensure that the humidity in the room is within specifications. 
For details, refer to Relative Humidity on page 221. 

• Choose a different paper type at the control panel, in the application, 
and in the print driver. 

• Replace the paper. 

Ghosting appears in the printed 
output. 

 

• Verify that the paper is the correct size, type, and weight. If not, 
change the paper settings. 

• Change the Paper Type settings in the print driver. In the print driver 
Printing Options tab, select Paper, then change the Other Type 
setting. 

• Replace the Drum Cartridge. 

Auger marks appear on the printed 
output. 

 

• To check the toner level, check the control panel, use the print driver, 
or the Embedded Web Server. If the toner cartridge is near empty, 
replace it. 

• Verify that the toner cartridge is approved for use in this printer, and 
replace it as needed. For best results, use a genuine Xerox toner 
cartridge. 
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Symptom Solutions 

The output print is wrinkled or 
stained. 

 

• Verify that the paper is the correct size, type, and weight for the 
printer and that it is loaded properly. If not, change the paper. 

• Try a new ream of paper. 
• Change the Paper Type settings in the print driver. In the print driver 

Printing Options tab, select Paper, then change the Other Type 
setting. 

Envelopes are wrinkled or creased 
when printed. 

Check if the crease is within 30 mm (1.2 in.) of the four edges of the 
envelope. 
• If yes, it is printing as expected. Your printer is not faulty. 
• If not, take the following actions: 

Ensure that envelopes are loaded properly in the bypass tray. For 
details, see Loading Envelopes in the Bypass Tray on page 156. 
Follow the guidelines for printing on envelopes. For details, see 
Guidelines for Printing Envelopes on page 155. 
If the problem persists, use a different size envelope. 

The top margin is incorrect. 

 

• Ensure that the paper is loaded properly. 
• Ensure that the margins are set correctly in the application you are 

using. 
• Adjust the paper registration. For details, see Adjusting Paper 

.Registration on page 170. 

The printed surface of the paper is 
bumpy. 

 

1. Print a solid image over the entire surface of one sheet of paper. 
2. Load the printed sheet into the tray with the printed side face down. 
3. Print five blank pages to remove debris from the fuser rollers. 
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Symptom Solutions 

Spots or lines appear at regular 
intervals on the prints. 

 

1. Print the Repeating Defects pages. 
At the control panel, touch Device > Support > Support Pages > 
Repeating Defects. 

2. To determine the cause, measure the distance between the print 
defects. 

• 28 mm (1.1 in.) - Drum Cartridge 
• 53 mm (2.1 in.) - Drum Cartridge 
• 94 mm (3.7 in.) - Drum Cartridge 
• 49 mm (1.9 in.) - Transfer Roller 
• 80 mm (3.1 in.) - Fuser 
• 95 mm (3.7 in.) - Fuser 
3. If the repeating defects matches the Drum Cartridge distances, 

replace the Drum Cartridge. 
4. If the distance matches the Fuser or Transfer Roller, call for service or 

replace the Maintenance Kit. 
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Copy and Scan Problems 

To lighten, darken, or adjust contrast, use the Image Quality settings. 
 

Symptoms Solutions 

Lines or streaks present in copies only made 
from the document feeder. 

There is debris on the document glass. When scanning, the 
paper from the document feeder passes over the debris creating 
lines or streaks. Clean all glass surfaces with a lint-free cloth. 

Spots present in copies taken from the 
document glass. 

There is debris on the document glass. When scanning, the 
debris creates a spot on the image. Clean all glass surfaces with 
a lint-free cloth. 

The reverse side of the original is showing on 
the copy or scan. 

Turn on Background Suppression. 

Image is too light or too dark. To lighten, darken, or adjust contrast, use the Image 
Quality settings. 

If the problem persists, for online support information, go to www.xerox.com/office/VLB405support. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLB405&PgName=tech&Language=English


Troubleshooting 

 

 Xerox® VersaLink® B405 Multifunction Printer 211 
 User Guide 
 

Fax Problems 

This section includes: 
• Problems Sending Faxes .............................................................................................................................................. 211 
• Problems Receiving Faxes ........................................................................................................................................... 212 
 

Note: If you cannot send and receive faxes, make sure that you are connected to an approved 
analog telephone line. The fax cannot send or receive when connected to a digital phone line. 

If you cannot send or receive faxes correctly, refer to the following tables. 
 
 

Problems Sending Faxes 
 

Symptoms Causes Solutions 

The document is not scanned 
using the document feeder. 

The document is too thick, too thin, or 
too small. 

Use the document glass to send 
the fax. 

The document is scanned at 
an angle. 

The document feeder guides are not 
adjusted to the width of the document. 

Adjust the document feeder guides to fit 
the width of the document. 

The fax received by the 
recipient is blurry. 

The document is positioned incorrectly. Position the document correctly. 

The document glass is dirty. Clean the document glass. 

The text in the document is too light. Adjust the resolution. 

There is a problem with the telephone 
connection. 

Verify that the telephone line is working, 
then send the fax again. 

There is a problem with the fax 
machine of the caller. 

Make a copy to verify that your printer is 
operating correctly. If the copy was 
printed correctly, have the recipient 
verify the condition of the receiving fax 
machine. 

The fax received by the 
recipient is blank. 

The document was loaded incorrectly. • Document feeder: Place the original 
document face up. 

• Document glass: Place the original 
document face down. 

Fax was not transmitted. The fax number is wrong. Verify the fax number. 

The telephone line is connected 
incorrectly. 

Verify the telephone connection. If it is 
disconnected, connect it. 

There is a problem with the fax 
machine of the recipient. 

Contact the recipient. 

The fax is not installed or is not 
enabled. 

Verify that the fax is installed and 
enabled. 

 

If the problem persists, for online support information, go to www.xerox.com/office/VLB405support. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLB405&PgName=tech&Language=English


Troubleshooting 

 

212 Xerox® VersaLink® B405 Multifunction Printer 
 User Guide 
 

Problems Receiving Faxes 
 

Symptoms Causes Solutions 

The received fax is blank. There is a problem with the telephone 
connection or with the fax machine of 
the caller. 

Verify that the printer can make clean 
copies. If it can, have the caller send 
the fax again. 

The sender loaded the pages 
incorrectly. 

Contact the sender. 

The printer answers the call, but 
does not accept incoming data. 

Not enough memory. If the job contains several graphics, 
the printer could not have enough 
memory. The printer does not answer 
when memory is low. Delete stored 
documents and jobs then wait for the 
existing job to complete. This 
increases available memory. 

The received fax size is reduced. The paper supply in the printer does 
not match the document size sent. 

Confirm the original size of the 
documents. Documents could be 
reduced based on the available paper 
supply in the printer. 

Faxes cannot be received 
automatically. 

The printer is set to receive faxes 
manually. 

Set the printer to automatic 
reception. 

The memory is full. Load paper if it is empty, and then 
print the faxes stored in the memory. 

The telephone line is incorrectly 
connected. 

Verify the telephone line connection. 
If it is disconnected, connect it. 

There is a problem with the fax 
machine of the sender. 

Make a copy to verify that your 
printer is operating correctly. If the 
copy prints correctly, have the 
recipient verify their fax machine is 
operating correctly. 

If the problem persists, for online support information, go to www.xerox.com/office/VLB405support. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLB405&PgName=tech&Language=English
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Getting Help 

This section includes: 
• Viewing Warning Messages on the Control Panel ............................................................................................. 213 
• Viewing Current Errors on the Control Panel ....................................................................................................... 213 
• Using the Integrated Troubleshooting Tools ...................................................................................................... 213 
• Online Support Assistant ............................................................................................................................................. 214 
• Information Pages ......................................................................................................................................................... 214 
• More Information .......................................................................................................................................................... 214 

Your printer comes with utilities and resources to help you troubleshoot printing problems. 
 
 

Viewing Warning Messages on the Control Panel 

When a warning condition occurs, the printer alerts you of the problem. A message appears on the 
control panel and the LED status light on the control panel flashes amber or red. Warning alerts inform 
you about printer conditions, such as low supplies or open doors, that require your attention. If more 
than one warning condition occurs, only one warning message appears on the control panel at a time. 
 

Viewing Current Errors on the Control Panel 

When an error condition occurs, a message appears on the control panel to inform you of the problem. 
Error messages warn you about printer conditions that prevent the printer from printing or degrade 
printing performance. If more than one error occurs, only one is displayed on the control panel. 
 

Using the Integrated Troubleshooting Tools 

Your printer has a set of reports that you can print. These reports include the Demonstration Print page 
and the Error History report that can assist you in troubleshooting certain problems. The Demonstration 
Print page prints an image to show print quality. You can use this page to troubleshoot print quality 
issues with the printer. The Error History report prints information on the most recent printer errors. 
 

Printing Information Pages 
1. At the printer control panel, press the Home button. 
2. Touch Device > About > Information Pages. 
3. To print an information page, touch the desired page. 
4. To return to the Home screen, press the Home button. 
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Printing the Error History Report 
1. At the printer control panel, press the Home button. 
2. To print the Error History Report, touch Device > Support > Support Pages > Error History Report. 
3. To return to the Home screen, press the Home button. 
 

Online Support Assistant 

The Online Support Assistant is a knowledge base that provides instructions and troubleshooting help to 
solve your printer problems. You can find solutions for print-quality problems, paper jams, software 
installation issues, and more. 

To access the Online Support Assistant, go to www.xerox.com/office/VLB405support. 
 

Information Pages 

Your printer has a set of information pages that you can print. These pages include configuration and 
font information, demonstration pages, and more. For details, refer to Information Pages on page 32. 
 

More Information 

You can obtain more information about your printer from these sources: 
 

Resource Location 

Installation Guide Packaged with the printer. 

Other documentation for your printer www.xerox.com/office/VLB405docs  

Technical support information for your printer; 
including online technical support, Online Support 
Assistant, and print driver downloads. 

www.xerox.com/office/VLB405support  

Information Pages Print from the control panel. For details, refer to 
Information Pages on page 32. 

Order supplies for your printer www.xerox.com/office/VLB405supplies  

A resource for tools and information, including 
interactive tutorials, printing templates, helpful tips, 
and customized features to meet your individual 
needs. 

www.xerox.com/office/businessresourcecenter  

Local sales and Technical Customer Support www.xerox.com/office/worldcontacts  

Printer registration www.xerox.com/office/register  

Xerox® Direct online store www.direct.xerox.com/  
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLB405&PgName=tech&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLB405&PgName=Man&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLB405&PgName=tech&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=VersaLink+VLB405&PgName=order&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&PgName=businessresourcecenter&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&PgName=customersupport&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&PgName=reg&Language=English
http://www.direct.xerox.com/
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Printer Configurations and Options 

Available Configurations 

This printer is a network printer with copy, automatic 2-sided printing, scan functions, fax functions, and 
USB or network connectivity. 
 

Standard Features 
 

Print Speed Standard and Enhanced modes up to 47 ppm (letter)/45 ppm (A4) 

2-Sided Print Speed Standard and Enhanced modes up to 29 images per minute 

Print Resolution • Standard mode: 600 x 600 dpi 
• Enhanced mode: 1200 x 1200 dpi 

Paper Capacity 
• Bypass Tray 
• Tray 1 
• Optional 550-Sheet Feeder (up to 3x) 
• Output Tray 

 
• 150 sheets 
• 550 sheets 
• 550 sheets (1x)/1100 (2x)/1650 (3x) 
• 250 sheets 

Maximum Print Size Legal (216 x 356 mm, 8.5 x 14 in.) 

2-Sided Printing Up to 163 g/m² from any tray 

Copy Speed 
• 1-sided copy 
• 2-sided copy 

 
• 47 copies per minute 
• 29 copies per minute 

Copy Resolution 600 x 600 dpi 

Max Copy Size Legal (216 x 356 mm, 8.5 x 14 in.) 

Document Feeder Duplex Automatic Document Feeder 

Document Feeder Capacity 60 sheets 

Scan Resolution 
• Optical 
• TWAIN 
• WIA 

 
• 600 x 600 dpi 
• Up to 1200 dpi interpolated 
• Up to 600 dpi 

Max Scan Size 
• Document Glass 
• Single-Pass Duplex Automatic 

Document Feeder 

 
• 215.9 x 355.6 mm (8.5 x 14 in.) 
• 215.9 x 355.6 mm (8.5 x 14 in.) 
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File Formats • JPEG 
• TIFF 
• PDF 
• PDF/A 
• XPS 

Supported Scanning • Scan to Home 
• Scan to Network (FTP or SMB) 
• Scan to Email 
• Scan to USB Flash Drive 
• Scan to Desktop (WSD) 

Email Address Book • Up to 100 email addresses 
• Up to 10 email groups 
• Up to 10 addresses per email group 

Control Panel 5-inch LCD touch screen with home and power/wake buttons 

Connectivity • 2 x USB 2.0 (Type A) 
• USB 3.0 (Type B) 
• Ethernet 10BASE-T/100BASE-TX/1000BASE-T 
• Wireless network connectivity with an IEEE802.11 n/g/b-compliant 

Wireless Network Adapter (optional) 
• Near Field Communication (NFC) 
• AirPrint™ 
• Mopria™ 

Remote Access Embedded Web Server 
 
 

Options and Upgrades 
• Wireless network adapter 
• 16-GB Solid State Drive 
• 550-Sheet Feeder 
• Stand 
• External Card Reader/RFID Kit 
• Foreign Device Interface Kit 

Note: This product supports up to three additional 550-Sheet Feeder trays. 
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Physical Specifications 

Weights and Dimensions 
 

 Standard Configuration Configuration with Three Optional 
550-Sheet Feeders 

Width 495 mm (19.5 in.) 495 mm (19.5 in.) 

Depth 495 mm (19.5 in.) 495 mm (19.5 in.) 

Height 551 mm (21.69 in.) 971 mm (38.2 in.) 

Weight 22 kg (48.5 lbs.) 32.5 kg (71.7 lbs.) 
 
 

Standard Configuration 
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Configuration with Three Optional 550-Sheet Feeders 

 
 

Total Space Requirements 
 

 Standard Configuration Configuration with Three Optional 
550-Sheet Feeders 

Width 995 mm (39.2 in.) 995 mm (39.2 in.) 

Depth 1495 mm (58.9 in.) 1495 mm (58.9 in.) 

Height 871 mm (34.3 in.) 1291 mm (50.8 in.) 
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Clearance Requirements 

 
 

Clearance Requirements with Three Optional 550-Sheet Feeders 
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Environmental Specifications 

Temperature 
• Operating Temperature Range: 10–32°C (50–90°F) 
• Optimal Temperature Range: 15–28°C (59–82°F) 
 

Relative Humidity 
• Operating Humidity Range: 10–85% 
• Optimal Humidity Range: 20–70% relative humidity at 28°C (82°F) 

Note: Under extreme environmental conditions, such as 10°C and 85% relative humidity, printing 
defects can occur due to condensation inside the printer. 

 

Elevation 

For optimum performance, use the printer at elevations below 3100 m (10,170 ft.). 
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Electrical Specifications 

Power Supply Voltage and Frequency 

Power Supply Voltage Frequency Current Required 

110–127 VAC +/-10% 
(99–140 VAC) 

60 Hz +/-3 Hz 11 A 

220–240 VAC +/-10% 
(198–264 VAC) 

50 Hz +/-3 Hz 6 A 

 
 

Power Consumption 
• Sleep mode: 4 W or less 
• Low Power mode: 15.5 W 
• Standby: 60 W 
• Continuous printing: 620 W 
 

ENERGY STAR Qualified Product 
 
 
 

 

This product is ENERGY STAR® qualified under the ENERGY STAR Program 
Requirements for Imaging Equipment. 

The ENERGY STAR and ENERGY STAR mark are registered United States 
trademarks. 

The ENERGY STAR Imaging Equipment Program is a team effort between 
United States, European Union, and Japanese governments and the office 
equipment industry to promote energy-efficient copiers, printers, fax, 
multifunction printers, personal computers, and monitors. Reducing product 
energy consumption helps combat smog, acid rain, and long-term changes 
to the climate by decreasing the emissions that result from generating 
electricity. 

ENERGY STAR settings are preset on Xerox® equipment at the factory to switch to Power Saver modes 
after 5 minutes from the last copy or print. 
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Germany - Blue Angel 
 

 

RAL, the German Institute for Quality Assurance and Labeling, has awarded 
this device the Blue Angel Environmental Label. This label distinguishes it as a 
device that satisfies Blue Angel criteria for environmental acceptability in terms 
of device design, manufacture, and operation. For more information, go to: 
www.blauer-engel.de. 

 
 

Recycling Supplies 

If you want to return used supplies for recycling, follow the instructions included with the new supplies. If 
the instructions or shipping label are not available, for more information, go to www.xerox.com/gwa for 
more information. 
 

http://www.blauer-engel.de/
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=VersaLink+VLB405&PgName=recyclesupplies&Language=English
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Performance Specifications 
 

Feature Specifications 

Printer warm-up time Power on: as fast as 60 seconds. 
Recovery from sleep mode as fast as 4 seconds. 

Note: Warm-up time assumes an ambient temperature of 20ºC (68°F) 
at 65% relative humidity. 

 
 

Print Speed 

Print speeds for continuous printing are up to 47 ppm. 

Several factors affect print speed: 
• Print mode: The fastest print mode is Standard. 
• Paper size: Letter (8.5 x 11 in.) prints slightly faster than A4 (210 x 297 mm). Larger sizes reduce 

print speeds. 
• Paper type and weights: For faster printing, use paper weights of 105 g/m² or less. 

Maximum Print Speeds: 
• 1-sided printing: 47ppm on Letter-sized paper and 45 ppm on A4 paper 
• 2-sided printing: 28 images per minute on Letter-sized paper and on A4 paper 
• Heavyweight Paper: 23 ppm 
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Basic Regulations 

Xerox has tested this printer to electromagnetic emission and immunity standards. These standards are 
designed to mitigate interference caused or received by this printer in a typical office environment. 
 

United States FCC Regulations 

This equipment has been tested and found to comply with the limits for a Class A digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against 
harmful interference when the equipment is operated in a commercial environment. This equipment 
generates, uses, and can radiate radio frequency energy. If it is not installed and used in accordance with 
these instructions, it may cause harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause harmful interference in which case the user will be 
required to correct the interference at his/her own expense. 

If this equipment does cause harmful interference to radio or television reception, which can be 
determined by turning the equipment off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures: 
• Reorient or relocate the receiving antenna. 
• Increase the separation between the equipment and receiver. 
• Connect the equipment into an outlet on a circuit different from that to which the receiver is 

connected. 
• Consult the dealer or an experienced radio/TV technician for help. 

Changes or modifications to this equipment not approved by Xerox can void the authority of the user to 
operate this equipment. 

Note: To ensure compliance with Part 15 of the FCC rules, use shielded interface cables. 
 

Canada 

This Class A digital apparatus complies with Canadian ICES-003. 

Cet appareil numérique de la classe A est conforme à la norme NMB-003 du Canada. 
 

Certifications in Europe 

 

The CE mark applied to this product symbolizes a declaration of conformity by Xerox 
with the following applicable Directives of the European Union as of the dates 
indicated: 
• February 26, 2014: Low Voltage Directive 2014/35/EU 
• February 26, 2014: Electromagnetic Compatibility Directive 2014/30/EU 
• March 9, 1999: Radio & Telecommunications Terminal Equipment Directive 

1999/5/EC 
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This printer, if used properly in accordance with the instructions, is not dangerous for the consumer or for 
the environment. 

A signed copy of the Declaration of Conformity for this printer can be obtained from Xerox. 
 

 WARNINGS:  

• Changes or modifications to this equipment not specifically approved by the Xerox 
Corporation may void the user's authority to operate this equipment. 

• External radiation from Industrial, Scientific, and Medical (ISM) equipment can interfere 
with the operation of this Xerox device. If external radiation from ISM equipment 
interferes with this device, contact your Xerox representative for assistance. 

• This is a class A product. In a domestic environment, this product can cause radio 
frequency interference, in which case the user can be required to take adequate measures. 

• To ensure compliance with European Union regulations, use shielded interface cables. 
 
 

European Union Lot 4 Imaging Equipment Agreement Environmental 
Information 

Environmental Information Providing Environmental Solutions and Reducing Cost 

The following information has been developed to assist users and has been issued in relation to the 
European Union (EU) Energy Related Products Directive, specifically the Lot 4 study on Imaging 
Equipment. This requires manufacturers to improve environmental performance of in scope products 
and supports the EU action plan on energy efficiency. 

In scope products are Household and Office equipment that meet the following criteria. 
• Standard monochrome format products with a maximum speed less than 66 A4 images per minute 
• Standard color format products with a maximum speed less than 51 A4 images per minute 
 

Environmental Benefits of Duplex Printing 

Most Xerox products have duplex printing, also known as 2-sided printing, capability. This enables you to 
print on both sides of the paper automatically, and therefore helps to reduce the use of valuable 
resources by reducing your paper consumption. The Lot 4 Imaging Equipment agreement requires that 
on models greater than or equal to 40 ppm color or greater than or equal to 45 ppm monochrome the 
duplex function has been auto enabled, during the setup and driver installation. Some Xerox models 
below these speed bands may also be enabled with 2-sided printing settings defaulted on at the time of 
install. Continuing to use the duplex function will reduce the environmental impact of your work. 
However, should you require simplex/1-sided printing, you may change the print settings in the 
print driver. 
 

Paper Types 

This product can be used to print on both recycled and virgin paper, approved to an environmental 
stewardship scheme, which complies with EN12281 or a similar quality standard. Lighter weight paper 
(60 g/m²), which contains less raw material and thus save resources per print, may be used in certain 
applications. We encourage you to check if this is suitable for your printing needs. 
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ENERGY STAR 
 
 
 
 

 

The ENERGY STAR program is a voluntary scheme to promote the 
development and purchase of energy efficient models, which help to 
reduce environmental impact. Details on the ENERGY STAR program and 
models qualified to ENERGY STAR can be found at the following website: 
www.energystar.gov/index.cfm?fuseaction=find_a_product.showProductGr
oup&pgw_code=IEQ  

The ENERGY STAR and ENERGY STAR mark are registered United States 
trademarks. 

The ENERGY STAR Imaging Equipment Program is a team effort between 
United States, European Union, and Japanese governments and the office 
equipment industry to promote energy-efficient copiers, printers, fax, 
multifunction printers, personal computers, and monitors. Reducing product 
energy consumption helps combat smog, acid rain, and long-term changes 
to the climate by decreasing the emissions that result from generating 
electricity. 

 

For additional information on energy or other related topics, go to 
www.xerox.com/about-xerox/environment/enus.html or 
www.xerox.co.uk/about-xerox/environment/engb.html. 
 

Power Consumption and Activation Time 

The amount of electricity that a device consumes depends on the way the device is used. This device is 
designed and configured to enable you to reduce your electricity usage. 

Power Saver modes are enabled on your device to reduce energy consumption. After the last print, the 
device transitions to Ready mode. In this mode, the device can print again immediately. If the device is 
not used for a specified period, the device transitions to Low Power mode, then to Sleep mode. In these 
modes, to enable reduced-power consumption, only essential functions remain active. The device takes 
longer to produce the first print after it exits the Power Saver modes than it takes to print in Ready 
mode. This delay is the result of the system waking up and is typical of most imaging devices on 
the market. 

To save power, you can enable Auto Power Off mode on your device. If Auto Power Off mode is enabled, 
you can configure the mode as follows: 
• Always Allowed: The device powers off automatically after the specified time, and the cumulative 

Low Power mode and Sleep mode timeouts have elapsed. 
• Allowed ONLY When Conditions are Met: The device automatically powers off only after timeouts 

have elapsed. The device also powers off if Fax, USB Drive, and Wired and Non-Wired Network have 
not been activated. 

To change the Power Saver settings, refer to the User Guide at www.xerox.com/office/VLB405docs . For 
further assistance, contact your System Administrator or refer to the System Administrator Guide. 

To enable Auto Power Off mode, contact your System Administrator. For details, refer to the System 
Administrator Guide at www.xerox.com/office/VLB405docs. 

http://www.energystar.gov/index.cfm?fuseaction=find_a_product.showProductGroup&pgw_code=IEQ
http://www.energystar.gov/index.cfm?fuseaction=find_a_product.showProductGroup&pgw_code=IEQ
http://www.xerox.com/about-xerox/environment/enus.html
http://www.xerox.co.uk/about-xerox/environment/engb.html
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLB405&PgName=Man&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLB405&PgName=Man&Language=English
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To learn more about Xerox participation in sustainability initiatives, go to: 
www.xerox.com/about-xerox/environment/enus.html. 

Note: Changing the default Power Saver activation times can result in an overall higher energy 
consumption of the device. Before you turn off Power Saver modes or set a long activation time, 
consider the increase in device power consumption. 

 

Default Power Saver Settings 

This device is ENERGY STAR®-qualified under the ENERGY STAR Program Requirements for Imaging 
Equipment. The transition time from Ready mode to Low-Power mode can be set up to 60 minutes. The 
default value is 5 minutes. The transition time from Low-Power mode to Sleep mode can be set up to 60 
minutes. The default value is set at 1 minute. The total transition time from Ready mode to Sleep mode 
can take up to 60 minutes. 

To change the Power Saver settings, contact your System Administrator, or refer to the System 
Administrator Guide at www.xerox.com/office/VLB405docs. 
 

Environmental Choice Certified to Office Machines CCD-035 
 
 
 

 

This product is certified to Environmental Choice standard for office machines, 
meeting all requirements for reduced environmental impact. As part of 
achieving certification, Xerox Corporation has proven this product meets the 
Environmental Choice criteria for energy efficiency. Certified copier, printer, 
multifunctional device, and fax products must also meet criteria such as 
reduced chemical emissions and demonstrate compatibility with recycled 
supplies. Environmental Choice was established in 1988 to help consumers find 
products and services with reduced environmental impacts. Environmental 
Choice is a voluntary, multi-attribute, and lifecycle-based environmental 
certification. This certification indicates that a product has undergone rigorous 
scientific testing, exhaustive auditing, or both, to prove its compliance with 
stringent, third-party, environmental performance standards. 

 
 

Germany 

Germany - Blue Angel 
 

 

RAL, the German Institute for Quality Assurance and Labeling, has awarded 
this device the Blue Angel Environmental Label. This label distinguishes it as a 
device that satisfies Blue Angel criteria for environmental acceptability in 
terms of device design, manufacture, and operation. For more information, go 
to: www.blauer-engel.de. 

 
 

Blendschutz 

Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz 
vorgesehen. Um störende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt nicht 
im unmittelbaren Gesichtsfeld platziert werden. 
 

http://www.xerox.com/about-xerox/environment/enus.html
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLB405&PgName=Man&Language=English
http://www.blauer-engel.de/
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Lärmemission 

Maschinenlärminformations-Verordnung 3. GPSGV: Der höchste Schalldruckpegel beträgt 70 dB(A) oder 
weniger gemäß EN ISO 7779. 
 

Importeur 

Xerox GmbH 

Hellersbergstraße 2-4 

41460 Neuss 

Deutschland 
 

Turkey RoHS Regulation 

In compliance with Article 7 (d), we hereby certify “it is in compliance with the EEE regulation.” 

“EEE yönetmeliğine uygundur.” 
 

Eurasian Economic Community Certification 
 

 

Russia, Belarus, and Kazakhstan are working to establish a common customs 
union, the Eurasian Economic Community, or EurAsEC. The Eurasian Economic 
Community members anticipate sharing a common regulatory scheme and 
common EurAsEC certification mark, the EAC Mark. 

 
 

Regulatory Information for 2.4-GHz and 5-GHz Wireless Network Adapter 

This product contains a 2.4-GHz and 5-GHz Wireless LAN radio transmitter module that complies with 
the requirements specified in FCC Part 15, Industry Canada RSS-210 and European Council Directive 
99/5/EC. 

Operation of this device is subject to the following two conditions: (1) this device may not cause harmful 
interference, and (2) this device must accept any interference received, including interference that may 
cause undesired operation. 

Changes or modifications to this device not specifically approved by the Xerox Corporation may void the 
user's authority to operate this equipment. 
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Ozone Release 

This printer produces ozone during normal operation. The amount of ozone produced is dependent on 
copy volume. Ozone is heavier than air and is not produced in amounts large enough to harm anyone. 
Install the printer in a well-ventilated room. 

For more information in the United States and Canada, go to www.xerox.com/environment . In other 
markets, please contact your local Xerox representative or go to www.xerox.com/environment_europe. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=VersaLink+VLB405&PgName=environmentna&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=VersaLink+VLB405&PgName=environmenteu&Language=English
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Copy Regulations 

United States 

Congress, by statute, has forbidden the reproduction of the following subjects under certain 
circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making such 
reproductions. 
1. Obligations or Securities of the United States Government, such as: 

− Certificates of Indebtedness. 
− National Bank Currency. 
− Coupons from Bonds. 
− Federal Reserve Bank Notes. 
− Silver Certificates. 
− Gold Certificates. 
− United States Bonds. 
− Treasury Notes. 
− Federal Reserve Notes. 
− Fractional Notes. 
− Certificates of Deposit. 
− Paper Money. 
− Bonds and Obligations of certain agencies of the government, such as FHA and so on. 
− Bonds. United States Savings Bonds may be photographed only for publicity purposes in 

connection with the campaign for the sale of such bonds. 
− Internal Revenue Stamps. If it is necessary to reproduce a legal document on which there is a 

canceled revenue stamp, this may be done provided the reproduction of the document is 
performed for lawful purposes. 

− Postage Stamps, canceled or uncanceled. For philatelic purposes, Postage Stamps may be 
photographed, provided the reproduction is in black and white and is less than 75% or more 
than 150% of the linear dimensions of the original. 

− Postal Money Orders. 
− Bills, Checks, or Drafts of money drawn by or upon authorized officers of the United States. 
− Stamps and other representatives of value, of whatever denomination, which have been or 

may be issued under any Act of Congress. 
− Adjusted Compensation Certificates for Veterans of the World Wars. 
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2. Obligations or Securities of any Foreign Government, Bank, or Corporation. 
3. Copyrighted materials, unless permission of the copyright owner has been obtained or the 

reproduction falls within the “fair use” or library reproduction rights provisions of the copyright law. 
Further information of these provisions may be obtained from the Copyright Office, Library of 
Congress, Washington, D.C. 20559. Ask for Circular R21. 

4. Certificate of Citizenship or Naturalization. Foreign Naturalization Certificates may be 
photographed. 

5. Passports. Foreign Passports may be photographed. 
6. Immigration papers. 
7. Draft Registration Cards. 
8. Selective Service Induction papers that bear any of the following Registrant’s information: 

− Earnings or Income. 
− Court Record. 
− Physical or mental condition. 
− Dependency Status. 
− Previous military service. 
− Exception: United States military discharge certificates may be photographed. 

9. Badges, Identification Cards, Passes, or Insignia carried by military personnel, or by members of the 
various Federal Departments, such as FBI, Treasure, and so on (unless photograph is ordered by the 
head of such department or bureau). 

Reproducing the following is also prohibited in certain states: 
• Automobile Licenses. 
• Drivers’ Licenses. 
• Automobile Certificates of Title. 

The preceding list is not all inclusive, and no liability is assumed for its completeness or accuracy. In case 
of doubt, consult your attorney. 

For more information about these provisions contact the Copyright Office, Library of Congress, 
Washington, D.C. 20559. Ask for Circular R21. 
 

Canada 

Parliament, by stature, has forbidden the reproduction of the following subjects under certain 
circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making such 
reproductions. 
• Current bank notes or current paper money 
• Obligations or securities of a government or bank 
• Exchequer bill paper or revenue paper 
• The public seal of Canada or of a province, or the seal of a public body or authority in Canada, or of 

a court of law 
• Proclamations, orders, regulations, or appointments, or notices thereof (with intent to falsely cause 

same to purport to have been printed by the Queens Printer for Canada, or the equivalent printer 
for a province) 
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• Marks, brands, seals, wrappers, or designs used by or on behalf of the Government of Canada or of a 
province, the government of a state other than Canada or a department, board, Commission, or 
agency established by the Government of Canada or of a province or of a government of a state 
other than Canada 

• Impressed or adhesive stamps used for the purpose of revenue by the Government of Canada or of 
a province or by the government of a state other than Canada 

• Documents, registers, or records kept by public officials charged with the duty of making or issuing 
certified copies thereof, where the copy falsely purports to be a certified copy thereof 

• Copyrighted material or trademarks of any manner or kind without the consent of the copyright or 
trademark owner 

This list is provided for your convenience and assistance, but it is not all-inclusive, and no liability is 
assumed for its completeness or accuracy. In case of doubt, consult your solicitor. 
 

Other Countries 

Copying certain documents may be illegal in your country. Penalties of fine or imprisonment may be 
imposed on those found guilty of making such reproductions. 
• Currency notes 
• Bank notes and checks 
• Bank and government bonds and securities 
• Passports and identification cards 
• Copyright material or trademarks without the consent of the owner 
• Postage stamps and other negotiable instruments 

This list is not inclusive and no liability is assumed for either its completeness or accuracy. In case of 
doubt, contact your legal counsel. 
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Fax Regulations 

United States 

Fax Send Header Requirements 

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or 
other electronic device, including a fax machine, to send any message unless such message clearly 
contains in a margin at the top or bottom of each transmitted page or on the first page of the 
transmission, the date and time it is sent and an identification of the business or other entity, or other 
individual sending the message and the telephone number of the sending machine or such business, 
other entity, or individual. The telephone number provided may not be a 900 number or any other 
number for which charges exceed local or long-distance transmission charges.  

For instructions on programming the Fax Send Header information, refer to the section of the System 
Administrator Guide on Setting Transmission Defaults. 
 

Data Coupler Information 

This equipment complies with Part 68 of the FCC rules and the requirements adopted by the 
Administrative Council for Terminal Attachments (ACTA). On the cover of this equipment is a label that 
contains, among other information, a product identifier in the format US:AAAEQ##TXXXX. If requested, 
this number must be provided to the Telephone Company. 

A plug and jack used to connect this equipment to the premises wiring and telephone network must 
comply with the applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant 
telephone cord and modular plug is provided with this product. It connects to a compatible modular jack 
that is also compliant. See installation instructions for details. 

You can safely connect the printer to the following standard modular jack: USOC RJ-11C using the 
compliant telephone line cord (with modular plugs) provided with the installation kit. See installation 
instructions for details. 

The Ringer Equivalence Number (REN) is used to determine the number of devices that can be 
connected to a telephone line. Excessive RENs on a telephone line could result in the devices not ringing 
in response to an incoming call. In most but not all areas, the sum of RENs should not exceed five (5.0). 
To be certain of the number of devices that can be connected to a line, as determined by the RENs, 
contact the local Telephone Company. For products approved after July 23, 2001, the REN is part of the 
product identifier that has the format US:AAAEQ##TXXXX. The digits represented by ## are the REN 
without a decimal point (for example, 03 is a REN of 0.3). For earlier products, the REN is separately 
shown on the label. 

To order the correct service from the local Telephone Company, you could also have to quote the codes 
in the following list: 
• Facility Interface Code (FIC) = 02LS2 
• Service Order Code (SOC) = 9.0Y 
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 CAUTION: Ask your local Telephone Company for the modular jack type installed on your 
line. Connecting this machine to an unauthorized jack can damage telephone company 
equipment. You, not Xerox, assume all responsibility and/or liability for any damage caused 
by the connection of this machine to an unauthorized jack. 

If this Xerox® equipment causes harm to the telephone network, the Telephone Company could 
temporarily discontinue service to the telephone line to which it is connected. If advance notice is not 
practical, the Telephone Company notifies you of the disconnection as soon as possible. If the 
Telephone Company interrupts your service, they can advise you of your right to file a complaint with 
the FCC if you believe that it is necessary. 

The Telephone Company could change its facilities, equipment, operations, or procedures which could 
affect the operation of the equipment. If the Telephone Company changes something that affects the 
operation of the equipment, they should notify you in order for you to make necessary modifications to 
maintain uninterrupted service. 

If you experience trouble with this Xerox® equipment, please contact the appropriate service center for 
repair or warranty information. Contact information is contained in the Device app on the printer and in 
the back of the Troubleshooting section of the User Guide. If the equipment is causing harm to the 
telephone network, the Telephone Company may request you to disconnect the equipment until the 
problem is resolved. 

Only a Xerox Service Representative or an authorized Xerox Service provider are authorized to make 
repairs to the printer. This applies at any time during or after the service warranty period. If 
unauthorized repair is performed, the remainder of the warranty period is null and void. 

This equipment must not be used on party lines. Connection to party line service is subject to state 
tariffs. Contact the state public utility commission, public service commission, or corporation commission 
for information. 

Your office could have specially wired alarm equipment connected to the telephone line. Make sure that 
the installation of this Xerox® equipment does not disable your alarm equipment. 

If you have questions about what could disable alarm equipment, consult your Telephone Company or a 
qualified installer. 
 

Canada 

This product meets the applicable Innovation, Science and Economic Development Canada technical 
specifications. 

A representative designated by the supplier should coordinate repairs to certified equipment. Repairs or 
alterations made by the user to this device, or device malfunctions, could cause the telecommunications 
company to request you to disconnect the equipment. 

For user protection, make sure that the printer is properly grounded. The electrical ground connections of 
the power utility, telephone lines, and internal metallic water pipe systems, if present, must be connected 
together. This precaution could be vital in rural areas. 
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 WARNING: Do not attempt to make such connections yourself. Contact the appropriate 
electric inspection authority, or electrician, to make the ground connection. 

 

The Ringer Equivalence Number (REN) indicates the maximum number of devices allowed to be 
connected to a telephone interface. The termination of an interface may consist of any combination of 
devices subject only to the requirement that the sum of the RENs of all the devices not exceed five. For 
the Canadian REN value, please refer to the label on the equipment. 
 

Canada CS-03 Issue 9 

This product has been tested to and is compliant with CS–03 issue 9. 
 

European Union 

Radio Equipment and Telecommunications Terminal Equipment Directive 

This device has been designed to work with the national public switched telephone networks and 
compatible PBX devices of the following countries: 
 

 Pan-European Analog PSTN and 
Compatible PBX Certifications  

 

Austria Greece Netherlands 

Belgium Hungary Norway 

Bulgaria Iceland Poland 

Cyprus Ireland Portugal 

Czech Republic Italy Romania 

Denmark Latvia Slovakia 

Estonia Liechtenstein Slovenia 

Finland Lithuania Spain 

France Luxembourg Sweden 

Germany Malta United Kingdom 

If you have problems with your product, contact your local Xerox representative. This product can be configured to 
be compatible with other country networks. Before reconnecting the device to a network in another country, 
contact your Xerox representative for assistance. 
 

Notes: 

• Although this product can use either loop disconnect (pulse) or DTMF tone signaling, Xerox 
recommends that you use DTMF signaling. DTMF signaling provides reliable and faster call 
setup. 

• Modification of this product, or connection to external control software or control 
apparatus not authorized by Xerox, invalidates its certification. 
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New Zealand 
1. The grant of a Telepermit for any item of terminal equipment indicates only that Telecom has 

accepted that the item complies with minimum conditions for connection to its network. It indicates 
no endorsement of the product by Telecom, it does not provide any sort of warranty, and it does not 
imply that any Telepermitted product is compatible with all Telecom network services. Above all, it 
provides no assurance that any item will work correctly in all respects with another item of 
Telepermitted equipment of a different make or model. 
The equipment may not be capable of correct operation at the higher data speeds designated. 
33.6 kbps and 56 kbps connections are likely to be restricted to lower bit rates when connected to 
some PSTN implementations. Telecom will accept no responsibility for difficulties that arise in such 
circumstances. 

2. Immediately disconnect this equipment should it become physically damaged, then arrange for its 
disposal or repair. 

3. This modem shall not be used in any manner which could constitute a nuisance to other Telecom 
customers. 

4. This device is equipped with pulse dialing, while the Telecom standard is DTMF tone dialing. There is 
no guarantee that Telecom lines will always continue to support pulse dialing. 

5. Use of pulse dialing, when this equipment is connected to the same line as other equipment, may 
give rise to 'bell tinkle' or noise and cause a false answer condition. If you encounter such problems, 
do not contact the Telecom Faults Service. 

6. DTMF tones dialing is the preferred method because it is faster than pulse (decadic) dialing and is 
readily available on almost all New Zealand telephone exchanges. 

 

 WARNING: No '111' or other calls can be made from this device during a mains power failure. 

7. This equipment may not provide for the effective hand-over of a call to another device connected to 
the same line. 

8. Some parameters required for compliance with Telecom Telepermit requirements are dependent on 
the equipment (computer) associated with this device. The associated equipment shall be set to 
operate within the following limits for compliance with Telecom Specifications: 
For repeat calls to the same number: 
− There shall be no more than 10 call attempts to the same number within any 30 minute period 

for any single manual call initiation, and 
− The equipment shall go on-hook for a period of not less than 30 seconds between the end of 

one attempt and the beginning of the next attempt. 
For automatic calls to different numbers: 
The equipment shall be set to ensure that automatic calls to different numbers are spaced such that 
there is no less than five seconds between the end of one call attempt and the beginning of 
another. 

9. For correct operation, total of the RNs of all devices connected to a single line at any time should 
not exceed five. 

 

South Africa 

This modem must be used in conjunction with an approved surge protection device. 
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Safety Certification 

This device is certified by the following Agencies using the following safety standards. 

Agency Standard 

Underwriters Laboratories Inc. (US/Canada) UL 60950-1, 2nd Edition, 2014-10-14 
CAN/CSA C22.2 No. 60950-1-07, 2nd Edition, 2014-10 

Underwriters Laboratories Inc. (Europe) IEC 60950-1:2005 + A1:2009 + A2:2013 
EN 60950-1:2006 + A11:2009 + A1:2010 + A12:2011 + 
A2:2013 
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Material Safety Data Sheets 

For Material Safety Data information regarding your printer, go to: 
• North America: www.xerox.com/msds  
• European Union: www.xerox.com/environment_europe  

For the Customer Support Center phone numbers, go to www.xerox.com/office/worldcontacts . 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=VersaLink+VLB405&PgName=msdsna&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=VersaLink+VLB405&PgName=environmenteu&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&PgName=customersupport&Language=English
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All Countries 

If you are managing the disposal of your Xerox product, please note that the printer may contain lead, 
mercury, perchlorate, and other materials whose disposal may be regulated due to environmental 
considerations. The presence of these materials is fully consistent with global regulations applicable at 
the time that the product was placed on the market. For recycling and disposal information, contact your 
local authorities. Perchlorate Material: This product may contain one or more Perchlorate-containing 
devices, such as batteries. Special handling may apply. For more information, go to 
www.dtsc.ca.gov/hazardouswaste/perchlorate. 
 

http://www.dtsc.ca.gov/hazardouswaste/perchlorate
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North America 

Xerox operates an equipment take-back and reuse/recycle program. Contact your Xerox representative 
(1-800-ASK-XEROX) to determine if this Xerox product is part of the program. For more information 
about Xerox environmental programs, visit www.xerox.com/environment , or for recycling and disposal 
information, contact your local authorities. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=VersaLink+VLB405&PgName=environmentna&Language=English
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European Union 

Some equipment may be used in both a domestic/household and a professional/business application. 
 

Domestic/Household Environment 

 

Application of this symbol on your equipment is confirmation that you should not 
dispose of the equipment in the normal household waste stream. 

In accordance with European legislation, end of life electrical and electronic equipment subject to 
disposal must be segregated from household waste. 

Private households within EU member states may return used electrical and electronic equipment to 
designated collection facilities free of charge. Please contact your local disposal authority for 
information. 

In some member states, when you purchase new equipment, your local retailer may be required to take 
back your old equipment free of charge. Please ask your retailer for information. 
 

Professional/Business Environment 

 

Application of this symbol on your equipment is confirmation that you must 
dispose of this equipment in compliance with agreed national procedures. 

In accordance with European legislation, end of life electrical and electronic equipment subject to 
disposal must be managed within agreed procedures. 

Prior to disposal, please contact your local reseller or Xerox representative for end of life 
take-back information. 
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Collection and Disposal of Equipment and Batteries 

 

These symbols on the products and/or accompanying documents mean that used 
electrical and electronic products and batteries should not be mixed with general 
household waste. 

For proper treatment, recovery, and recycling of old products and used batteries, 
please take them to applicable collection points, in accordance with your national 
legislation and the Directive 2002/96/EC and 2006/66/EC. 

By disposing of these products and batteries correctly, you will help to save 
valuable resources and prevent any potential negative effects on human health 
and the environment which could otherwise arise from inappropriate waste 
handling. 

For more information about collection and recycling of old products and batteries, 
please contact your local municipality, your waste disposal service or the point of 
sale where you purchased the items.  

Penalties may be applicable for incorrect disposal of this waste, in accordance with 
national legislation. 

 
 

Business Users in the European Union 

If you wish to discard electrical and electronic equipment, please contact your dealer or supplier for 
further information. 
 

Disposal Outside of the European Union 

These symbols are only valid in the European Union. If you wish to discard these items, please contact 
your local authorities or dealer and ask for the correct method of disposal. 
 

Battery Symbol Note 

Hg  

This wheeled bin symbol may be used in combination with a chemical symbol. This 
establishes compliance with the requirements set out by the Directive. 

 
 

Battery Removal 

Batteries should only be replaced by a manufacturer-approved service facility. 
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Other Countries 

Please contact your local waste management authority to request disposal guidance. 
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Feature Description Copy Email Fax 
Scan 
To 

ID 
Card 
Copy 

 

Preset Use Preset to select values that 
were stored previously. Select 
the required Preset from the 
menu. 

￭ ￭ ￭ ￭  

 

Output Color Use Output Color to control the 
color rendering of the output 
image or print. 

 ￭  ￭  

 

Saturation Saturation allows you to adjust 
the color strength and the 
amount of gray in the color. 

 ￭  ￭  

 

2-Sided and 2-Sided 
Scanning 

You can use the 2-Sided options 
to set the device to scan one or 
both sides of an original 
document. For Copy jobs, you 
can specify 1-Sided or 2-Sided 
output. 

￭ ￭ ￭ ￭  

 

Paper Supply Use Paper Supply to specify the 
size, type and color of the paper 
required, or the Paper Tray to 
use. If Auto is selected, the 
printer chooses the paper tray 
based on the original document 
size and the selected settings. 

￭    ￭ 

 

Collated You can collate multi-page 
copy jobs automatically. For 
example, when making three 
1-Sided copies of a six-page 
document, the copies are 
printed in this order: 
1, 2, 3, 4, 5, 6; 1, 2, 3, 4, 5, 6; 1, 
2, 3, 4, 5, 6. 

￭     

 

Reduce/Enlarge You can reduce the image to as 
little as 25% of its original size 
or enlarge it as much as 400%. 

￭     

 D Apps Features 
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Original Type The printer optimizes the image 
quality of the copies based on 
the type of images in the 
original document and how the 
original was created. 

￭ ￭ ￭ ￭ ￭ 

 

Lighten/Darken Use the Lighten/Darken slider 
to make the output image or 
print lighter or darker. 

￭ ￭ ￭ ￭ ￭ 

 

Sharpness Use this option to sharpen the 
output image or print. For best 
results, sharpen text images 
and soften photos. 

￭ ￭ ￭ ￭  

 

Original  
Orientation 

You can use the Original 
Orientation option to specify 
the layout of the original 
images. The printer uses the 
information to determine if 
images require rotation to 
produce the required output. 

￭ ￭  ￭  

 

Image Shift Image Shift allows you to 
modify the location of the 
image on the page. You can 
shift the printed image along 
the X and Y axes of each sheet 
of paper. 

￭     

 

Auto Background 
Suppression 

Use the Auto Background 
Suppression setting to reduce 
the sensitivity of the printer to 
variations in light background 
colors. 

 ￭    

 

Edge Erase You can erase content from the 
edges of your images using the 
Edge Erase feature. You can 
specify the amount to erase on 
the right, left, top, and bottom 
edges. 

￭ ￭  ￭  

 

Original Size To ensure that you are 
scanning the correct area of the 
documents, specify the original 
size. 

￭ ￭ ￭ ￭  

 

Book Copying You can use the Book Copying 
feature to copy books, 
magazines, or other bound 
documents. 

￭     
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Front Cover You can print the first page of 
your copy job on different 
paper, such as colored or 
heavyweight paper. The printer 
selects the special paper from a 
different tray. The cover can be 
blank or printed. 
Note: This function is available 
on printers with an optional 
Productivity Kit installed only. 

￭     

 

Annotations You can add Annotations such 
as page numbers and the date, 
to your copies. 
Note: This function is available 
on printers with an optional 
Productivity Kit installed only. 

￭     

 

Booklet Creation The Booklet Creation feature 
prints two pages on each side 
of the paper. The pages are 
reordered so that they are in 
numerical order when folded. 
Note: This function is available 
on printers with an optional 
Productivity Kit installed only. 

￭     

 

Page Layout You can print the selected 
number of pages on one side of 
a sheet of paper. Selecting 
multiple pages per sheet saves 
paper and provides a way to 
review the layout of a 
document. 

￭     

 

Sample Copy Sample Copy allows you to 
print a test copy of a job to 
inspect before printing multiple 
copies. This feature is useful for 
complex or high-volume jobs. 
After you print and inspect the 
test copy, you can choose to 
print or cancel the remaining 
copies. 

￭     

 

Quantity Use this option to enter the 
number of required ID card 
copies. 

    ￭ 

 

Preview Use this option to view a 
sample image. 

 ￭ ￭ ￭  

 

Resolution Resolution determines how fine 
or grainy graphic images 
appear. Image resolution is 
measured in dots per inch (dpi). 

 ￭ ￭ ￭  
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Contrast You can use the Contrast 
feature to adjust the variation 
between light and dark areas of 
the image. 

 ￭  ￭  

 

Remove Blank 
Pages 

Remove Blank Pages configures 
the printer to ignore blank 
pages. 

 ￭ ￭ ￭  

 

Book Scanning You can use the Book Scanning 
feature to scan books, 
magazines, or other bound 
documents. 

 ￭  ￭  

 

Subject Use the Subject option to add a 
title or heading to an email. 

 ￭  ￭  

 

From Use the From option to specify 
the originator of the email. 

 ￭  ￭  

 

Reply To Use the Reply To option to 
include an email address you 
want the recipient to reply to. 
This option is useful if you want 
the recipient to reply to your 
email address rather than to 
the device. 

Note: The system administrator 
can preset this option. 

 ￭  ￭  

 

Message Use Message to enter 
information to accompany the 
email. 

 ￭  ￭  

 

File Format Use the File Format option to 
specify the format of the saved 
image or to define a searchable 
image. You can add a password 
to protect the image or choose 
to combine multiple images 
into a single file. 

 ￭    

 

File Already Exists Use the File Already Exists 
option to define what action 
the device takes when the file 
name is used already. 

   ￭  

 

File Name Use the File Name option to 
specify a name for the file 
containing the scanned images. 

 ￭  ￭  

 

Book Faxing You can use the Book Faxing 
feature to scan images from 
books, magazines, or other 
bound documents for faxing. 

  ￭   

 

Starting Rate Select the highest starting rate 
for transmitting the fax, unless 
the destination for the fax you 
are sending has special 
requirements. 

  ￭   
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Cover Sheet You can use the Cover Sheet 
option to add an introduction 
page to the beginning of your 
fax. You can add a short 
comment to the cover sheet, as 
well as To and From details. 

  ￭   

 

Transmission 
Header Text 

It is unlawful to send a 
message from a fax machine 
without the proper 
Transmission Header Text. 
Ensure that the name and 
telephone number of the 
sender, and the date and time 
of the transmission is included 
on all faxes. 

  ￭   

 

Delay Send You can set a time in the future 
for the printer to send your fax 
job. You can delay the send of 
your fax job for up to 24 hours. 

  ￭   

 

Priority Send Use Priority Send to identify 
urgent faxes. Priority faxes are 
sent first. 

  ￭   

 

Manual Send You can use the Manual Send 
feature to enable the fax 
modem speaker temporarily. 
This feature is helpful to dial 
international numbers, or to use 
phone systems that require you 
to wait for a specific audio 
tone. 

  ￭   

 

Polling Polling allows you to retrieve 
faxes stored on other fax 
machines. 

  ￭   
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